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Wizard or MSI Installer 
1



2

Dragon®  Medical Installation and Administration Guide
Administrator Guide Overview — Dragon® Medical 
Version 10

For information on: See:

Installing, modifying and upgrading Dragon NaturallySpeaking or 
Dragon Medical.

Installing, 
modifying and 
upgrading 
Dragon

and

Installation 
checklists

Setting up and using Roaming Users

The Roaming User feature lets users dictate with Dragon from 
different network locations and different machines without having 
to create and train individual user files at each location.

Setting up and 
using 
Roaming 
Users

Deploying Dragon Version 10 in a Citrix Presentation Server 
environment. 

Dragon supports installation on a Citrix Presentation Server, 
enabling users to dictate from workstations that do not have 
Dragon installed. 

Using Dragon 
in a Citrix 
Presentation 
Server 
environment

Customizing Vocabularies with the Dragon Vocabulary Tool 
(Voctool) 

You use the Dragon Vocabulary Tool to customize a vocabulary 
by adding new words and by optimizing the language model. 

Customizing 
Vocabularies 
with the 
Dragon 
Vocabulary 
Tool 

Adding new words, customized vocabularies or commands and 
make them available to all user profiles on a particular Dragon 
installation.

You use the nsadmin command line utility and the Dragon Data 
Distribution Tool when you want to make new words, customized 
vocabularies or new commands available to all user profiles on a 
particular Dragon installation.

Adding words, 
commands, or 
vocabularies 
to user 
profiles

Using the Convert XML to DAT tool

This tool (mycmdsxml2dat.exe) extracts user-defined Dragon 
commands from an .XML file. 

Using the 
Convert XML 
to DAT tool

Using Structured Commands

Dragon Professional, Medical, and Legal include an extension to 
text and graphics commands that let you to set the values of 
variables in text blocks based on voice input. 

About 
Structured 
Commands

 



Installing Dragon® with the Wizard or MSI Installer
Installing, Modifying, and Upgrading Dragon

To install Dragon NaturallySpeaking or Dragon Medical:

1. Be sure your systems meet the system requirements.

2. Prepare for the installation or upgrade.

3. Install or upgrade the software by choosing the type of installation in the table and 
linking to the corresponding instructions.

4. View the Version 10 file structure and carry out other post installation tasks.

For information on: See:

Installation checklists Installation 
checklists

System requirements System 
requirements

Preparing for an installation or upgrade Preparing for 
an installation 
or upgrade

Installing on a single machine

This topic describes the basics steps for installing Dragon on a 
single machine. 

It covers both a Typical/Complete installation and in a Custom 
installation, sometimes linking you to further detail in another 
topic.

Installing on a 
single 
machine

Installing using the Windows Installer (MSI)

Dragon includes a native Windows Installer (MSI) that lets you 
customize your installations as well as install across a network to 
multiple client machines. In addition, you use this service to 
modify, repair, or remove an existing Dragon installations. 

Using the 
Windows 
Installer (MSI) 
to install 
Dragon

Upgrading from a previous version

You can upgrade to Version 10 from Dragon NaturallySpeaking 
Versions 8.x and 9.x. 

Upgrading 
from a 
previous 
version

View Version 10 file structure and carry out post installation tasks Post 
Installation 
Tasks
3
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Preparing for an Installation or Upgrade

Before installing, modifying, or upgrading Dragon NaturallySpeaking or Dragon 
Medical: 

• Close all open applications. 

• Turn off or disable any antivirus software; installation can sometimes trigger a false 
virus report. 

• Look at the supplied Installation Checklists.

Installation restrictions

• Be sure your system meets the hardware requirements before attempting to install 
Dragon. See Recommended System Requirements

• Administrator rights are not required to create a user or use the software after 
installation.

• On Windows 2000 and Windows XP Professional systems, if as administrator you 
want to create a Dragon user for a Windows limited user (with restricted privileges), 
you must log on to Windows using that limited user account, then create the Dragon 
user. If you create a Dragon user account for a Windows limited user while logged in 
as a Windows administrator, the limited user will not be able to access that user 
account. These restrictions also apply to an upgrade installation.

• Dragon is licensed on a per individual basis. You are permitted to install the software 
on more than one computer (for example, on a desktop and a laptop computer, or 
on a work and a home computer), but you cannot use the software concurrently on 
more than one computer.  
 
You are permitted to create multiple voice profiles, so long as each voice profile is for 
a single individual. If someone else wants to create or use another voice profile, 
however, that person must purchase a separate license for Dragon. 
 
Volume license agreements are available.

File Structure

Upgrading from Dragon NaturallySpeaking Version 8.x or 9.x automatically relocates 
some NaturallySpeaking directories and files. 

For information, see Version 10 File Structure.



Installing Dragon® with the Wizard or MSI Installer
Installation checklists

Installation checklist

 Do all of your workstations meet the recommended system requirements for 
Dragon? (Not applicable if you are running Dragon on a Citrix server; see Citrix 
Checklist below.) 

Will you install the Dragon software manually at each computer or will installation 
be unattended? (If the latter, read Installing, modifying, and upgrading Dragon for 
information on setup or MSI command-line parameters. Your answers to all of the 
installation questions are implemented through setup parameters.) 

 Which features will you install on each computer? 

 Which vocabularies do you need to install on each computer? 
  
Note: Installing only selected vocabularies makes a significant improvement in 
disk space consumption and setup time. A full installation with all vocabularies 
uses about 2500 MB and takes about 20 minutes, while an installation with only 
one vocabulary uses less than 500 MB and takes about 5-10 minutes. 

 Will you install the tutorial (recommended)? 

Will you install the text-to-speech component? 

 Will you set up roaming users? (Read Setting up and dictating with Roaming Users) 

 If so, where will you place the user files? 

 In a shared network directory? 

 In multiple shared network directories? (for example, one per 
department or clinic) 

 In each user’s home directory?  
 
Note: Placing each user’s file in his or her home directory is not highly 
recommended, because this makes it more difficult for the administrator to 
perform operations on multiple users, such as running the Acoustic and 
Language Model Optimizer or upgrading user files to a new version.

 On an Internet server running WebDAV (HTTP roaming)? 

 If not, what location will you designate as the backup directory for each user? 

 Where will you place the data distribution directory for distributing word lists 
and command sets? 
5
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 Will you be collecting data for the acoustic optimizer? 

 Will you restrict users from modifying commands and vocabularies? 

 Which default user-specific options will you set at installation time? (See the 
Dragon Help on the Options dialog.) 

Note: Here are some additional considerations in user file placement. Each user 
file uses at least 25-30 MB. With default settings, acoustic optimizer data can 
take up to an additional 100 MB per workstation, to a total of 500 MB in the 
master roaming user file (more precisely, 100 MB per dictation source per 
workstation, 500 MB per dictation source per master roaming user). Acoustic 
optimizer data contains text and audio data that can be read or heard by anyone 
with access to the user files.

Upgrade checklist 

 Are there user files that need to be upgraded from a previous version? 

 If so, will an administrator upgrade them or will each end user upgrade his/
her own? 

Citrix checklist 

 Will you be running Dragon on a client or a server system? 

 If you will be running Dragon on a Citrix client, do you fully understand the impact 
this will have on functionality? (See tech note 5543 in the Nuance knowledge base at 
http://knowledgebase.nuance.com/view.asp?60VQ=JKKG&5d7r4B=Pv64vA ) 

 If you will be running Dragon on a Citrix server: 

 Are all of your Citrix client systems running Windows 2000 or XP as required? 

 Have you or your Citrix administrator read Using Dragon in a Citrix 
Presentation Server environment? 

Support Checklist 

 Who will be responsible for running the Acoustic and Language Model Optimizer? 

 Who is responsible for collecting word lists and commands? 

 Who is responsible for distributing word lists and commands? 

 Will words and commands be distributed through the data distribution directory or 
by some other means (such as email)? 

http://knowledgebase.nuance.com/view.asp?60VQ=JKKG&5d7r4B=Pv64vA
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 Who will Dragon users contact if they need help? 

Recommended System Requirements

To run Dragon, your system must meet the following requirements:

• Intel Pentium 4 (or equivalent AMD process) with CPU speed 2.4 GHz (1.6 GHz dual 
core processor) or equivalent AMD processor. If you have a minimum CPU speed of 
1 GHz, you can run the software, but the performance is reduced. Faster processors 
produce faster performance. 
 
Note: During the installation process the software checks to make sure your system 
meets the minimum requirements. If your system does not meet the requirements, 
the software will not be installed.

• 512 MB RAM minimum. Recommended: 1 GB recommended. On Windows Vista, 1 GB 
RAM is required.

• 512 KB minimum L2 Cache. Recommended: 1 GB L2 Cache.

• Minimum of 1 GB of free hard disk space. Minimum 2.5 GB free hard disk space for 
Dragon Medical.

• Windows 2000 with Service Pack 4 or higher, Windows Server 2000 with Service Pack 
4 or higher, Windows Server 2003, Windows XP Home or XP Professional with 32-bit 
with Service Pack 2 or higher, Windows Vista Home or Professional with or without 
Service Pack 1 (32-bit only). Windows Vista considerations for more on Vista 
restrictions.

• Sound card supporting 16-bit 11 KHz recording.

• Microsoft® Internet Explorer 6 or higher (free download available at http://
www.microsoft.com).

• An internet connection for product activation. 

• DVD drive (required for installation).

• Nuance-approved noise-canceling headset/microphone (provided with the full 
product, but not with upgrades).

• Speakers (optional for playback of recorded speech and text-to-speech features).

• For Bluetooth wireless microphone support, visit http://support.nuance.com/
compatibility. 

• Additional software—Additional operating system Support for Professional, Legal, and 
Medical Editions: Citrix MetaFrame Presentation Server 4.0 or 4.5 for Citrix support

Storage space required for user files

Adequate storage space must be available for user files that store information about 
each particular user’s speech patterns. The space needs to exist on: 

• Stand-alone installations where users work on dedicated machines.  
AND

• (Only if you have roaming users) Central machines (sometimes servers) where 
7
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Master Roaming User files are stored.

Having Roaming User files lets providers run Dragon on more than one machine or 
device by accessing centrally stored provider-specific voice and speech information, 
rather than requiring that the voice information be on each machine. 

Note: These are guidelines only and not definitive specifications—actual size will 
vary from site to site.

For each Master Roaming User (user files stored on the central machine), you should 
plan to have this much space:

• 25 MB for each set of roaming user files 

• 8 MB for each additional vocabulary you add for this user 

• 18 MB for each additional dictation source you add for this user 

• 500 MB for acoustic optimizer data associated with each dictation source of each user

To set how much data is stored: 

1. On the DragonBar, select Tools > Administrative Settings.

2. When the Administrative Settings dialog box opens, check the Disk space 
reserved for network archive option. 

In addition, for the Local Roaming User, you should plan to have the following space on 
each PC where the roaming user dictates: 

• 25 MB for each set of roaming user files 

• 8 MB for each additional vocabulary you add for this user 

• 18 MB for each additional dictation source you add for this user 

• 240 MB for acoustic optimizer data associated with each dictation source of each 
user. 

How much acoustic optimizer data is retained locally is controlled by settings on the 
Data tab of the Options dialog box: 

1. To set the number of minutes of audio to retain locally, click the Archive size... 
button and position the slider. 

2. To turn off retaining this data locally, check the Conserve disk space required by 
user files (for portability) option. 

For each non-roaming user, you should plan on approximately twice as much space as 
a Local Roaming User, because Dragon periodically makes a backup copy of the files 
and stores it on the same machine. The product does not back up Roaming User files 
this way as they are located on a central machine that your Information Technology 
department should back up regularly.

Installing on or Upgrading to Windows Vista

Dragon NaturallySpeaking and Dragon Medical Versions 9.5 and higher are compatible 
with all editions of Windows Vista.

Earlier version of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista.
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Upgrade considerations

If you upgrade a machine from a previous version of Windows to Windows Vista and 
that machine has Version 8.x, 9.0, or 9.1 of Dragon installed, that version of Dragon 
will not work after upgrading to Windows Vista. 

All your user profiles from these previous versions remain intact and can be upgraded 
when you install Dragon Version 9.5 or Version 10.

Roaming Users in an MSI Installation on Vista

For more on carrying out an MSI installation on Windows Vista, see Roaming Users in 
an MSI Installation on Vista.

Coexistence with other Dragon products

Coexistence with previous versions of Dragon 

You can have only one version of Dragon installed on your system. 

Note: Running Version 8.x or 9.x concurrently with Version 10 is not supported.

Coexistence with Dragon SDK Client Edition

You can install Dragon SDK Client Edition 10 on the same machine where Dragon 10 is 
installed. In addition, Dragon and Dragon SDK Client Edition can share vocabularies 
and users. 

You can run only one product at the same time. For example, if you are running Dragon, 
you cannot run any of the Dragon SDK Client tools or samples. 

Note: Coexistence with Dragon SDK Client Edition Version 9.x is not supported.
9
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Installing Dragon on a single machine

This topic presents the basic steps for installing Dragon NaturallySpeaking or Dragon 
Medical on a single machine.

For a complete step-by-step procedure of installing Dragon on a single machine, please 
see the Dragon Getting Started Guide, available in printed form, or the Dragon Version 
10 User Guide, available on the DVD in \documentation\enx\user guide.pdf.

Note:

You must have Windows Administrator rights to install or uninstall Dragon or Dragon 
Medical on Windows 2000, Windows XP, or Windows Vista. For more on how 
Administrator rights impact creating Dragon users, refer to Preparing for an installation 
or upgrade.

Installing on Windows Vista

For information about installing the product on Windows Vista, refer to Installing or 
Upgrading to Windows Vista.

Installing Dragon on a single machine

To install Dragon NaturallySpeaking or Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive.  
 
If the installation does not start automatically, use the Windows Explorer to find and 
double-click setup.exe on the DVD.  
 
When you start the installation on Windows Vista, you might see a message saying 
A program needs your permission to continue. Click Continue to start the 
installation.

2. After the Windows Installer begins, it installs two software packages (if they are not 
already installed): 
 
Visual C++ Version 8.0  
PowerMic Microphone Drivers (if you are installing Dragon Medical)  

3. After the installation Wizard begins, click Next to proceed to the License Agreement. 
Read the text of the agreement and select I accept..., then click Next again.

4. Enter your customer information—User Name and Organization—then the Serial 
Number supplied to your Dragon installation. 

5. Choose your installation directory. If there are no previous versions of Dragon on 
your system, the default directory is: 
 
C:\Program Files\Nuance\NaturallySpeaking10 
For a list of directories created by the installation, see Version 10 File Structure. 

6. Choose your Setup Type:  
 
Note: If you decide not to install some Dragon components by selecting Custom 
installation, you can install them later by running the Setup program again and 
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choosing Modify. 

• Typical/Complete: Installs all options and speech files and requires the most 
disk space.

• Custom: Lets you select options and speech files to install. Customizing your 
installation options can greatly reduce the disk space required.  
 
In the Professional and Medical editions, you can modify the following settings 
during a custom installation. These settings are applied to all users created with 
this installation of Dragon, including users created from Windows XP limited 
accounts: 

• Modify the application’s settings for all users displays the Options dialog box 
at the end of the installation. The Options dialog box lets you change the product’s 
standard behavior:

– Change hot key settings 
– Customize how text is formatted 
– Choose initial microphone settings
– Set how often your user files are backed up
– Set where you can dictate commands, such as in web pages or other windows

• Modify the administrative settings displays the Administrative settings 
dialog box at the end of the installation. The Administrative settings dialog box lets 
you:

–  Set up the Roaming User feature
– Set the backup location of your user files
– Restrict users from modifying commands and vocabularies

• Formatting options displays the Formatting dialog box at the end of the 
installation. In this dialog box, you can choose ways that text should be 
automatically formatted (such as the date in US or European format) and the 
number of spaces after a period.

7. Click Next and on the Ready to Install the Program page you can choose to take 
two optional actions:

• Enable QuickStart option for the current user—Launches the product on 
system startup and places the QuickStart icon in the Windows task bar.

• Upgrade existing speech files to work with the installation—Immediately 
after you reboot, the user upgrade process begins. You can make this choice to 
upgrade users from Version 8.x or 9.x.

8. Continue following the on-screen instructions. The setup program will install the files 
for Dragon on your computer.

9. If you are upgrading and chose to upgrade speech files, when the message about 
upgrading your user speech files pops up, click OK.

10.After you click Finish and the installation is complete, if you did a Custom installation 
one or more of the following windows opens immediately:

• If you checked off Modify the application settings for all users, the Options 
dialog box opens. For more information on the Options dialog box, see the main 
Dragon Help file.
11
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• If you checked Modify the administrative settings, the Administrative 
Settings dialog box opens. For more information on setting administrative 
settings under the Roaming, Miscellaneous, and Scheduled Tasks tabs: 

•  Administrative Settings: Roaming tab

• Administrative Settings: Miscellaneous tab

• See "Administrative Settings: Scheduled Tasks tab" on page 

• If you checked Formatting options on the Custom Setup page, the Formatting 
dialog box opens. For more information on the Formatting dialog box, see the 
Main Dragon Help file.

11.After you click Finish, if you are prompted to restart your computer, restart it now. 
Otherwise, skip to the next step.

12.Start the product by selecting Start > All Programs > Dragon 
NaturallySpeaking 10 > Dragon NaturallySpeaking 10. The DragonBar 
appears on your desktop.

13.If you have users from Version 8.x or 9.x and you chose the Upgrade existing 
speech files to work with the installation check box earlier, the User Upgrade 
Wizard opens automatically. Otherwise, if you do not have any users to upgrade, the 
New User Wizard opens automatically so that you can create the first user.

Activating Dragon

The first time you start Dragon, you will be prompted to activate your copy of Dragon. 
If you do not activate the software, Dragon will stop working after you start the product 
fives times.

For more information on activation, please see the Dragon Version 10 User Guide.

Sample custom installation of Dragon Medical

This topic shows an example of a typical custom installation of Dragon Medical for the 
Roaming User environment.

Note: This is an example only and is provided to give administrators an overview of a 
typical installation and the kind of decisions you have to make. Though the example 
provides recommendations it is not meant as a substitute for your own planning.

For more information, see:

1. Installation checklists

2. Installing Dragon on a single machine

3. Overview of installing Dragon using Windows Installer (MSI)

Preparing for the Roaming User Feature

1. Create network storage location for Master Roaming User files. For example, you can 
create a shared drive that all Dragon users will have read/write access to. In this 
example, we’ll name this shared folder "Dragon."

2. In the shared "Dragon" folder, you can create 2 sub-folders; "Dragon Profiles" and 
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"Data Directory."

• "Dragon Profiles" is the location for the master copies of the user profiles. (For 
planning purposes allow for 500 MB per user profile.) 

• "Data Directory" is the location for macros and word lists that automatically update 
the user profiles by use of the Data Directory Tool. 

For more information, see Setting up the Roaming User feature.

Install Dragon Medical

 To install Dragon NaturallySpeaking or Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive or if installing from network drive, 
click on "setup.exe".

2. When you have the option, choose "custom installation". For example: 
 

 
Custom lets you select options and speech files to install. Customizing your 
installation options can greatly reduce the disk space required. See Choosing Medical 
Vocabulary to Support Your Specialty for more information. 
 
Click BI to continue.

3. On the Additional Options screen, select all 
three options. For example: 
 
 
 
Click Next to continue.
13
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Setting the Dragon Options

When the installation is complete, the three customization dialog boxes will open. The 
first to open is the Options dialog box.

Corrections tab:

You use this tab to control how the correction feature and spelling features work. 

In this example:

• Check Enable double-click to correct. Selecting this check box gives the user a 
way to correct with the mouse.

• Maximize the number of choices that can appear in the Correction menu by setting it 
to "9"
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The Commands tab:

You use this tab to set options that control how Dragon interprets commands. Unless 
otherwise indicated, changing these options only affects the current user; any other 
users keep their existing settings.

The following example shows the default settings:
15
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The View tab:

You use the View tab to control the behavior and appearance of the DragonBar and the 
Results box.

In this example, change Auto-hide delay from "Never Hide" to "5 seconds"

The Hot Keys tab:

You use the Hot keys tab to specify hot key assignments.

If your users will be using Dragon on a Notebook, then click "Microphone on/off" and 
hit the "F10" key to change the hotkey. 
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The PowerMic I and II tabs:

 If you are using Dragon and you are using a Dictaphone PowerMic for dictation, the 
Options dialog box displays the PowerMic I and II tabs. Dragon has built-in support for 
PowerMic or PowerMic II microphones. You can use the PowerMic II microphone buttons 
to perform predefined actions (described in the table below) or program the buttons to 
take custom actions.

The following example shows the default settings for the PowerMic II:
17
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The Text-to-Speech tab:

You use the Text-to-speech tab to adjust the attributes of text-to-speech playback.

In this example, increase the Speed slider slightly. The default value is a little too slow. 
For example:

The Miscellaneous tab:

You use this tab to set miscellaneous options.

In this example

Leave the Microphone on (asleep) option unchecked unless the user cannot or does 
not want to use their hands to turn the microphone on and off.

Check Automatically save user files to automatically save the user’s files when 
Dragon is closed.

For example:
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The Dictation Box tab:

On the Dictation tab of the Options dialog box, you can define how the Dictation Box 
operates.

For more information on the Dictation Box, see the 

"Using the Dictation Box" topic in Dragon help file.

The following example shows the default settings for the Dictation Box:
19
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The Data tab:

You use the Data tab to instruct Dragon to store corrections in an archive, conserve 
disk pace for better portability of user files, and control how Dragon adapts training, 
saves recorded dictation, and backs up user files.

In this example:

• Set the Save recorded dictation with document option to Never. You may want 
to set this option in most cases when using Dragon Medical and definitely when 
working in AP or EMR applications that only use a text editor to populate a database.

• Set the Automatically back up user files every "n" saves to nothing if your users 
are using the Roaming User option. When you have a Roaming User, the Master 
Roaming User profile most likely resides on a server that should be backed up every 
night.

For example:
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Setting the Administrative Options: Roaming Users

The second dialog to open at the end of the installation is the Administrative Settings 
dialog box. This section describes the Roaming tab of the Administrative options dialog 
box

You use the Roaming tab of the Administrative Settings dialog box to set up the 
Roaming User feature. You must set up the Roaming User feature on each computer 
where you want users to dictate with a Roaming User. For more information, see 
Setting up the Roaming User feature.

In this example:

• Select Enable to activate the Roaming User feature and the Roaming User options.

• Click the Add button. You use the Roaming User Network Location dialog box to 
define the network location of the master roaming users. The location you pick must 
be accessible to all computers on the network that you want available for dictation 
with Dragon. In this example, we’ll use the network storage location we initially 
created. For example: 
 

 
 

21
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• The Administrative Settings dialog box also contains several options that you can 
choose from to indicate how you want a Roaming User to function at each Roaming 
User location> 
 
In addition to the default settings, also enable the Access network at user open/
close only and Always copy acoustic information to network options. For 
example: 
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Click OK to continue.

• You will be prompted to create the default directory if it does not already exists, when 
you see the following message, always click Yes: 
 

23
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Setting the Administrative Options: Miscellaneous options

When the installation is complete, the three customization dialog boxes will open. The 
second to open is the Administrative Settings dialog box. This section describes the 
Miscellaneous tab of the Administrative options dialog box

In this example, click Change... to set the location of the Data Distribution Location 
to the network directory that you created at the beginning.

Also make sure to deselect the Check for product updates at startup option to 
disable Dragon from automatically checking the Nuance web site for product updates if 
you want to control which updates your users can get.
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Setting the Administrative Options: Scheduled Tasks 

When the installation is complete, the three customization dialog boxes will open. The 
second to open is the Administrative Settings dialog box. This section describes the 
Scheduled Tasks tab of the Administrative options dialog box

The following example shows the default settings for the Scheduled Tasks tab:

For more information, see the Dragon help file.
25
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Setting Formatting Options

The third dialog to open at the end of the installation is the Formatting dialog box. For 
example:

The Formatting dialog includes:

• General Tab—Controls general settings like how number, dates and times, and 
common number related abbreviations are formatted. Also on this tab is the option 
to spell out (expand) English contractions.

• Capitalization Tab—Controls how Dragon capitalizes dictated words, including 
medical terms.

• Numbers, Units, and Dates Tab—Contains rules for formatting numbers and units 
of measure, including rules specific to medical topics.

• Abbreviations Tab—Controls how medical-specific abbreviations are formatted.

• Miscellaneous Tab—Contains miscellaneous formatting rules.

1. Set the formatting options.

2. Click Apply to save your changes and leave the Formatting dialog box open.

3. Click OK to save your changes in the current tab, close the Formatting dialog box, 
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and have the changes take effect. Your changes do not take effect until after you 
close the dialog box.

Nuance recommends that you review these tabs to make appropriate choices for you 
site.

Overview of Installing Dragon Using Windows Installer (MSI)

Dragon NaturallySpeaking and Dragon Medical include a native Windows Installer (MSI) 
that lets you customize your installations as well as install across a network to multiple 
client machines. In addition, you use this service to modify, repair, or remove any 
existing installations.

Note: MSI installations are not supported for Dragon Medical Small Practice Edition.

Caution: Before you carry out an MSI installation you must install Visual C++ Runtime 
for Dragon on every machine where dictation will occur. The easiest way to install it is to:

1. Find the ISSetupPrerequisites directory on the product DVD and open it.

2. You see a subfolder with a long name enclosed in curly brackets {1FAD9007-0FF1-
4B05-B7CE-ADE12FB7DEC5}. Open that directory to find the vcruntime.exe file.

3. Copy the vcruntime.exe file to your server or to another accessible location and 
then run it on each machine where you intend to install Dragon. This .exe file installs 
Visual C++ Runtime for Dragon.

Caution: Do not attempt to extract the .msi file from the vcruntime.exe. Installing 
the Visual C++ Runtime for Dragon as part of an msiexec.exe installation is not 
recommended and not supported.

This section describes command line options for:

• Setting Windows Installer (msiexec.exe) options

• Setting msiexec.exe options specific to Dragon

• Using InstallShield (setup.exe) options

• Sample command lines Installing Dragon with setup.exe

• Extracting and using .MSI and .MST files

• Enabling Roaming Users in an msiexec.exe installation

• If you are setting up Dragon in a Citrix environment, refer to Installing the Citrix 
Client Update for an MSI installation.

Finding the MSI Installer

The compiled MSI file is located on your installation DVD. The files for each edition are 
named:

• Dragon NaturallySpeaking (all editions) or Dragon Medical: Dragon 
NaturallySpeaking 10.msi

• SDK Client Edition (DSC): Dragon SDK Client Edition 10.msi

• SDK Server Edition (DSS): Dragon SDK Server Edition 10.msi

You can double click on one of these .msi files to start the InstallShield Wizard. To 
instead take advantage of available command line options, you can pass the file name 
27
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as the application to install to the msiexec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking10.msi"

For details on other command line options,See "Setting Windows Installer 
(msiexec.exe) options" on page 

Installation notes

• Unless otherwise noted:

o All command line options are case-insensitive and may be combined.

o No options require special values based on the values of other options. 

• In the examples below, user-supplied information is displayed between angle 
brackets. Do not use angle brackets (<,>) as part of the command line. 

• Do not use quotation marks except when specifying a full path name with the -path 
command.

Windows Vista Notes

Dragon setup is designed so that msiexec.exe can be run from an elevated command 
prompt in Windows Vista. 

To launch an elevated command prompt in Windows Vista:

1. Click the Windows Start key

2. Type cmd in the search field

3. Press Ctrl+Shift+Enter. This action displays a User Account Control dialog box 
stating that Windows needs your permission to continue.

4. Click Continue or hit Alt+C to confirm the elevation prompt. This displays an 
elevated command prompt.

Alternatively, to run the command window as an administrator, you can select Start > 
All Programs > Accessories > Command Prompt (without releasing the mouse), 
then right click Command Prompt and select Run As. Choose an Administrator user 
and enter the authentication information requested.

Setting Windows Installer (msiexec.exe) options 

The Microsoft Installer Service (msiexec.exe) or MSI is an executable program that 
interprets packages and installs products.

Dragon supports all native MSI command line options. All options are documented in 
the Microsoft MSI documentation, found at:

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/
command_line_options.asp

Caution: Before you install Dragon using an MSI installation, you must install Visual 
C++ Runtime for Dragon on each dictation machine using the vcruntime.exe 
available on the product DVD. You cannot install Visual C++ Runtime as part of a 
typical msiexec.exe installation. For details on how to install it, refer to the caution in 
the Installing Dragon using the Windows Installer (MSI) topic. For how to install it from 
the command line, refer to Sample command lines Installing Dragon with setup.exe.

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/msi/setup/command_line_options.asp
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About MSI Installer Command Line Options

Unless otherwise noted, during installation with the MSI installer:

• All msiexec.exe command-line options must be prefaced with a forward slash (/) 
only. 

• All msiexec.exe command-line options are case -insensitive and can be combined.

• No options require special values based on the values of other options.

• In the examples shown, information you are to supply is between angle brackets. Do 
not enter the angle brackets (<>) as part of the command.

• Do not use quotation marks except when specifying a full path name with the -path 
command.

The following are the most useful MSI options for installing Dragon:

/i <Package|ProductCode> Installs or configures a product.

/q or /qn Quiet (or silent) mode installation.

/L 
[i|w|e|a|r|u|c|m|o|p|v|x|+|!|*] 
Logfile

Specifies the location of an installation logfile 
and specifies the nature of the information to be 
logged:

i—Status messages.

w—Nonfatal warnings.

e—All error messages.

a—Start up of actions.

r—Action-specific records.

u—User requests.

c—Initial UI parameters.

m—Out-of-memory or fatal exit information.

o—Out-of-disk-space messages.

p—Terminal properties.

v—Verbose output.

x—Extra debugging information. Only available 
on Windows Server 2003.

+—Append to existing file.

!—Flush each line to the log.

"*"—Wildcard, log all information except for 
the v and x options. To include the v and x 
options, specify /L*vx.

PROPERTY=VALUE Overrides default public property value. For 
example, setting XYZ=ABC will change the 
property value from XYZ to ABC.

Option Description
29
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Setting msiexec.exe options specific to Dragon

This section described the msiexec.exe options that apply to Dragon 
NaturallySpeaking and Dragon Medical.

Caution: Before you install Dragon using an MSI installation, you must install 
Visual C++ Runtime for Dragon on each dictation machine using the 
vcruntime.exe available on the product DVD. You cannot install Visual 
C++ Runtime as part of a typical msiexec.exe installation. For details on how to 
install it, refer to the caution in the Installing Dragon using the Windows Installer 
(MSI) topic. For how to install it from the command line, refer to Sample 
command lines Installing Dragon with setup.exe.

The Dragon command line options do not need to be prefaced by hyphens or slashes.

Note: Launching msiexec.exe /i "Dragon NaturallySpeaking 10.msi" 
XYZ=ABC automatically sets the property named XYZ to the value of ABC 
internally and continues the installation. However, installation through 
setup.exe still requires the /v command line option in order to pass the property 
override value on to the MSI service.

The following table presents supported global property overrides. Unless noted 
otherwise, all property values are in UPPERCASE.

Option Description

ADDLOCAL=Feature1,Feature2,... 

or 

ADDLOCAL=ALL

Set the ADDLOCAL property to a list of 
features to be installed locally, delimited 
by commas. 

 To install all features locally (including 
speech files), use ADDLOCAL=ALL on the 
command line.

ADVERTISE=Feature1,Feature1,... Set the ADVERTISE property to a list of 
features to be advertised, delimited by 
commas.

To install all features as advertised, use 
ADVERTISE=ALL on the command line.

The ADVERTISE option overrides the 
ADDLOCAL option. 

The best method for specifying a custom 
installation is to set the ADDLOCAL 
property to ALL and then set the 
ADVERTISE property to match those 
features you don’t want installed locally. 
A list of the features that you can set for 
installation is listed in the section after 
this table.
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DEFAULTSINI="c:\xyz.ini" Indicates a default settings file that the 
installer uses to change the default 
behavior of the product for all users. The 
specified file contains settings that will be 
merged into the nsdefaults.ini file at 
installation time. This file must be in an 
.ini file format, where any settings you 
want to merge must have a section name 
encased in square brackets as well as the 
value and data. If only values and data 
are set in this file without the section 
name encased in brackets, the settings 
are not merged.

Settings in the .ini file are the same as 
settings found in Dragon’s Options dialog 
box. 

 Follow these steps to create a 
nsdefaults.ini file for an MSI 
installation:

1. Install Dragon on a machine with 
Windows administrator privileges.

2. Set the Dragon options from the 
Options dialog box as required in your 
environment. 

3. Save your settings by closing Dragon.

4. Copy the nsdefaults.ini file created by 
this installation of Dragon to a separate 
location. By default, the nsdefaults.ini 
is located in: 
C:\Documents and Settings\All 
Users\Application 
Data\Nuance\NaturallySpeaking10\

5. Use the copied nsdefaults.ini as the 
input for the DEFAULTSINI option.

SERIALNUMBER=abcde-fgh-ijkl-mnop-qr Serial number, in the form of abcde-fgh-
ijkl-mnop-qr.  
A serial number is required for all 
installations. If one is not already built 
into the ereg.ini file, then you must 
specify a valid one on the command line. 

 
Note: Specifying a serial number 
on the command line does not 
bypass the serial number checking 
within setup.

Option Description
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INSTALLDIR="c:\xyz" Default installation directory. 

In long path names require their quoted 
strings be escaped using a back slash 
before each quotation mark (\"). If you do 
not use this option, Dragon is installed to 
the default directory: 
[PROGRAMFILES]\Nuance\NaturallySpea
king10 

If you are upgrading from an earlier 
version, you must set INSTALLDIR to that 
version’s installation directory.

PRODUCTUPDATEFLAG=0 (or 1 or -1) Sets the default state of the product 
update check box at the end of 
installation, to indicate whether the 
installation should automatically check 
the web for product updates. 

A value of 0 (zero) turns the check box off 
by default, 1 (one) turns it on by default.

To disable the option entirely (turn the 
option off and suppress the display of the 
check box altogether), set the value to -
1. 

The default setting is 1 (enables the 
check box and checks for product updates 
by default).

NOTYPICAL=1 Sets the default choice in the Setup Type 
page of the Installation Wizard to 
Custom, rather than Typical/
Complete.

Option Description
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PERIODIC_TASK=<string> Sets schedule for either one, two, or three 
tasks — an acoustic model optimization 
(ACO) task, language model optimization 
(LMO) task, and/or data collection (DC) 
task. You can schedule each task to run 
daily or weekly, but need to set the 
schedule for each task only once.

The <string> contains these arguments, 
separated by semicolons:

•  aco | lmo | dc — One, two, or all three 
of them with a vertical bar separating 
each.

• Administrator login name. Be sure you 
use the fully qualified <domain 
name>\<account name> in a case 
where the user is a local administrator 
but the machine is on a domain.

• Administrator password.

• When to run the task(s), with times for 
each of multiple tasks separated by a 
vertical bar (|). Each scheduled time 
should be in the format DayOfWeek, 
hh:mm, where the day of the week is 
the three letter abbreviation (no 
period), the time is the 24-hour time, 
and the comma between them is 
required.  
 
The task runs once a week on the day/
at the time you indicate. If you omit the 
DayOfWeek, the task runs every day at 
the time given.  
 
The first of multiple times becomes the 
schedule for the first task named in the 
first parameter, the second time the 
schedule for the second task, the third 
the schedule for the third task. If you 
omit a time by having two vertical bars 
with no time between them or by 
leaving out the first or last time, the 
corresponding task is scheduled for a 
default time:

Option Description
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Default Schedules

o Acoustic model optimization (ACO) — 
Mon, 02:00

o Language model optimization (LMO) — 
Every day, 03:00

o Data collection (DC) — Fri, 01:00

 Examples of PERIODIC_TASK Settings

A string setting this option to perform an 
acoustic model optimization every 
Monday at 1 AM and a language model 
optimization the same day at 2 AM is 
(notice the comma between the day of 
the week and the time):

PERIODIC_TASK="aco|lmo;admin;pswd;
Mon, 01:00|Mon, 02:00"

To schedule only data collection and 
language model optimization tasks and 
have them occur every day at 4 PM and 
11 PM, respectively, you would enter only 
the time for each task, without indicating 
a particular day:

PERIODIC_TASK="dc|lmo;myadmin;myps
wd;04:00|23:00"

A string setting this option to perform an 
acoustic model optimization every 
Tuesday at midnight, data collection 
every Wednesday at 3 AM, and a 
language model optimization every Friday 
night at 10 PM is:

PERIODIC_TASK="aco|dc|lmo;myadmin;
mypswd;Tue,  
00:00|Wed, 03:00|Fri, 22:00"

To have the data collection and language 
model optimization tasks shown in the 
previous example occur at their default 
times, you would modify the previous 
string by removing the corresponding 
times for those tasks from the string, but 
leaving space between the vertical bars 
and after the last vertical bar:

PERIODIC_TASK="aco|dc|lmo;myadmin;
mypswd;Tue,  
00:00||"

Option Description
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RebootYesNo=No Stops Windows from rebooting, even if 
the installation will not be complete until 
Windows is restarted.

Note case: This option is case-
sensitive; it should not be changed 
to uppercase.

This option will also suppress the 
prevention of installation when a reboot is 
necessary.

QUICKSTART=0 (or 1) Set the default state of Enable 
QuickStart Mode check box to enable 
QuickStart and to create shortcut for 
Dragon in the Windows Startup folder. 

A value of 0/1 will turn check box off/on, 
respectively.

REINSTALL=Feature1,Feature2,... (or 
ALL)

List of features that are to be reinstalled, 
delimited by commas. To reinstall all 
features use REINSTALL=ALL on the 
command line.

If the REINSTALL property is set, the 
REINSTALLMODE property should also be 
set, to indicate the type of reinstall to be 
performed. If the REINSTALLMODE 
property is not set, then by default all 
files that are currently installed are 
reinstalled only if the currently installed 
file is an earlier version (or is not 
present). By default, no registry entries 
are rewritten.

Note that even if REINSTALL is set to ALL, 
only those features that were already 
installed previously are reinstalled. Thus, 
if REINSTALL is set for a product that is 
yet to be installed, no installation action 
takes place at all.

For more information, see: http://
msdn.microsoft.com/library/
default.asp?url=/library/en-us/msi/
setup/reinstall.asp

Option Description
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REINSTALLMODE={specifying the type of 
reinstallation to perform}

String that contains letters indicating the 
type of reinstall to perform. Options are 
case-insensitive and order-independent. 
This property should normally always be 
used in conjunction with the REINSTALL 
property. However, this property can also 
be used during installation, not just 
during a reinstall.

If the REINSTALLMODE property is 
defined without also defining the 
REINSTALL property, then the specified 
detection modes still apply and specify 
the overwrite mode for a normal 
installation. The REINSTALLMODE 
property only affects those features that 
are selected normally for installation. Just 
setting the REINSTALLMODE property 
does not reinstall features. For 
reinstallation of features to occur, you 
must have set the REINSTALL property.

For example, to launch a minor upgrade 
without using setup.exe, you must set 
the following properties through the 
command line:

REINSTALL=ALL 
REINSTALLMODE=vemus

To install a minor upgrade through the 
.msi file, issue the following command 
line:

msiexec /i 
"<Dragon_MSI_filename.msi" 
REINSTALL=ALL REINSTALLMODE=vemus.

For more information on 
REINSTALLMODE and the reinstall option 
codes, see: http://msdn.microsoft.com/
library/default.asp?url=/library/en-us/
msi/setup/reinstallmode.asp

Option Description
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ROAMINGUSEROPTIONS="c:\xyz.ini" Specifies an options file that contains 
Roaming User settings to be merged 
into nssystem.ini at installation time. 

 These are the same options set on the 
Roaming tab of the Administrative 
settings dialog box.

You can either create a text file to set 
these options (see Setting Roaming user 
options) or you can copy these options 
from an existing installation of Dragon as 
follows:

² Install Dragon on a machine with 
Windows administrator privileges.

2. Enable the Roaming User feature and 
set all the Roaming User options on 
the Roaming User tab of the 
Administrative settings dialog box as 
required in your environment.  
Note: The Roaming User location is 
written in a separate file called 
roaming.ini, an unencrypted file that 
is supplied for the ROAMINGUSERINI 
option, described below.

3. Test these settings to make sure the 
Roaming User connection works.

4. Open nssystem.ini. By default, 
nssystem.ini is located in: 
C:\Documents and Settings\All 
Users\Application 
Data\Nuance\NaturallySpeaking10\

5. The Roaming User options in 
nssytem.ini are listed in the 
[Settings] section and have the 
format Roaming User <option>.

6. Copy the Roaming User options to a 
separate file and give that file a unique 
name.  
Note: Do NOT name the file 
roaming.ini.

7. Set the ROAMINGUSEROPTIONS option 
to the path to the file you named in the 
previous step. The default setting for 
this option is empty (no .ini file to be 
merged).

 

Option Description
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 Notes: Long path names are required to 
have their quoted strings escaped by using a 
back slash before each quotation mark (\"). 
This file must have a unique name and 
cannot be named roaming.ini. This file must 
be a text file. Any settings you want to merge 
must also have a [Settings]section head as 
well as the value and data. If only values and 
data are set in this file (without the section 
name encased in brackets), the settings are 
not merged. This file does not specify the 
Master Roaming User location. You specify 
the Master Roaming User by setting the 
ROAMINGUSERINI option.For a list of 
options, see Setting/selecting Roaming User 
options.

ROAMINGUSERINI="c:\xyz.ini" Specifies a roaming user .ini file 
(roaming.ini) that contains the Master 
Roaming User location and any 
associated HTTP or HTTPS settings for a 
roaming user. These are the same 
options set in the Network Directories 
field of the Roaming tab of the 
Administrative settings dialog box and 
the HTTP and HTTPS Settings dialog 
boxes.

When you enable Roaming User, 
Dragon creates an encrypted 
roaming.ini file. Use the following steps 
to create a roaming.ini file to be used for 
an MSI installation where Roaming User 
is enabled:

1. Install Dragon on a machine with 
Windows administrator privileges.

2. Enable the Roaming User feature and 
set all the Roaming User options 
required in your environment. These 
must include the Master Roaming 
User location set in the Network 
Directories field in the Roaming tab 
of the Administrative settings dialog 
box and any HTTP or HTTPS settings. 

3. Test these settings to make sure the 
Roaming User connection works.

4. Save your settings by closing Dragon.

Option Description
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ROAMINGUSERINI="c:\xyz.ini" (continued) 5. Copy the encrypted roaming.ini file 
created by this installation of Dragon to 
a separate location. By default, 
roaming.ini is located in: 
C:\Documents and Settings\All 
Users\Application 
Data\Nuance\NaturallySpeaking10\

6. Set the ROAMINGUSERINI option to 
the name of the roaming.ini file. The 
default is empty (no .ini file will be 
used).

To set these options using 
ROAMINGUSERINI, the Roaming User 
feature must be enabled in the 
ROAMINGUSEROPTIONS option. For 
more information, see Setting Roaming 
user options.

SETDEFAULTS=0 (or 1) If set to 1, sets the default state of 
Modify the application’s settings for 
all users check box to display the 
Options dialog box at the end of the 
installation. The Options dialog box lets 
you change Dragon’s standard behavior, 
including specifying hot keys, 
customizing how text is formatted, 
changing initial microphone settings, and 
setting the how often your user files are 
backed up. 

A value of 0/1 will turn check box off/on 
accordingly.

With SETDEFAULTS=1, no dialogs display 
during installation if /qn is used for quiet 
mode installation.

SETADMINS=0 (or 1) If set to 1, sets the default state of 
Modify the administrative settings 
check box to display the Administrative 
settings dialog box at the end of the 
installation. The Administrative 
settings dialog box lets you set up the 
Roaming User feature, set the backup 
location of your user files, and restrict 
users from modifying commands and 
vocabularies. 

A value of 0/1 will turn check box off/on 
accordingly.

With SETADMINS=1, no dialogs display 
during installation if /qn is used for quiet 
mode installation.

Option Description
39



40

Dragon®  Medical Installation and Administration Guide
Feature variables that can be set on the command line through the 
ADDLOCAL or ADVERTISE property

Note the following when specifying features on the command line:

• If a feature doesn’t exist in a particular edition or language, overriding its default 
property has no effect. 

• Some features (for example, the Speech feature) have sub features. Setting these 
features on the command line automatically turns on the properties of all sub 
features, unless those sub features have an additional override also specified.  
 
Sub features are indented from their parent features, and any information in 
parentheses is not included in the feature name.

The following features can be specified from the command line:

WEBREGISTRATION=1 (or 0) Determines whether or not to launch the 
on-line product registration form after the 
installation completes. 0 disables the 
product registration. The default of 1 
enables display of the form.

Option Description

Feature—Sub-feature Sub-feature Sub-feature
NatSpeak 
 
Note: Must be included in 
ADDLOCAL, otherwise 
installation will fail 

  

Samples (Sample Commands 
files) 

  

TTS (Text-to-Speech) TTSDEU 
 (German Text-to-Speech) 
TTSENX  
 (English Text-to-Speech) 
TTSESP 
 (Spanish Text-to-Speech) 
TTSFRA  
 (French Text-to-Speech) 
TTSITA 
 (Italian Text-to-Speech) 
TTSNLD 
 (Dutch Text-to-Speech) 

 

Tutorial TutDEU (German Tutorial) 
TutENX (English Tutorial) 
TutESP (Spanish Tutorial) 
TutFRA (French Tutorial) 
TutITA (Italian Tutorial) 
TutNLD (Dutch Tutorial)
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Speech—DEU (German) DEU (German) Sub-features for DEU 
(German):

DEUGeneral (German 
General Large, Swiss 
German General, Empty 
Dictation General)  
DEULegal (German Legal) 
DEUMedical (German 
Medical Large) 
DEURadiology (German 
Medical Radiology Large)

Speech—ENX (English) AUS (Australian English) Sub-features for AUS 
(Australian English): 

AUS (Australian English 
General Large) 
Not available in Dragon 
Medical, where you instead 
use UK English with an 
Australian accent.

Speech—ENX (English) ENU (US English) Sub-features for ENU 

(US English): 
ENULegal (US English 
Legal Large) 
ENUGeneral (US English 
General Medium, US 
English Empty Dictation, 
US English Commands 
Only) 
ENUGenSvc (US English 
Large General)

Dragon Medical Only:  
Sub-features for ENU 
(US English):
ENUCardiology 
(US English Medical 
Large Cardiology, Pediatric 
Cardiology)ENUEmergency 
(US English Emergency 
Medicine Large) 
ENUGastroenterology (US 
English Medical Large 
Gastroenterology, 
Pediatric 
Gastroenterology) 

Feature—Sub-feature Sub-feature Sub-feature
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Speech—ENX (English)  
(continued)

ENU (US English) 
(continued)

Dragon Medical Only:  
Sub-features for ENU 
(US English)  
(continued):
ENGGeneralPractice 
(US English Large Family 
Medicine, Allergy and 
Immunology, 
Dermatology, 
Epidemiology, Geriatric, 
Hematology, Infectious 
Disease, Internal 
Medicine, Medical 
Education and Writing, 
Nephrology, Nursing, 
Osteopathy, Pulmonary 
Disease, Rheumatology, 
Sleep Lab)
ENUMedical (US English 
General Medical Large—
No Specialty) 
ENUMentalHealth 
(US English Large 
Medical Addiction 
Psychiatry; 
Endocrinology, Diabetes, 
and Metabolism; 
Psychiatry, 
Psychology)ENGNeurolog
y (US English 
Anesthesiology, 
Neurology, Pain 
Medicine, Physical 
Medicine and 
Rehabilitation, Vascular 
and Interventional 
Radiology) 
ENUObGyn (US English 
Medical Large ENT, Fetal 
Medicine, Midwifery, 
Obstetrics and 
Gynecology, 
Ophthalmology) 
ENUOncology (US English 
Medical Large Oncology, 
Radiation Therapy) 
ENUOrthopaedic 
(US English Medical 
Large Dentistry, Large 
Hand Surgery, 
Neurosurgery, 
Orthopaedics, Oral and 
Facial Surgery, 
Orthopaedic Surgery, 
Plastic Surgery, Podiatry) 
ENUPathology (US 
English Medical Large 
Pathology)ENUPediatrics 
(US English Medical 
Large Pediatrics, 
Neonatal and Perinatal 
Medicine, Pediatric 
Dentistry) 

Feature—Sub-feature Sub-feature Sub-feature
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Speech—ENX (English)  
(continued)

ENU (US English) 
(continued)

ENURadiology (US English 
Medical Large Nuclear 
Medicine or Radiology) 
ENUSurgery (US English 
Medical Large Cardiac 
Surgery, Colon and Rectal 
Surgery, Surgery, Thoracic 
Surgery, Urology, Vascular 
Surgery)

Speech—ENX (English) ENG (UK English) Sub-features for ENG 
(UK English): 

ENGGeneral (UK English 
General Large, Empty 
Dictation General, 
Commands Only) 

Dragon Medical Only:  
Sub-features for ENG 
(UK English): 

ENGCardiology (UK English 
Cardiology Large) 
ENGEmergency (UK 
English Emergency Large) 
ENGGastroenterology (UK 
English Gastroenterology 
Large)  
ENGGeneralPractice (UK 
English General Practice 
Large) 
ENGMedical (UK English 
Medical Large— No 
Specialty) 
ENGMentalHealth (UK 
English Mental Health 
Large) 
ENGNeurology (UK English 
Neurology Large) 
ENGObGyn (UK English 
ObGyn Large) 
ENGOncology (UK English 
Oncology Large) 
ENGOrthopaedic (UK 
English Large Orthopedic) 
ENGPathology (UK English 
Large Pathology) 
ENGPediatrics (UK English 
Large Pediatrics) 
ENGRadiology (UK English 
Large Radiology) 
ENGSurgery (UK English 
Large Surgery)

Feature—Sub-feature Sub-feature Sub-feature
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Speech—ENX (English) IND (Indian English) Sub-features for IND 
(Indian English): 

IND (Indian English Large 
General)

Not available in Dragon 
Medical, where you instead 
use UK English with an 
Indian accent.

Speech—ENX (English) SEA (SouthEast Asian English) Sub-features for SEA 
(SouthEast Asian 
English): 

SEA (SouthEastern Asian 
English Large General)

Not available in Dragon 
Medical, where you instead 
use UK English with a 
Southeast Asian accent.

Speech—ITA (Italian)  ITA (Italian) Sub-features for ITA 
(Italian): 

ITA (Italian General Large 
and Italian Empty Dictation 
General Large)

Speech—NLD (Dutch) NLD (Dutch) Sub-features for NLD 
(Dutch): 

NLDGeneral (Dutch 
General Large and Dutch 
Empty Dictation General 
Large)

Dragon Medical only:  
Sub-features for NLD 
(Dutch): 

NLDCardiology (Dutch 
Cardiology) 
NLDGeneralPractice (Dutch 
General Practice) 
NLDMedical (Dutch Medical 
Large) 
NLDOrthopaedics (Dutch 
Orthopaedics Large) 
NLDPathology (Dutch 
Pathology Large) 
NLDPediatrics (Dutch 
Pediatrics) 
NLDRadiology (Dutch 
Radiology Large) 
NLDRalph (Dutch Ralph 
Large) 
NLDSurgery (Dutch 
Surgery Large) 

Feature—Sub-feature Sub-feature Sub-feature
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Setting Roaming user options

You use the ROAMINGUSEROPTIONS option to specify a roaming user options file that 
contains settings to be merged into nssystem.ini at installation time. 

 These are the same options set from the Roaming tab of the Administrative 
Settings dialog box.

You can either create a text file to set these options or you can copy these options from 
an existing installation of using the procedure described under 
ROAMINGUSEROPTIONS.

The following options can be set with the ROAMINGUSEROPTIONS option:

Speech—FRA (French) FRA (French) Sub-features for FRA 
(French): 

FRAGeneral (French 
General Large, French 
Empty Dictation General 
Large) 
FRAMedical (French 
Medical Large) 
FRARadiology (French 
Radiology Large) 
 

Speech—ESP (Spanish) ESP (Spanish) Sub-features for ESP 
(Spanish): 

ESP (Latin American 
Spanish General Large) 
ESP (Latin American 
Spanish Empty 
Dictation General Large) 
ESP (Castilian Spanish 
General Large) 
ESP (Castilian Spanish 
Empty Dictation General 
Large)

Feature—Sub-feature Sub-feature Sub-feature

 
 
 
Options

 
 
  
Description

UI equivalent

(Roaming tab of 
Administrative Settings 
dialog)

Roaming User On=0 (or 
1)

 Turns on the Roaming 
User feature.

 Default 0 = Off

Enable
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Roaming User Local 
Cache 
Directory="existing 
directory"

 Sets the location of the 
local copy of the roaming 
user.

The default location is: 
Documents and 
Settings\All 
Users\Application 
Data\Nuance\Dragon 
NaturallySpeaking10\Roa
mingUsers\.

Local directory (for cache) 

Roaming User Restrict 
Local User Access=1 (or 
0)

 Permits non-roaming 
user to be opened when 
the roaming user feature 
is active. Default of 1 
restricts access to 
roaming users only, 
preventing non-roaming 
(local) users from 
dictating by accident.

Allow non-Roaming Users 
to be opened

Roaming User Copy 
Dragon Log=0 (or 1)

 Copies the dragon.log 
file from the local 
roaming user location to 
the master roaming user 
location at the same time 
that the program 
synchronizes the local 
and the master roaming 
user. Default 0= Off

Copy Dragon Log to 
Network

Roaming User Limited 
Network Traffic=0 (or 1)

 Transfers local roaming 
user changes to the 
master roaming user to 
synchronize the local and 
the master roaming user 
only when you open or 
close the user. This 
changes include the 
changes a user makes 
locally from the Options 
dialog box.

 For more information, 
see Synchronizing Master 
and Local Roaming Users. 
Excessive network 
slowdowns can be 
alleviated by checking 
this option because it 
limits multiple interim 
synchronizations of local 
and master roaming 
users. Default 0= Off.

Access network at user 
open/close only

 
 
 
Options

 
 
  
Description

UI equivalent

(Roaming tab of 
Administrative Settings 
dialog)
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Roaming User Always 
Break Lock=0 (or 1)

 Ask before breaking the 
locks on network users 
(recommended). 

 A network lock prevents 
opening a roaming user 
that is already open. 
Network problems can 
cause a lock to become 
"stuck" and not release 
even after opening the 
user is complete. Default 
of 0 produces a prompt 
that states the user is 
locked and asks you to 
override the lock. A 
setting of 1 does not 
produce the prompt, but 
breaks the lock 
automatically.

Ask before breaking locks 
on network users 
(recommended for UNC 
and mapped drives) 

Roaming User Max 
Container Size=500MB

 Controls the maximum 
size for each container 
directory in the master 
roaming user directory. 
Defaults to 500 MB, max 
of 10000 MB.

Disk space reserved for 
network archive

ASW Override=0 (or 1) (ASW is short for Audio 
Setup Wizard.) Runs a 
Volume and Quality 
Check on the microphone 
each time you open a 
roaming user.

 Turn this option on if your 
users experience reduced 
accuracy because of 
differences in the 
microphone, sound card, 
and ambient sound levels 
at different locations. 
Default 0 = off.

Set audio levels on each 
machine 

 
 
 
Options

 
 
  
Description

UI equivalent

(Roaming tab of 
Administrative Settings 
dialog)
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Roaming User Do Not 
Copy Dra Files=0 (or 1)

 Prevents making files 
that contain acoustic data 
from the latest dictation 
session available to the 
Acoustic Optimizer 
when the program 
synchronizes the local 
and master roaming 
users. 

 Setting this option 
prevents the Acoustic 
Optimizer from running 
on a local roaming user. 
To not retain optimizer 
information, you use this 
option to prevent the 
transfer.

Conserve archive size on 
network

Roaming User 
Incorporate Voc Delta=0 
(or 1)

Copies the contents of the 
local vocdelta.dat file to 
the master roaming user 
without running the 
Acoustic and Language 
Model Optimizer. When 
the vocdelta.dat file 
reaches 90% of its 
maximum size (500KB), 
copies the contents of the 
file to the master 
roaming user and clears 
the local copy out. Occurs 
when you open the local 
roaming user and can be 
time consuming. Default 
0 = off.

Merge contents of 
vocdelta.dat into network 
user when file is full

 
 
 
Options

 
 
  
Description

UI equivalent

(Roaming tab of 
Administrative Settings 
dialog)
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Roaming User Copy 
Acoustic Always=0 (or 1)

Copies the user’s acoustic 
information to the 
master roaming user 
location. The local 
roaming user acoustic 
information is stored in: 

Documents and 
Settings\All 
Users\Application 
Data\Nuance\Naturally
Speaking10\RoamingUse
rs\<display 
name>\<username>\curr
ent\voice

The <display name> is 
the name you defined for 
the master roaming user 
location. You can have 
multiple network storage 
locations. The 
<username> contains the 
names of the individual 
master roaming users.

Select this option to copy 
the user’s acoustic 
information to the Master 
Roaming User location. 

You would select this 
option only if your 
roaming users are moving 
between identical 
machines; in other words, 
machines must be the 
same model, have the 

Always copy acoustic 
information to network

 
 
 
Options

 
 
  
Description

UI equivalent

(Roaming tab of 
Administrative Settings 
dialog)
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Roaming User Copy 
Acoustic Always=0 (or 1)

machines must be the 
same model, have the 
same sound card and use 
the same dictation source 
(microphone). Checking 
this box when the 
machines are identical 
will causes changes on 
one machine to be 
updated on the other 
machines in your 
network, increasing 
accuracy.

 If the users roam 
between differently 
configured machines, or 
use different models of 
microphones, or you are 
not sure, do not select 
this option. Selecting this 
option in an environment 
that uses different 
machines, different 
sound cards, or different 
microphones may cause 
a decrease in accuracy on 
all machines.

If you chose not to copy 
the user’s acoustic 
information to the 
network, corrections you 
make on one machine are 
not available on other 
machines used by that 
particular roaming user 
until you run the 
Acoustic and Language 
Model Optimizer on the 
master roaming user 
location and the local 
and master roaming 
user synchronize. When 
this option is set to 1 
(on), the latest acoustic 
information is always 
available and 
automatically 
synchronized when the 
master roaming user is 
opened from another 
location. The transfer of 
acoustic information is 

Always copy acoustic 
information to network

 
 
 
Options

 
 
  
Description

UI equivalent

(Roaming tab of 
Administrative Settings 
dialog)
not limited by setting the 
Disk space reserved 
for network archive 
option. Default 0 = off.
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Example .ini file:

[Settings]

Roaming User On=1 
Roaming User Copy Dragon Log=1 
Roaming User Copy Acoustic Always=1 
Roaming User On=1 
Roaming User Limited Network Traffic=1 
Roaming User Restrict Local User Access=0 
Roaming User Do Not Copy Dra Files=1 
Roaming User Max Container Size=300 
Roaming User Incorporate Voc Delta=1

Using InstallShield (setup.exe) options

 Like the Microsoft Installer Service (msiexec.exe), the InstallShield Setup program 
(setup.exe) can accept a number of command line options and can pass those options 
to the included .msi file.

 All setup.exe command-line options must be prefaced with a forward slash (/) only. 

 All options are documented in the InstallShield documentation at: http://
helpnet.installshield.com/robo/projects/helplibdevstudio9/
IHelpSetup_EXECmdLine.htm

For information on running msiexec.exe on Windows Vista, see Installing Dragon 
NaturallySpeaking using the Windows Installer (MSI).

Caution: Before you install Dragon using an MSI installation, you must install 
Visual C++ Runtime for Dragon on each dictation machine using the 
vcruntime.exe available on the product DVD. You cannot install Visual 
C++ Runtime as part of a typical MSI installation. For examples installing it, refer 
to Sample command lines Installing Dragon with setup.exe.

 The following are the most useful command line options:

Option Description

/v  Passes command line and public properties options to the 
Windows Installer (msiexec.exe) installation. 

 If you run setup.exe (rather than msiexec.exe) to install 
Dragon SDK Client, you can specify any Windows Installer 
command line options using the /v option. 

 For example, for MSI quiet mode, you’ll need to run: setup.exe 
/v/qn. 

To set the public property XYZ to ABC, you would run: 
setup.exe /v"XYZ=ABC"
51
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Extracting msi files from single-file installation executables (setup.exe 
files)

The following options are designed to extract .msi/.mst files from Windows Installer-
oriented setup.exe distributions. These options will not install any files; they will only 
extract an installable set of files into a specified directory.

/s  Formerly "noui," a command line flag no longer supported.

 Runs setup in a Silent mode, suppressing the initialization 
window. However, unless the MSI installation is also specified as 
silent, the MSI installation runs normally. 

 In order to run both setup.exe and msiexec.exe silently, you 
need to combine the /s and the /v options. Enter the command 
this way: 
setup.exe /s /v/qn

 With these options, no dialogs of any kind display during 
installation or uninstallation. All messages are suppressed or, if a 
log file is also specified, sent to the MSI log file in the user-
specified temp directory. 

/L 
(followed 
by the 
Windows 
Language 
Code)

 For multi-lingual installations, specifies the language to use for 
installation and bypasses the Choose Installation Language 
dialog box. 

 For example to launch the installation in French, the command 
line would be: setup.exe /L1036. The code for English is 1033.

Option Description

/a Administrative installation option. Instructs setup.exe to 
perform an administrative installation to a network for use 
by a workgroup instead of a normal installation. This option 
is required when trying to extract the .msi files.

An administrative installation installs a source image of the 
application onto the network. This image is similar to a 
source image on a CD or DVD.  Users in the workgroup who 
have access can then install the product from this source by 
installing it from the network.

/v Passed arguments to Windows Installer. See previous table 
for details. This option is required when trying to extract the 
.msi files.

Option Description
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Sample command lines Installing Dragon with setup.exe

The command lines shown below illustrate using setup.exe with various properties to 
install Dragon. These same examples could install Dragon Medical as well.

Using setup.exe to install

Caution: Before you install Dragon using an MSI installation, you must install 
Visual C++ Runtime for Dragon on each dictation machine using the 
vcruntime.exe available on the product DVD. Details are provided in each 
example below.

Caution: A script for carrying out a full administrative installation, including 
installation of Visual C++ Runtime for Dragon, is provided in the 
admininstall.bat file at the top of the directory structure on the DVD.

Administrative Installation

The following sample script line carries out an administrative installation of Visual 
C++ Runtime for Dragon from the DVD, which you are required to install before you 
run setup.exe to install Dragon:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-
ADE12FB7DEC5}\vcruntime.exe /a /

/l 
(followed by the 
Windows Language 
Code)

Specifies the language to use for installing Dragon. For 
example, to launch the installation in French, the command 
line would be setup.exe /L1036. The following language 
codes are supported for installing Dragon 
NaturallySpeaking:

ß 1031=German 

ß 1033=English 

ß 1034=Spanish 

ß 1036=French 

ß 1040=Italian 

ß 1043=Dutch 

This option creates an MST file for the language that is 
specified, for example, 1036.MST.

EXTRACTFILES="c
:\xyz" 

The directory where the .msi/.mst files are to be extracted. 
Long path names need to have their quoted strings escaped 
by having a back slash in front of each quotation mark (\"). 
This property must be set when trying to extract the .msi 
files. If the specified directory doesn’t exist, it is created.

A sample command that extracts msi files from a single file 
executable might look like this:

setup.exe /a /s /
v"EXTRACTFILES=c:\temp\msifiles" 

Option Description
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v"TARGETDIR=TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /Liwmole+ 
TEMP\admininstall.log"

The following sample script line carries out an administrative installation of Dragon:

setup /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR% /Liwmole+ 
%TEMP%\admininstall.log"

For a complete script, see the admininstall.bat file in the top directory of the product 
DVD.

Silent Installation with Particular Vocabularies

The following sample command line installs Visual C++ Runtime for Dragon from the 
DVD. You must install this program before you run setup.exe to install Dragon:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-
ADE12FB7DEC5}\vcruntime.exe

The InstallShield wizard pops up and steps you through the installation of the program.

The following sample command line silently installs Dragon locally with a particular set 
of vocabularies available for installation on-demand:

setup /s /v /qn INSTALLDIR=\"c:\\natspeak10\" SERIALNUMBER=abcde-fgh-
ijkl-mnop-qr ADDLOCAL=ALL 
ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology,ENUGeneralPract
ice,ENUMentalHealth, 
ENUNeurology,ENUObGyn,ENUOncology,ENUOrthopaedic,ENUPathology,ENUPediatr
ics,General /Liwmo!e c:\\Setup.log

The table below describes each option:

Option or Property Description

/s Runs setup in a Silent mode, suppressing the 
initialization window.

/v Passes command line and public properties options 
to the Windows Installer (msiexec.exe) installation.  
In order to run both setup.exe and msiexec.exe 
silently, this example combines the /s and the /v 
options. Use the following command line: setup.exe 
/s /v/qn.  
No dialogs of any kind are displayed during 
installation or uninstallation. Instead of displaying 
messages on the screen, this command sends all 
messages to the Setup.log file. 

/qn Quiet (or Silent) mode installation.

INSTALLDIR=\"c:\\sdk10\" Sets the installation directory to C:\natspeak10.

SERIALNUMBER=abcde-fgh-
hij-klmo-pq

Supplies the serial number for the installation. The 
serial number is required.

ADDLOCAL=ALL Installs all features locally.
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Extracting and using .MSI and .MST files

.MST files let you tailor the MSI installations without changing any of the setup.exe 
files that Nuance provides.

Caution: Before you install Dragon using an MSI installation, you must install Visual 
C++ Runtime for Dragon on each dictation machine using the vcruntime.exe 
available on the product DVD. You cannot install Visual C++ Runtime as part of a 
typical MSI installation. For details on how to install it, refer to the caution in the 
Installing Dragon using the Windows Installer (MSI) topic. For examples installing it, 
refer to Sample command lines Installing Dragon with setup.exe.

Running setup.exe to extract .MSI and .MST files

Caution: Before you run this command line, be sure you have installed Visual 
C++ Runtime for Dragon (see Caution near the top of this topic).

The following sample command line installs  Visual C++ Runtime for Dragon from the 
DVD. You must install this program before you run setup.exe to install Dragon:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-
ADE12FB7DEC5}\vcruntime.exe

The InstallShield wizard pops up and steps you through the installation of the program.

The following sample command line extracts the .MSI file, Dragon SDK Client Edition 
10.msi , and the .MST file used for installing the SDK Client Edition in French (you 
must be in the appropriate directory for the SDK Client Edition):

setup.exe /a /s /l1036 /v"EXTRACTFILES=c:\temp\MSIfiles"

ADVERTISE=Cardiology,Emerg
ency,Gastroenterology, 
GeneralPractice,MentalHealth,
Neurology,ObGyn, 
Oncology,Orthopaedic,Patholo
gy,Pediatrics,General,Teens 

Installs the specified vocabularies as on-demand 
only—When a user tries to open one of the 
vocabularies, only then is it installed.

The best method for specifying a custom installation 
is to set the ADDLOCAL=ALL and then specify the 
ADVERTISE property to those features that you don’t 
want installed locally. 

Non-vocabulary items such as samples and TTS in an 
ADVERTISE property are not installed on-demand. If 
such features are needed at a later point, modify the 
installation running the MSI again.

/Liwmo!e c:\\Setup.log /L specifies the location of an installation logfile and 
specifies the nature of the information to be logged:i 
— Status messages. 
w — Nonfatal warnings. 
m — Out-of-memory or fatal exit information. 
o — Out-of-disk-space messages. 
! — Flush each line to the log. 
e — All error messages.

c:\\Setup.log - writes out the log file to 
c:\setup.log

Option or Property Description
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Next, you specify the extracted .MSI and .MST files in a command line to install Dragon 
SDK Client Edition. The next two examples show how these files are used for running 
setup.exe and msiexec.exe.

Running setup.exe to install Dragon

Caution: Before you run this command line, be sure you have installed Visual 
C++ Runtime for Dragon (see Caution near the top of this topic).

The following sample command line installs Visual C++ Runtime for Dragon from the 
DVD. You must install this program before you run setup.exe to install Dragon: 

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-
ADE12FB7DEC5}\vcruntime.exe

The InstallShield wizard pops up and steps you through the installation of the program.

The following sample command line launches Setup in French and installs Dragon SDK 
Client Edition into the c:\DSC10 directory:

setup /a /s /v"INSTALLDIR=c:\DSC10" TRANSFORMS=1036.MST

Running msiexec.exe to install SDK Client Edition

Caution: Before you run this command line, be sure you have installed Visual 
C++ Runtime for Dragon (see Caution near the top of this topic). 

The following sample command line installs Visual C++ Runtime for Dragon from the 
DVD. You must install this program before you run msiexec.exe to install Dragon:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-
ADE12FB7DEC5}\vcruntime.exe

The InstallShield wizard pops up and steps you through the installation of the program.

The following example demonstrates how you use the .msi file that was extracted in 
the previous example by running setup.exe. To install the SDK Client Edition in 
German, you would use this command line:

msiexec /i "c:\Dragon NaturallySpeaking 10.MSI" /l*v /q 
TRANSFORMS=1031.MST

The /q option runs the installation in Silent mode. 

For more information on using the Microsoft Windows Installer, see http://
msdn2.microsoft.com/en-us/library/Aa372866.

Enabling Roaming Users in an msiexec.exe installation

This section described how to enable Roaming Users in an msiexec.exe installation. 
For more information on msiexec.exe options specific to all editions of Dragon 
NaturallySpeaking or Dragon Medical, see Setting msiexec.exe options specific to 
Dragon.

Step 1: Setting ROAMINGUSEROPTIONS options 

You use the ROAMINGUSEROPTIONS option to name a file that contains Roaming User 
settings to be merged into nssystem.ini at installation time. 

http://msdn2.microsoft.com/en-us/library/Aa372866
http://msdn2.microsoft.com/en-us/library/Aa372866
http://msdn2.microsoft.com/en-us/library/Aa372866
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 These are the same options you can set from the Roaming tab of the Administrative 
Settings dialog box.

You can either create a text file to set these options as specified in Setting Roaming 
user options or you can copy these options from an installation of Dragon using the 
following procedure:

1. Install Dragon on a machine with Windows Administrator privileges.

2. Enable the Roaming User feature and set all the Roaming User options on the 
Roaming tab of the Administrative Settings dialog box as required in your 
environment. (Note: The Roaming User location is written in a separate file called 
roaming.ini, an unencrypted file that is supplied for the ROAMINGUSERINI 
parameter, described below).

3. Test these settings to make sure the Roaming User connection works.

4. Open nssystem.ini. By default, nssystem.ini is located in: 
 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\

5. The Roaming User options in nssytem.ini are listed in the [Settings] section and 
have the format Roaming User <option>.

6. Copy the Roaming User options to a separate file and give that file a unique name.

7. Use this file as the input for the ROAMINGUSEROPTIONS option. 

Notes:

• Long path names need to have any quoted strings "escaped" (each quotation marked 
preceded by a slash, \").

• This file must have a unique name and cannot be named roaming.ini. 

• This file must be a text file. Any settings you want to merge must also have the 
section notated as well as the value and data. If only values and data are set in this 
file (without the section name encased in brackets), the settings will not be merged.

• This file does not specify the Master Roaming User location. The Master Roaming User 
location is specified by the ROAMINGUSERINI option.

For a list of options, see Setting Roaming user options.

Step 2: Setting ROAMINGUSERINI options 

You use the ROAMINGUSERINI option to specify a roaming user ini file (roaming.ini) 
to specify the Master Roaming User location and any associated HTTP or HTTPS settings 
for a roaming user. These are the same options set from the Network Directories field 
of the Roaming tab of the Administrative Settings dialog box and the HTTP and 
HTTPS Settings dialog boxes.

When you enable Roaming User, Dragon creates an encrypted roaming.ini file. Use 
the following steps to create a roaming.ini file to be used for an MSI installation where 
Roaming User feature is enabled:

1. Install Dragon on a machine with Windows Administrator privileges.

2. Enable the Roaming User feature and set all the Roaming User options required in 
your environment. These must include the Master Roaming User location set in the 
Network Directories field in the Roaming tab of the Administrative Settings 
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dialog box and any HTTP or HTTPS settings. 

3. Test these settings to make sure the Roaming User connection works.

4. Save your settings by closing Dragon.

5. Copy the encrypted roaming.ini file created by this installation of Dragon to a 
separate location. By default, the roaming.ini is located in: 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\

6. Use the copied roaming.ini as the input for the ROAMINGUSERINI option.

 The default is empty (no .ini file will be used).

To set these options using ROAMINGUSERINI, the Roaming User feature must be 
enabled in the ROAMINGUSEROPTIONS option. For more information, see Setting 
Roaming user options.

Installing the Citrix Client Update for an MSI installation

Dragon includes support for deploying and running Dragon in a Citrix environment.

If you intend to dictate from the Citrix client, before you run Dragon for the first time 
from that client, you must run the Citrix Client Update.

Dragon includes a native Windows Installer (MSI) that lets you install the Citrix Client 
Update during an MSI installation.

The compiled Citrix Client Update.MSI file (vddnspatch.msi) is located on your 
installation CD.

Note: There are no options for vddnspatch.msi.

Creating a custom installation using the Microsoft Custom Install 
Wizard

You can install Dragon runtime in a network environment, in other words, push the 
software application out to client computers without having to install it separately on 
each client system. 

Dragon includes a native Windows Installer (MSI) that lets you both install across a 
network to multiple client machines and customize your installations. Several servers 
support this type of network installation:

• Microsoft Windows 2000 Advanced Server

• Windows Server 2003

• System Management Server (SMS)

The installation administrator creates an image of the installation program on the 
server and then configures the server to automatically push the application onto the 
client systems. You can also configure network installations to modify, repair, or 
remove an existing installation.
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Support for SMS and Windows 2000/2003 Server with Active 
Directory

Systems Management Server (SMS) provides a mechanism for pushing application 
installations out from the server to client systems. SMS supports using the Windows 
Installer (MSI) to push client installations on clients using all versions of Windows, from 
Windows 95 to Windows Vista. SMS requires that a client application be installed on all 
client machines.

For information about Windows Installer technology, see the Microsoft document 
Scenarios and Procedures for SMS 2003: Planning and Deployment available at http:/
/www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-
9BC180713F7E&displaylang=en.

Active Directory Services is a feature of Windows 2000 Advanced Server and Windows 
Server 2003. The Group Policy component of Active Directory Services includes a 
Software Installation snap-in that enables an administrator to create a network 
installation. The administrator can use this feature to install software to Windows 2000, 
Windows XP, and Windows Vista clients.

Dragon supports the Active Directory Services Assign to Computers installation 
option. This option successfully installs the software when the computer is rebooted. 
You (as administrator) can delay installation on Windows XP or Vista clients by enabling 
logon optimization for group policy; for this type of installation, an entry for the 
installation can be viewed in the event log after the first reboot. The installation is then 
performed on the second reboot. The installation takes place silently, and the software 
is installed for all users on the computer.

Creating a Custom Installation

You can create a custom installation using a set of tools available from Microsoft.

First, you download and install the tools—Installing the Microsoft Custom Installation 
Wizard 

Then you run the wizard—Modifying setup properties using the Custom Installation 
Wizard

You are then ready to use the custom installer to install the product.

Installing the Microsoft Custom Installation Wizard 

The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit 
Tools. To install the Custom Installation Wizard: 

1. Download the Office Resource Kit Tools (OrkTools.exe) from: http://
www.microsoft.com/office/orkarchive/xpddl.htm 
 
OrkTools.exe is a self-extracting executable (EXE) file that installs the core Office 
XP Resource Kit tools on your computer through a single Setup program. 

2. After downloading OrkTools.exe, double-click it to start the installation. 

To locate the tool after installation, click the Start > Programs > Microsoft Office 
Tools > Microsoft Office XP Resource Kit Tools.

After you install the tool, you use its Custom Installation Wizard to create your 
custom installation.For details on using the wizard, proceed to Modifying setup 
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properties for a Custom Installation.See "Modifying setup properties for a Custom 
Installation" on page 

Modifying setup properties for a Custom Installation

The following explains how to modify setup properties for a custom installation of 
Dragon NaturallySpeaking or Dragon Medical. This example shows how to add the 
SERIALNUMBER property and specify its value. This example shows only one of the MSI 
options you can set for installing Dragon.

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs > 
Microsoft Office Tools > Microsoft Office XP Resource Kit Tools, and then click 
Custom Installation Wizard. 
 
This displays the Custom Installation Wizard screen: 
 

2. Click Next. 

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you 
want to use to create a custom installation. The compiled .MSI file is located on your 
installation CD. The files are named:

• Dragon NaturallySpeaking or Dragon Medical: Dragon NaturallySpeaking 
10.msi

• Dragon SDK Client Edition (DSC): Dragon SDK Client Edition10.msi

• Dragon SDK Server Edition (DSS): Dragon SDK Server Edition10.msa

The following example uses Dragon SDK Client Edition 10.msi.  
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5. Click Next. 

6. Click Yes when you see the following message: 
 

7. On the Open the MST File page of the wizard, select Create a new MST file, as 
shown below: 
 

8. Click Next to continue. 

9. On the Select MST File to Save page of the wizard, select a file name and path for 
the MST file you are creating, as shown in the figure below: 
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10.Click Next. 

11.On the Specify a Default Path and Organization page, select the default path for 
the installation. By default, the SDK installs in \Program Files\Nuance\Dragon SDK 
Client Edition10. 
 

12.Click Next. 

13.On the Remove Previous Versions page, keep the default selections and click 
Next. This page applies only to Microsoft Office and does not affect the Dragon 
installation. 

14.Click Next to keep all the defaults when you come to the Set Features Installation 
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States page, where you select particular components to install: 
 

15.On the next several pages of the wizard, click Next on each, and proceed until you 
reach the Modify Setup Properties page. All the pages in between apply only to 
Microsoft Office or do not affect the Dragon SDK Client Edition installation.

• Customize Default Application Settings page

• Change Office User Settings page

• Add/Remove Files page

• Add/Remove Registry Entries page

• Add, Modify, or Remove Shortcuts page

• Identify Additional Servers page

• Specify Office Security Settings page

• Add Installations and Run Programs page

16.Use the Modify Setup Properties page, shown below, to add, modify, and set the 
MSI options of your custom installation.  
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17.Click the Add... button to display the Add/Modify Property Value dialog box, 
where you modify the MSI installation options. In this example, we add and set the 
SERIALNUMBER option. 

18.In the following Add/Modify Property Value page, enter the new property name 
SERIALNUMBER and a valid serial number, then click OK: 
 

19.Note that the Modify Setup Properties page re-displays with the updated 
information. For example: 
 

20.Continue adding or modifying other MSI options that apply for your environment. 
Once you are done, click Next. 

21.On the Save Changes page, click Finish. 

22.When the Custom Installation Wizard page appears, click Exit. This screen 
displays the location of Windows Installer transform (.MST file) that you created. 
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After you save changes, you can use the resulting .MST file to manage an installation 
through a Group Policy in Active Directory Services. 

You are now ready to use the custom installer you created to install the product.
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Installing Dragon from the command line interface

You can use command line options to modify the way that Dragon NaturallySpeaking 
or Dragon Medical starts up. These switches are used in the following syntax:

natspeak /switch

where /switch is one or more switches from the following table:

/diagnose Runs Dragon in diagnostic mode. Outputs 
information into the Dragon.log file and 
exits.

/user <user> Automatically loads the user named by 
<user>.

/topic <topic> Automatically loads the topic named by 
<topic> (Professional edition only).

/quick Runs Dragon in quick mode. QuickStart 
mode starts Dragon without loading a user or 
any speech models when you start your 
computer. Only the Dragon tray icon is 
visible. When you click on the Dragon 
desktop icon, the Open User dialog box 
immediately appears. When you exit Dragon 
the program returns to the QuickStart 
mode and remains in memory with a reduced 
footprint (approximately 10 MB). 

/SetDefaultOptions Displays the Options dialog box at the end 
of the installation. The Options dialog box 
lets you change Dragon’s standard behavior, 
including specifying hot keys, customizing 
how text is formatted, specifying initial 
microphone settings, and setting the how 
often your user files are backed up. 

/SetDefaultAdministrativeOptions Displays the Administrative settings 
dialog box at the end of the installation. The 
Administrative settings dialog box lets 
you set up the Roaming User feature, set the 
backup location of your user files, and 
restrict users from modifying commands and 
vocabularies. 

/SetDefaultFormattingOptions Displays the Formatting dialog box at the 
end of the installation. The Formatting 
dialog box lets you set default ways that 
Dragon should automatically format the 
results of your dictation, such as by 
automatically inserting commas and periods 
or by capitalizing certain words in particular 
ways.

Switch Function
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Post Installation Tasks

Once you have installed or upgraded Dragon, you might want to carry out some of 
these tasks before you proceed:

• Cleaning up after uninstalling Dragon

• Viewing the Version 10 File Structure

• Turning off Dragon’s use of Microsoft Active Accessibility Service

• Choosing Medical Vocabulary to Support Your Specialty (Dragon Medical only)

Cleaning up after uninstalling Dragon

The following files remain on your machine after you uninstall Dragon 
NaturallySpeaking or Dragon Medical:

• C:\Windows\Speech

• VText.dll 

• Vdict.dll 

• WrapSAPI.dll 

• XTel.Dll 

• Xcommand.dll 

• Xlisten.dll 

• Xvoice.dll 

• spchtel.dll 

• speech.cnt 

• speech.dll 

• speech.hlp 

• vcauto.tlb 

• vcmd.exe 

• vcmshl.dll 

• vtxtauto.tlb

Dragon installed these files for Microsoft SAPI4 support. If you do not have other 
speech applications that require SAPI4, you can safely remove these files manually. If 
have installed other speech applications that require SAPI4 support, you may need to 
re-install those applications if you remove the files.

Version 10 File Structure

Upgrading from Dragon NaturallySpeaking version 8.x or 9.x to version 10 will 
automatically relocate some Dragon NaturallySpeaking directories and files.

Note: The following directory structures and file locations assume an installation to a 
default location. 
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V8 Windows 2000/XP Pro/XP Home directory structure

The V8 directory structure before upgrading to V10:

C:\Program Files\ScanSoft\NaturallySpeaking 
 \Help 
 \Program 
 \Tutorial (optional) 
C:\Documents and Settings\All Users\Application 
Data\ScanSoft\NaturallySpeaking\ 
 \Custom  
 \Data 
 \Data\Training 
 \Users 
C:\Documents and Settings\<username>\Application 
Data\ScanSoft\NaturallySpeaking\ 
 \Results

V9.0/V9.1 Windows 2000/XP Pro/XP Home/Windows Server 2003 
directory structure

The V9.0/V9.1 directory structure before upgrading to V10:

C:\Program Files\Nuance\NaturallySpeaking9 
 \Help 
 \Program 
 \Tutorial (optional) 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking9\ 
 \Custom  
 \Data 
 \Data\Training 
 \Users 
C:\Documents and Settings\<username>\Application 
Data\Nuance\NaturallySpeaking9\ 
 \Results

V9.5 Windows 2000/XP Pro/XP Home/Windows Server 2003 directory 
structure

The V9.5 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 
Advanced Server/Windows Server 2003 before upgrading to V10:

C:\Program Files\Nuance\NaturallySpeaking9 
 \Ereg 
 \Help 
 \Program 
 \Tutorial (optional) 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking9\ 
 \Custom  
 \Data 
 \Data\Training 
 \Users 
C:\Documents and Settings\<username>\Application 
Data\Nuance\NaturallySpeaking9\ 
 \Results
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V9.5 Windows Vista directory structure

The V9.5 directory structure on Windows Vista before upgrading to V10:

C:\Program Files\Nuance\NaturallySpeaking9 
 \Ereg 
 \Help 
 \Program 
 \Tutorial (optional) 
C:\ProgramData\Nuance\NaturallySpeaking9\ 
 \Custom 
 \Data 
 \Data\Training 
 \Users 
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking9\ 
 \Results

V10 Windows 2000/XP Pro/XP Home/Windows Server 2003 directory 
structure

The directory structure after installing V10 on Windows 2000/XP Pro/XP Home/
Windows 2000 Advanced Server/Windows Server 2003:

C:\Program Files\Nuance\NaturallySpeaking10 
 \Ereg 
 \Help 
 \Program 
 \Tutorial (optional) 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\ 
 \Custom  
 \Data 
 \Data\Training 
 \Users 
C:\Documents and Settings\<username>\Application 
Data\Nuance\NaturallySpeaking10\ 
 \Results

V10 Windows Vista directory structure

The directory structure after installing V10 on Windows Vista:

C:\Program Files\Nuance\NaturallySpeaking10 
 \Ereg 
 \Help 
 \Program 
 \Tutorial (optional) 
C:\ProgramData\Nuance\NaturallySpeaking10\ 
 \Custom 
 \Data 
 \Data\Training 
 \Users 
C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking10
\ 
 \Results
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Turning off Dragon’s use of Microsoft Active Accessibility Service

Dragon NaturallySpeaking and Dragon Medical use Microsoft Active Accessibility 
Service to let you control certain menus and dialog boxes by voice. Without Microsoft 
Active Accessibility Service, you would be unable to use Dragon to select menu 
commands and dialog box controls with your voice.

If you don’t need to control the menus and dialog boxes by voice, you can speed up 
Dragon performance by turning off Microsoft Active Accessibility Services. 

To turn off Active Accessibility Services in Dragon for all applications

1. Open the Options dialog box by selecting Tools > Options on the DragonBar.

2. Click the Miscellaneous tab.

3. Clear the Use Active Accessibility for menu and dialog control box if it is 
selected.

4. Click OK. You will need to exit and re-start Dragon for this change to take effect.

To turn off Active Accessibility in Dragon for specific applications

1. Exit Dragon.

2. Open nssystem.ini in a text editor. By default, nssystem.ini is located in 
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking10

3. Under [MSAA Modules Disabled], add a line similar to the following for each 
application where you want to disable the use of Active Accessibility Services: 
<executable_name>=1

4. Save and close nssystem.ini.

5. Re-start Dragon.

For example, to disable Dragon use of Active Accessibility Services in Microsoft Word 
and Microsoft Excel, you would add the following lines to nssystem.ini:

[MSAA Modules Disabled] 
winword.exe=1 
excel.exe=1

Note: If you do not know the name of an application’s executable file, you can start 
the application from the Windows Start menu and then use the Windows Task Manager 
to view the list of current Windows applications. The executable names are listed under 
Image Name on the Processes tab. You can also right-click the application’s icon and 
select the shortcut tab—the Target field will provide the name of the executable. 

Modifying Sample Commands 

While you are running Dragon, you can ask it "What can I say?" and it responds by 
popping up a display of available commands you can speak in the application where the 
cursor is currently focused. The commands appear in the Sample Commands window, 
which displays global commands for Dragon if you do not have the cursor focused in a 
particular application.

If, for example, you have Excel open and the cursor in it, a list of Excel commands pops 
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up.

You can modify the commands that display in the Sample Commands window for an 
existing application or add a list of commands for a new application by modifying the 
nsapps.ini file.

Modifying Sample Commands for Existing Application

1. Create a .chm, .htm, or .html (Help) file that contains the information you want to 
display. That information can be global commands usable in any application or 
commands specific to a particular application. If you provide a .chm file, you must 
also indicate which .htm subfile in that .chm you want to display. If you provide an 
.htm or .html file only, you do not have to indicate a subfile.

2. In the custom directory under C:\Documents and Settings\All 
Users\Application Data\Nuance\NaturallySpeaking10\custom create a 
subdirectory named samplecommands.

3. Under samplecommands, create a directory named for the language you are using, 
such as enx for English or fra for French.

4. Place the Help file in the language directory under custom/samplecommands.

5. Find the nsapps.ini file in C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10.

6. Open the nsapps.ini file in Notepad or another text editor.

7. Notice that the file contains sections with headings inside square brackets, starting 
with [.Global]. For each application, you see such an entry. Under each heading is 
the information about that program. Among the may programs you can provide 
alternative command help for are the programs under the sections indicated below 
(this is not a complete list):

• Acrobat Reader under [ACROREAD]

• Visual Application Builder under [APPBLDR]

• Lotus Approach under [APPROACH]

• Windows Calculator under [CALC]

• Windows Control Panel under [CONTROL]

• Corel Draw under [CRELDRW]

• Windows Defragmenter under [DEFRAG]

• Microsoft Excel [EXCEL]

• Windows Explorer [EXPLORER] 

• Internet Explorer [IEXPLORE]

• Dragon NaturallySpeaking or Dragon Medical [NATSPEAK]

• Notepad [NOTEPAD]

• Microsoft Outlook [OUTLOOK]

• Paintbrush [PBRUSH]

• Microsoft PowerPoint [POWERPNT]

8. To change the Help that pops up for any particular program, go to its section in 
square brackets and find your language listed in the section. Here are the languages:
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• enx = English

• fra = French

• ita = Italian

• deu = German

• esp = Spanish

• nld = Dutch

• jpn = Japanese

9. Enter a line under the section heading that indicates the alternative help file name. 
The line should be in this format: 
 
___<language> Custom Sample Commands File= <filename>.chm 
___<language> Custom Sample Commands Subfile= <full path and filename>.htm 
  
or for an .htm or .html file without a .chm file, enter only the first line, because you 
don’t need a subfile: 
 
___<language> Custom Sample Commands File= <filename>.htm 
 
For example, here are the lines required to have an English .chm file and indicate 
which of its .htm files to display (notice the ../ in front of the htm file name—it might 
be required in the correct path):  
 
___enx Custom Sample Commands File=altCmdsHelp.chm 
___enx Custom Sample Commands Subfile=../editingCmds.htm 
For example, here is the line required to have only an .htm file:  
 
___enx Custom Sample Commands File=editingCmds.htm

10.Save the nsapps.ini file.

11.If it is not already running, run Dragon and try dictating "What Can I Say?" You 
should see the new Sample Commands Help display. The entries for Custom 
Sample Command File and Subfile override the Help that would otherwise display.

Adding Sample Commands Help for New Application

1. To add sample commands help for a new application:

2. Add a section for the program to this nsapps.ini file. To create the section heading, 
place the executable file’s root name in square brackets. For excel.exe, for example, 
you can have a section named [EXCEL]. You can also include the version number if 
you have more than one version; for example, [EXCEL10].

3. Go to step 7 in the preceding section (Modifying Sample Commands 
for Existing ApplicationModifying Sample Commands for Existing Application)and 
complete steps 8 through 11.

Choosing Medical Vocabulary to Support Your Specialty

If you are using Dragon Medical, you should know which medical vocabulary supports 
your specialty, so that you can readily select the correct vocabulary from the list 
provided.
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The following table correlates Medical specialties with US English and UK English 
Dragon Medical vocabularies.

Note: The Physical Medicine and Rehabilitation and the Speech and Language 
Pathology vocabularies not available in UK English are marked with an asterisk (*).

US and UK English Dragon Medical Specialties and the Vocabularies That 
Support Them

Note: Specialities and Medical Vocabularies marked with a (1) are not available in the 
Dragon Medical Small Practice Edition.

Note: The Physical Medicine and Rehabilitation and the Speech and Language 
Pathology vocabularies not available in UK English are marked with a (2).

Specialty Medical Vocabulary to Choose

Addiction Psychiatry Addiction Psychiatry

Adolescent Medicine Family Medicine, Internal Medicine, or 
Pediatrics

Allergy and Immunology Allergy and Immunology

Anesthesiology Anesthesiology

Bariatric Surgery Surgery

Behavioral Health Psychiatry

Blood Banking/Transfusion Medicine Pathology 1

Breast Surgery Surgery

Cardiac Surgery Cardiac Surgery

Cardiology Cardiology 

Cardiothoracic Surgery Surgery

Cardiovascular Disease Internal Medicine

Chemical Pathology Pathology 1

Child and Adolescent Psychiatry Psychiatry

Child Abuse Pediatrics Pediatrics

Clinical Cardiac Electrophysiology Cardiology

Critical Care Medicine Anesthesiology or Internal Medicine

Dentistry Dentistry

Dermatology Dermatology

Dermatopathology Pathology 1

Developmental-Behavioral Pediatrics Pediatrics

Diagnostic Radiology Radiology 1

ENT ENT

Ear, Nose, and Throat ENT

EEG Psychiatry

Emergency Medicine Emergency Medicine

EMG Examinations Neurology
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Endocrinology Endocrinology Diabetes and Metabolism

Epidemiology Epidemiology

Family Medicine Family Medicine

Fetal Medicine Fetal Medicine

Forensic Pathology Pathology 1

Forensic Psychiatry Psychiatry

Gastroenterology Gastroenterology

General Medicine General Medicine

Geriatric Medicine Geriatric Medicine or Family Medicine

Geriatric Psychiatry Psychiatry

Hand Surgery Hand Surgery or Plastic Surgery

Hematology Hematology

Hospice and Palliative Medicine Pain Medicine, Emergency Medicine, Family 
Medicine, Internal Medicine, Pediatrics, or 
Physical Medicine and Rehabilitation 2

Infectious Disease Infectious Disease

Internal Medicine Internal Medicine

Interventional Cardiology Internal Medicine

Medical Education and Writing Medical Education and Writing

Medical Microbiology Pathology 1

Medical Oncology Internal Medicine

Medical Toxicology Emergency Medicine, Pediatrics

Mental Health Addiction Psychiatry, Endocrinology Diabetes 
and Metabolism, Psychiatry, or Psychology

Midwifery Midwifery

Neonatal and Perinatal Medicine Neonatal and Perinatal Medicine

Nephrology Nephrology

Neurodevelopmental Disabilities Pediatrics

Neurology Neurology

Neuromuscular Medicine Physical Medicine and Rehabilitation 2

Neuropathology Pathology 1

Neuropsychology Psychiatry, Neurology

Neurosurgery Neurosurgery

Neurotology ENT

Nuclear Medicine Nuclear Medicine

Nuclear Radiology Radiology 1

Nursing Nursing

Obstetrics and Gynecology Obstetrics and Gynecology

Specialty Medical Vocabulary to Choose
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Oncology Oncology

Ophthalmology Ophthalmology

Oral and Facial Surgery Oral and Facial Surgery

Orthopaedic Surgery Orthopaedic Surgery

Osteopathy Osteopathy

Otolaryngology ENT

Pain Medicine Pain Medicine

Pathology Pathology 1

Pediatric Cardiology Pediatric Cardiology

Pediatric Critical Care Medicine Pediatrics

Pediatric Dentistry Pediatric Dentistry

Pediatric Dermatology Dermatology

Pediatric Emergency Medicine Emergency Medicine or Pediatrics

Pediatric Endocrinology Pediatrics

Pediatric ENT Pediatrics

Pediatric Gastroenterology Pediatric Gastroenterology

Pediatric Hematology-Oncology Pediatrics

Pediatric Infectious Diseases Pediatrics

Pediatric Nephrology Pediatrics

Pediatric Otolaryngology ENT

Pediatric Pathology Pathology 1

Pediatric Pulmonology Pediatrics

Pediatric Rehabilitation Medicine Physical Medicine and Rehabilitation 2

Pediatric Rheumatology Pediatrics

Pediatric Surgery Surgery

Pediatric Transplant Hepatology Pediatrics

Pediatric Urology Urology

Pediatrics Pediatrics

Physical Medicine and Rehabilitation Physical Medicine and Rehabilitation 2

Plastic Surgery Plastic Surgery

Plastic Surgery within Head and Neck ENT

Podiatry Podiatry

Proctology Colon and Rectal Surgery

Psychiatry Psychiatry or Addiction Psychiatry

Psychology Psychology

Pulmonary Disease Pulmonary Disease

Radiation Oncology Radiology 1

Radiation Therapy Radiation Therapy

Specialty Medical Vocabulary to Choose
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Radiologic Physics Radiology 1

Radiology Radiology 1 or Nuclear Medicine

Rheumatology Rheumatology

Sleep Lab Sleep Lab

Sleep Medicine Family Medicine or ENT

Speech and Language Pathology Speech and Language Pathology 1, 2

Spinal Cord Injury Medicine Physical Medicine and Rehabilitation 2

Sports Medicine Emergency Medicine, Family Medicine, or 
Physical Medicine and Rehabilitation

Surgery Surgery

Thoracic Surgery Thoracic Surgery

Transplant Hepatology Internal Medicine

Trauma Surgery Surgery

Undersea and Hyperbaric Medicine Emergency Medicine

Urology Urology

Vascular Surgery Vascular Surgery

Vascular and Interventional Radiology Vascular and Interventional Radiology 1

Specialty Medical Vocabulary to Choose



 
 
 
 
 
 
 
 
 
 
Chapter 2 
 

Upgrading Dragon® with the 
Wizard or MSI Installer 
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Upgrading Dragon NaturallySpeaking or Dragon 
Medical

You take the following steps to upgrade from Version 8.x or 9.x to Version 10 of 
Dragon:

• Prepare to upgrade:

• Based on the version you are upgrading from (8.x or 9.x), determine how you will 
proceed (see What you should know before upgrading from a previous version)

• If you are upgrading to Windows Vista, see Installing on or Upgrading to Windows 
Vista

• Carry out one of these procedures:

• Upgrade multiple users (see Upgrading multiple users)

• Upgrade roaming users (see Upgrading roaming user files)

• Upgrade users with custom or customized vocabularies (see Upgrading Users with 
Custom and Customized Vocabularies)

You can work with the User Upgrade Wizard (see Upgrading multiple users)

What you should know before upgrading from a previous version

You can upgrade to Version 10 from Dragon NaturallySpeaking or Dragon Medical 
Versions 8.x or 9.x. You upgrade to Version 10 by following the installation instructions 
for Version 10, but you should first be sure to:

• Uninstall the previous version, when it is required for the version you are upgrading 
from.

• Retain your existing user files, to be updated after the installation completes.

• Check that it is possible to upgrade from your existing edition to the edition you are 
installing.

Upgrading from Versions 8.x

During an upgrade, the Version 10 upgrade procedure asks you to:

• Remove the previous Dragon installation. If you choose not to remove the previous 
installation, you cannot continue to upgrade. Removing Version 8.x will not remove 
your Version 8.x speech files and vocabularies.

• Migrate your existing user files and vocabularies to Version 10. If you choose not to 
upgrade your user files and vocabularies during the upgrade, you can do so at a later 
time by running the Version 10 Upgrade Users Tool. 

Once Version 10 is installed, your previous version will no longer be functional.

Note: The user profiles from previous versions remain untouched in case you 
decide to later reinstall the previous version.
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Upgrading from Version 9.x

The Version 10 installation will install in the Version 9.x directories and overwrite the 
files in those directories.

Edition considerations

You must upgrade to the same edition or higher and to the same language. 

For example, if you started with Version 9.1 German/English and you upgrade to 
Version 10 English only, your Version 9.1 German users will not be upgraded. 
Upgrading to Version 10 German/English will upgrade both your German and English 
users. After upgrading, you can install other Version 10 languages.

Installing on or Upgrading to Windows Vista

Dragon NaturallySpeaking and Dragon Medical Versions 9.5 and higher are compatible 
with all editions of Windows Vista.

Earlier version of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista.

Upgrade considerations

If you upgrade a machine from a previous version of Windows to Windows Vista and 
that machine has Version 8.x, 9.0, or 9.1 of Dragon installed, that version of Dragon 
will not work after upgrading to Windows Vista. 

All your user profiles from these previous versions remain intact and can be upgraded 
when you install Dragon Version 9.5 or Version 10.

Roaming Users in an MSI Installation on Vista

For more on carrying out an MSI installation on Windows Vista, see Enabling Roaming 
Users in an msiexec.exe installation.

Upgrading multiple users

If you choose not to upgrade your user files and vocabularies during the upgrade, you 
can do so at a later time by running the Version 10 Upgrade User Tool by selecting 
Start > Programs > Dragon NaturallySpeaking 10 > Dragon 
NaturallySpeaking Tools > Upgrade Users. 

The User Upgrade Wizard opens.

The User Upgrade Wizard guides you through the process of upgrading user files 
created in Dragon Versions 8.x and 9.x. The wizard cannot upgrade user files created 
by versions of Dragon prior to Version 8. 

User Upgrade Wizard: Select Users to Upgrade page

On the Select Users to Upgrade page, you see these elements:

User files to upgrade

Lists the location and name of all the users that the wizard will upgrade. Modify the list 
of users to include all users that you want to upgrade. The wizard starts by including 
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all the users in the current folder as candidates to upgrade. You add users to the list by 
clicking the Add button and browsing for additional users in other locations. You 
remove users from the list by selecting them and clicking the Remove button. Once 
you have adjusted the list of user files to show only the ones you want to upgrade, click 
Next. 

Note: If you have roaming users in your network, see Upgrading roaming user 
files: Overview 

Old Location

The current location of the user files is called Old Location on this page of the wizard.

User name

This column lists the users to upgrade by name.

Number of users to upgrade

Displays the total number of users the wizard will upgrade.

Add button

Opens a Browse for Folder window that you can browse in to locate additional users 
for the wizard to upgrade.

Remove button

Deletes a selected user from the User Upgrade wizard.

Once you have made a selection, click Next.

User Upgrade Wizard: Choose Destination page

At the same time that the User Upgrade Wizard modifies your user files to work with 
Dragon Version 10, it can move a copy of the upgraded user to another location while 
keeping the old files untouched. This allows you to return to the old user files in case 
you need them again, and it makes the files compatible with operating systems, like 
Windows XP, that store all user data in the Documents and Settings folder. 

Destination for upgraded user files

Click the Browse button or select a new destination from the list if you want to choose 
a destination other than the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can 
alter the way that the wizard upgrades the user.

User Upgrade Wizard: Advanced Options dialog box

The Advanced Options dialog box lets you make finer adjustments to how the wizard 
upgrades the user. This page contains the following information and allows you to make 
the following changes:

Users to upgrade

This list box contains the following information about each user at the current location:
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User

Name of the user.

Old Location

Location of the current (not yet upgraded) user files.

Vocabulary

The original vocabulary of the user.

Acoustic Model

The audio input device and associated language/voice model assigned to the 
user.

New Location

When you click on the Location line in the Users to upgrade list box, this text box 
becomes available. Initially it displays the location that the wizard recommends or that 
you chose on the Choose Destination page.You can click Browse and choose a new 
location.

New Base Vocabulary

When you click on the Vocabulary line in the Users to upgrade list box, this text box 
becomes available. Initially it displays the current vocabulary of the user or the one that 
the User Upgrade Wizard will assign to the upgraded user if the old vocabulary is no 
longer supported by Dragon. If the current vocabulary is supported, the message 
<Unable to upgrade> appears.

You can select a new base vocabulary from the drop-down list if it contains other 
vocabularies.

New Acoustic Model

When you click on an Acoustic model line in the Users to upgrade list box, this text 
box becomes available. Initially, it displays the current language (such as US English), 
language model, and accent of the user. You can choose a new acoustic model from 
the drop-down list.

After you have modified the user information for each user in the list box, click OK to 
return to the wizard, and click Next to proceed.

User Upgrade Wizard: Upgrade Users page

On the Upgrade Users page, click Begin to start the upgrade process. Expect to wait 
approximately 5 minutes for each user being upgraded.

When the process is complete, click Finish.

If the Upgrade User wizard ran automatically in response to you starting the product 
after installing an upgrade, the Open User window opens and displays a list of users 
you can choose from to begin dictation.

Upgrading roaming user files: Overview 

This section describes how to upgrade Roaming User files from Dragon 
NaturallySpeaking or Dragon Medical Version 8.x or 9.x to Version 10.
81



82

Dragon®  Medical Installation and Administration Guide
 When you use the Roaming User feature, each Dragon user has a master roaming user 
file that can be opened from multiple networked computers where Dragon is installed. 
These master roaming user files are stored on a network location made accessible to 
your Dragon users. 

When a master roaming user file is opened from that central network location, Dragon 
transfers a copy of that user to the Local Roaming User file on the local computer. 

Since the Local Roaming user file is a copy of the user data taken from the master 
roaming user file, you cannot directly upgrade the Local Roaming User when you 
upgrade the local Dragon installation from Version 8.x or 9.x to Version 10.

Notes: 

• Upgrading a set of Version 8.x or 9.x master roaming user files to Version 10 leaves 
the Version 8.x or 9.x master roaming user files unchanged. Leaving the Version 8.x 
or 9.x files intact allows the users in your network to run Dragon Version 8.x or 9.x 
while you plan your upgrade.

• Plan to upgrade the master roaming user files at a time when they are not being 
opened by end users, for example during the night or on a weekend.

•  Even though the Dragon 10 User Upgrade Wizard supports both mapped drives and 
UNC paths, Nuance strongly recommends that you upgrade your Master Roaming 
User files on a drive on a machine where Dragon 10 is locally installed. Nuance does 
not recommend that you upgrade your Master Roaming user files across a network 
to either a mapped drive or UNC path; upgrading over a network will take a 
undetermined length of time. In addition, the User Upgrade Wizard does not support 
upgrading users over an HTTP connection.

Step 1: Preparing to upgrade roaming user files

To upgrade your Master Roaming user files from a previous version of Dragon, Nuance 
recommends that you install Dragon 10 directly on the network machine where the 
version 8.x or 9.x Master Roaming user files are located and upgrade those Master 
Roaming user files directly to Dragon 10 Master Roaming user files.

If you are unable to install Dragon where your version 8.x or 9.x Master Roaming user 
files are located, Nuance recommends that you:

• Install Dragon 10 on a separate machine where you will perform the upgrades.

• Copy the version 8.x or 9.x Master Roaming user files from their network location to 
the machine where Dragon 10 is installed.

• Upgrade the version 8.x or 9.x Master Roaming user files on the machine where 
Dragon 10 is installed.

• Copy the upgraded version 10 Master Roaming user files to a network accessible 
directory on the original network location.

For more information, see Preparing to upgrade roaming user files.

Step 2: Upgrading the user files 

 As administrator you must separately upgrade the master roaming user files to Version 
10 using the Version 10 User Upgrade Wizard. 

After you upgrade the version 8.x or 9.x Master Roaming user files, you can then 
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proceed to upgrade end-user systems that deploy the Roaming User feature.

For more information, see Upgrading master roaming user files 

Step 3: Upgrade the end-user systems

After you have upgraded the master roaming user files, you can then proceed to 
upgrade end-user systems that deploy the Roaming User feature.

For more information, see Upgrading end-user systems.

 Preparing to upgrade roaming user files

Step 1: Install Dragon 10 the machine where you will perform the upgrades of 
your version 8.x or 9.x Master Roaming user files

Nuance recommends that you install Dragon 10 on the machine where the version 8.x 
or 9.x Master Roaming user files are located. If that is not possible, Nuance 
recommends that you install Dragon 10 on a separate machine where you will perform 
the upgrades.

For more information on installing, see Installing on a single machine.

Notes: 

• If during the installation or upgrade you are prompted to Upgrade existing speech 
files to work with this installation, be sure to leave this option unchecked. You 
will be manually running the User Upgrade Wizard in a later step.

• If you are unable to install Dragon where your version 8.x or 9.x Master Roaming user 
files are located, see Upgrading roaming user files, Nuance recommends that you 
install Dragon 10 on a separate machine where you will perform the upgrades. For 
more information, see Upgrading roaming user files: Overview.

Step 2: On the version 8.x or 9.x end-user systems that use the Roaming User feature

On the end-user systems where the users dictate using the version 8.x or 9.x Roaming 
User feature, save and close any open user on each Dragon Version 8.x or 9.x system 
that uses the Roaming User feature.

Note: If there is no time when all of your roaming user files are unused (for example, 
if you are supporting a hospital where some physicians use Dragon during a night shift), 
you can upgrade different groups of roaming user files at different times.

Step 3: On the central network location that stores the version 8.x or 9.x Master Roaming 
User files:  

1. (Optional) Back up the master roaming user files to a separate location, either by 
using any system backup utility that is implemented at your facility or by using the 
Dragon The Manage Users dialog.

Note: You are not required to back up the roaming user files because when you 
upgrade, your Version 8.x or 9.x user files are retained in a directory separate from 
your Version 10 user files.

2. Create a new directory on the shared network drive that should store the upgraded 
Dragon 10 Master Roaming User files. Although you can store the upgraded Version 
10 users in the same location as the current users — this would make two versions 
of each user file visible to the end user and lead to confusion — Nuance recommend 
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that you create a location that differs from the location that stores the current user 
files.

Step 4: Copy the version 8.x or 9.x Master Roaming user files from the previous 
network location to the machine where Dragon 10 is installed.

If you installed Dragon 10 on the machine where the version 8.x or 9.x Master Roaming 
user files are located, then proceed to Step 5 below.

If you installed Dragon 10 on a machine other than where the version 8.x or 9.x Master 
Roaming user files are located, then do the following on the machine where Dragon 10 
is installed:

1. Create a directory on the local machine that will hold all the Master Roaming user files 
you plan to upgrade.

2. Copy the version 8.x or 9.x Master Roaming User files from the network location to 
the directory you just created.

Step 5: On the administrator system from where you will upgrade the version 8.x or 9.x 
Master Roaming User files to version 10:

1. Start Dragon Version 10 and make sure the Roaming User feature is turned off.  
 
To turn off the Roaming User feature:  

a. Close any open users.

b. Click Administrative Settings on the DragonBar Tools menu. This action 
displays the Administrative Settings dialog box.

c. On the Roaming tab, make sure Enable is not selected. 

2. Close Dragon.

3. Follow the instructions in the next section, Upgrading master roaming user files.

Upgrading master roaming user files

 As administrator you must separately upgrade the master roaming user files to Version 
10 using the Version 10 User Upgrade Wizard on the version 8.x or 9.x Master Roaming 
user files.

Before proceeding with this section, make sure you have followed the procedure 
described in Preparing to upgrade roaming user files.

After you have upgraded the version 8.x or 9.x Master Roaming user files and optionally 
copied them back to their network location, you can then proceed to upgrade your end-
user systems that use the Roaming User feature. For more information, see Upgrading 
end-user systems.

Step 1: Upgrade the version 8.x or 9.x Master Roaming user files using the User 
Upgrade Wizard

On the machine where both your version 8.x or 9.x Master Roaming files and Dragon 
10 are installed:

1. Select Start > Programs > Dragon NaturallySpeaking 10 > Dragon 
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NaturallySpeaking Tools > Upgrade Users.  
 
This opens the User Upgrade Wizard. For example: 
 

 
 
Note: If you did not turn off the Roaming User feature in the Administrative 
Settings dialog box before attempting to start the User Upgrade Wizard, you 
receive an error message stating that you cannot upgrade a Roaming User. If you 
receive the message, go back to the Administrative Settings dialog and be sure 
the Enabled check box is not checked.

2. On the Select Users to Upgrade page, click Add... to select the location of the 
version 8.x or 9.x Master Roaming user files. The the Select Users to Upgrade page 
now displays a list of users in the selected directory. For example: 
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You can continue to use the Add... button to add users from other local locations or 
use the Remove button to remove specific users. Click Next to continue.

3. On the Choose Destination page, in the Destination for upgraded user files text 
box, choose the local location you previously created that will contain the upgrade 
Version 10 master roaming user files. If you do not see the location you want, you 
can click the Browse button, find the correct location, and click Next. For example: 
 

4. The Upgrade Users page displays the number of users that the wizard is prepared 
to upgrade.

5. Click Begin to start the upgrade process. The upgrade process can take 2-3 minutes 
or more per user, depending on the speed of your system and your network. You can 
click Stop at any time to interrupt this process. 
 
The upgrade process creates new master roaming user files in the destination you 
selected.

6. Click Finish to complete the upgrading process and exit the User Upgrade Wizard.

Note: The User Upgrade Wizard renames each Version 10 master roaming user file 
as follows: <name> (v10).  
For example, a Version 9.x Master Roaming user file named roaminguser1 will be 
copied and named roaminguser1 (v10) when upgraded to Version 10. The Version 9.x 
Master Roaming user file named roaminguser1 remains unchanged.

Having the files renamed like this could cause some confusion for the users in your 
network who are dictating with Roaming User accounts. If, for example, you chose to 
locate your Version 8.x or 9.x and your upgraded Version 10 Roaming User files in the 
same network directory, the Open User dialog box would display both the old and the 
Version 10 master roaming user files.

Step 2: Clean up network locations of Version 8.x or 9.x master roaming user 
files (optional) 

When the User Upgrade Wizard modifies the Version 8.x or 9.x master roaming user 
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files to work with Dragon Version 10, it makes a copy of the upgraded user first, 
keeping the original Version 8.x or 9.x files unchanged. This allows you to return to the 
old user files in case you need them again.

As administrator, you can optionally rename or remove the Version 8.x or 9.x master 
roaming user files through the Manage Users dialog box. 

Step 3: Copy the upgraded version 10 Master Roaming user files back to their 
network location (Optional)

If you were unable to install Dragon where your version 8.x or 9.x Master Roaming user 
files were located and you copied your version 8.x or 9.x Master Roaming user files to 
a another machine where Dragon 10 was installed, you must now copy the upgraded 
version 10 Master Roaming user files back to the new network accessible directory that 
you created on their original network location.

You can skip this step if you installed Dragon 10 on the machine where the version 8.x 
or 9.x Master Roaming user files are located and upgraded those Master Roaming user 
files directly to Dragon 10 Master Roaming user files.

Step 4: Upgrade your end-user systems from Dragon V8 or V9 to Version 10

After you have upgraded the master roaming user files, you can then proceed to 
upgrade your end-user systems where users dictate deploying the Roaming User 
feature. For more information, see Upgrading end-user systems.

Upgrading end-user systems to Dragon 10

After you have upgraded the master roaming user files, you can then proceed to 
upgrade the end-user systems that use the Roaming User feature.

Before proceeding with this section, make sure you have followed the procedure 
described in Upgrading master roaming user files.

Step 1: Upgrade Version 8.x or 9.x systems where users will dictate with the 
Version 10 Roaming feature

Since the User Upgrade Wizard leaves your Version 8.x or 9.x master roaming user 
files unchanged and in their original network location, your Version 8.x or 9.x systems 
can continue to use the Roaming User feature until you upgrade those installations to 
Version 10.

To upgrade a Version 8.x or 9.x system where Roaming Users dictate to Version 10, 
follow the installation instructions under Installing Dragon on a single machine.

Notes:

• When prompted, choose to remove the Version 8.x or 9.x Dragon installation. If you 
choose not to remove the previous installation, you cannot continue to upgrade. 

Step 2: Enable Roaming User feature on upgraded end user systems and 
try opening a Roaming User

When you upgrade a Dragon to Version 10, the Roaming User feature is turned off by 
default.

To turn on the Roaming User feature on the upgrade machines:

1. Start Dragon.
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2. If a user opens, close it.

3. Click Administrative Settings on the DragonBar Tools menu. This displays the 
Administrative Settings dialog box. 

4. On the Roaming tab, select Enable. 

5. The Network Directories list will display the network location of the Version 8.x or 
9.x master roaming user files.  
 
If you created a new network directory for your Version 10 master roaming user files, 
you can either click the Add button to add the new network location or select a listed 
directory and then click Edit to change the path to the new location. When you have 
finished, click OK to close the Administrative Settings dialog box. You should also 
remove any unused Version 8.x or 9.x master roaming user directory to avoid 
confusion.

6. Select Dragon > Open Users on the DragonBar. This action displays the Open 
User dialog box. If you allow users to select both non-roaming local and Roaming 
Users, make sure they select the correct location (the Version 10 Roaming User 
location) from the Location of user files field. 

7. Select a user and click Open. 

Note: If the Roaming Users have not already been upgraded and stored in the new 
master roaming user directory, when you click Open, the User files need to be 
upgraded dialog box appears. Since you cannot upgrade roaming users locally, you 
should click Cancel here and return to Upgrading master roaming user files. If you click 
OK instead of Cancel, you receive a message stating You cannot upgrade a 
roaming user because you cannot upgrade Roaming Users on a workstation that has 
roaming enabled.

Upgrading multiple users

If you choose not to upgrade your user files and vocabularies during the upgrade, you 
can do so at a later time by running the Version 10 Upgrade User Tool by selecting 
Start > Programs > Dragon NaturallySpeaking 10 > Dragon 
NaturallySpeaking Tools > Upgrade Users. 

The User Upgrade Wizard opens.

The User Upgrade Wizard guides you through the process of upgrading user files 
created in Dragon Versions 8.x and 9.x. The wizard cannot upgrade user files created 
by versions of Dragon prior to Version 8. 

User Upgrade Wizard: Select Users to Upgrade page

On the Select Users to Upgrade page, you see these elements:

User files to upgrade

Lists the location and name of all the users that the wizard will upgrade. Modify the list 
of users to include all users that you want to upgrade. The wizard starts by including 
all the users in the current folder as candidates to upgrade. You add users to the list by 
clicking the Add button and browsing for additional users in other locations. You 
remove users from the list by selecting them and clicking the Remove button. Once 
you have adjusted the list of user files to show only the ones you want to upgrade, click 
Next. 



Upgrading Dragon® with the Wizard or MSI Installer
Note: If you have roaming users in your network, see Upgrading roaming user 
files: Overview 

Old Location

The current location of the user files is called Old Location on this page of the wizard.

User name

This column lists the users to upgrade by name.

Number of users to upgrade

Displays the total number of users the wizard will upgrade.

Add button

Opens a Browse for Folder window that you can browse in to locate additional users 
for the wizard to upgrade.

Remove button

Deletes a selected user from the User Upgrade wizard.

Once you have made a selection, click Next.

User Upgrade Wizard: Choose Destination page

At the same time that the User Upgrade Wizard modifies your user files to work with 
Dragon Version 10, it can move a copy of the upgraded user to another location while 
keeping the old files untouched. This allows you to return to the old user files in case 
you need them again, and it makes the files compatible with operating systems, like 
Windows XP, that store all user data in the Documents and Settings folder. 

Destination for upgraded user files

Click the Browse button or select a new destination from the list if you want to choose 
a destination other than the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can 
alter the way that the wizard upgrades the user.

User Upgrade Wizard: Advanced Options dialog box

The Advanced Options dialog box lets you make finer adjustments to how the wizard 
upgrades the user. This page contains the following information and allows you to make 
the following changes:

Users to upgrade

This list box contains the following information about each user at the current location:

User

Name of the user.

Old Location

Location of the current (not yet upgraded) user files.
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Vocabulary

The original vocabulary of the user.

Acoustic Model

The audio input device and associated language/voice model assigned to the 
user.

New Location

When you click on the Location line in the Users to upgrade list box, this text box 
becomes available. Initially it displays the location that the wizard recommends or that 
you chose on the Choose Destination page.You can click Browse and choose a new 
location.

New Base Vocabulary

When you click on the Vocabulary line in the Users to upgrade list box, this text box 
becomes available. Initially it displays the current vocabulary of the user or the one that 
the User Upgrade Wizard will assign to the upgraded user if the old vocabulary is no 
longer supported by Dragon. If the current vocabulary is supported, the message 
<Unable to upgrade> appears.

You can select a new base vocabulary from the drop-down list if it contains other 
vocabularies.

New Acoustic Model

When you click on an Acoustic model line in the Users to upgrade list box, this text 
box becomes available. Initially, it displays the current language (such as US English), 
language model, and accent of the user. You can choose a new acoustic model from 
the drop-down list.

After you have modified the user information for each user in the list box, click OK to 
return to the wizard, and click Next to proceed.

User Upgrade Wizard: Upgrade Users page

On the Upgrade Users page, click Begin to start the upgrade process. Expect to wait 
approximately 5 minutes for each user being upgraded.

When the process is complete, click Finish.

If the Upgrade User wizard ran automatically in response to you starting the product 
after installing an upgrade, the Open User window opens and displays a list of users 
you can choose from to begin dictation.

Upgrading Users with Vocabularies Created by Third Parties

Vocabularies Created by a Third Party (rather than by Nuance)

Note: Any installation can use vocabularies that are not provided by Nuance, but 
created by a third party specifically for a particular installation. 
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Upgrading Users with Vocabularies Created by Third Parties

When you upgrade a user whose base vocabulary was created by a third party, all 
custom words and other changes to that vocabulary will be maintained but the 
vocabulary’s base type will be changed. For example, Version 8.x or 9.x users who used 
US English | Large | Nuance vocabulary with a topic ID of 9005 are upgraded to use 
the General—Large vocabulary; that upgraded user’s vocabulary also contains all 
customizations in the Version 8.x or 9.x vocabulary.

Once the user is upgraded, you can continue to modify the vocabulary using the 
Voctool. 

To further modify and re-distribute customizations to vocabularies created by third 
parties, you can follow the steps outlined below on your Version 10 users.

Step 1: Export any custom words added to the custom vocabulary

If you added any additional custom words to the vocabulary created by a third party, 
you must first export those words. To export custom words:

1. On the DragonBar menu, select Words > Export.... This action displays the Export 
Custom Words dialog box.

2. Enter the path and name of the file containing the custom words to add to the 
vocabulary that you want to create, or use Save in list to find a location for the file you 
want to create.

Step 2: Upgrade a user with a customized vocabulary

To upgrade Version 8.x or 9.x users with a vocabulary created by a third party:

1. Run the User Upgrade Wizard. To run the wizard, select Dragon 
NaturallySpeaking 10> Dragon NaturallySpeaking Tools > Upgrade Users. 

2. In the User Upgrade Wizard, select a Version 8.x or 9.x user that uses a vocabulary 
created by a third party.

3. Click Next and follow the on-screen prompts.

The User Upgrade Wizard displays the original vocabulary deployed to create the 
user and lets you choose a Version 10 base vocabulary that the User Upgrade Wizard 
should assign to the upgraded user. 

Step 3: Import custom words to the upgraded user 

If you exported words in Step 1, you now must import those words. To import a word 
list:

1. On the DragonBar, click Words > Import.... This displays the Add Words from 
Word Lists wizard.

2. Click Next to add the file you created in Step 1. 
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Step 4: Export the customized vocabulary 

You can share vocabularies among different users by first exporting a vocabulary from 
one user and then importing it to a new user. Use the following procedure to export a 
vocabulary. To export a vocabulary:

1. Create a folder in which to save the exported vocabulary files. 

2. Open the upgraded Version 8.x or 9.x user that uses the customized vocabulary. 

3. On the DragonBar, select NaturallySpeaking or say "Manage Vocabularies." 

4. In the Manage Vocabularies dialog box, select the vocabulary you want to export 
and then export it. 

5. Locate and open the target folder, enter a name for the exported vocabulary in the 
File Name box, and then save it. 

6. In the Manage Vocabularies dialog box, click or say "Close" to save and close it.  

Note: Exporting a vocabulary creates a copy of the four files that make up the 
vocabulary in the new location. You can access these files via the Data Distribution 
Tool or the nsadmin tool to create new custom base vocabularies.

Step 5: Use nsadmin or the Data Distribution tool to copy the 
exported vocabulary 

Using the nsadmin command line or the Data Distribution Tool, you can import the 
vocabulary your created in Step 2 as a base vocabulary on any Dragon installation. 

Once you add a base vocabulary to a Dragon installation, you can then use the new 
vocabulary to create new users or add the new a new vocabulary to the an existing 
user.

When you run nsadmin or the Data Distribution Tool to import the exported 
vocabulary to your Dragon installation, be sure to give the new vocabulary the same 
name and topic ID that the Version 8.x or 9.x customized vocabulary had. 

For example, if your Version 8.x or 9.x customized vocabulary was named US English 
| Large | Nuance topic ID 9005, you would use nsadmin or the Data Distribution 
Tool to create a new base vocabulary with that same name and topic ID number.

 



 
 
 
 
 
 
 
 
 
 
Chapter 3 
 

Setting Up and Dictating with 
Roaming Users 
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Setting Up and Dictating with Roaming Users

Roaming Users is a feature of Dragon that allows your users to move from one 
computer to another and dictate with equal recognition quality. The way the feature 
works is that the same user files stored in a central location are accessed by all 
computers on the network, so that the information Dragon learns from a user dictating 
on one machine is also available on other machines.

For more information on the Roaming User feature, see the first row in the table below.

To set up, then use Roaming Users, carry out the steps shown in the table below, in 
chronological order.

For information on: See:

The Roaming User feature Introducing Roaming User 
Feature 

1. Setting up the Roaming User feature, including: Setting up the Roaming 
User feature

2. Creating and dictating with a Roaming User, 
including:

Creating and dictating with 
a Roaming User

• Choosing type of machine to store Master 
Roaming User files

• Creating a network storage location for the Master 
Roaming User files 

• Turning on Roaming User feature

• Setting Roaming User locations

• Setting Roaming User options

• Testing an HTTP or HTTPS connection

• Installing and configuring Dragon on your end-
user workstations 

• Creating Roaming Users one of three ways:

– Creating and training a new Roaming User 
– Converting a non-roaming local user into a 

Roaming User 
– Copying a non-roaming local users to the 

Master Roaming User location 

• Dictating with a Roaming User
– Opening a Roaming User
– Using multiple dictation sources with a single 

user 
– Running the Acoustic and Language Model 

Optimizer for Roaming Users 
– Synchronizing Master and Local Roaming users 
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Introducing the Roaming User Feature

The Roaming User feature lets users dictate with Dragon from different network 
locations and on different machines without having to create and train individual user 
files at each location. 

Some situations that the Roaming User feature makes possible:

• A doctor may need to dictate reports in a medical office building using a desktop 
computer, in a hospital room using a Tablet PC, or at home using a laptop computer. 
The Roaming User feature allows the doctor to use the same set of user files 
containing the same vocabulary words with the acoustic information from each 
location.

• A user dictates on the same laptop at multiple offices and at home. Before leaving 
the office, the user loads a set of user files from a central location on the network to 
his laptop. Once home, the user dictates and corrects as you normally would. When 
you return to the office, you reconnect the laptop to the network. The next time the 
user opens a Dragon user, the Roaming User feature synchronizes the updated user 
files on the laptop with those at the network’s central location.

Advantages of the Roaming User capability

It is important to distinguish the Roaming User capability from simply browsing to a 
network directory and creating files there. Nuance recommends using the Roaming 
User capability rather than storing non-roaming user files in a network directory. The 
Roaming User capability:

• Minimizes network traffic. When Dragon opens a user file, if there is already a copy 
of the roaming user file on the local machine, only the updates are downloaded from 
the network. When the user closes the file at the end of his or her dictation session, 
only the updates from the current session are uploaded to the network. These 
updates typically amount to no more than a few KB of data, as opposed to roughly 
25 MB of data if the entire user file is opened and closed over the network.

• Warns the user if the user attempts to open the same user file from more than one 
workstation at a time.

• Allows the user to use Dragon even if the network directory is unavailable. In that 
case, Dragon opens the local copy of the roaming user file.

• Gives the administrator precise control over where users can put user files. If 
roaming is enabled, the administrator can specify whether or not to also allow users 
to browse to any user file location; the default is not to allow browsing. This means 
that the administrator can easily see how many user files have been created and who 
created them. If roaming is not enabled, users can browse to any location to which 
they have access and create user files there. 

• If HTTP Roaming is configured, it can be used to provide username/password 
authentication on user files. 

Master Roaming User versus Local Roaming User 

With the Roaming User feature, each Dragon user has a single Master Roaming User 
that can be opened from multiple networked machines running Dragon. The Master 
Roaming User is stored on a network location accessible to your dictating users. 
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When a Master Roaming User is opened from that central network location, Dragon 
transfers a copy of that user to the local machine. That local copy is called the Local 
Roaming User.

The Local Roaming User is a copy of the user data taken from the Master Roaming User 
but modified locally by corrections and acoustic data gathered during a dictation 
session.

You can set a central storage device to contain all your Master Roaming User files. By 
loading a Dragon user from the central network location, your users can dictate at any 
computer where Dragon is installed. When users exit Dragon and save the changes to 
their user files, these changes are saved in that central location. The next time the user 
runs Dragon, all the changes saved are available regardless of which computer on the 
network he or she uses for dictation.

 Hosting Master Roaming User files

There are several methods for hosting your Master Roaming User files: 

• On a file server you connect to over a Mapped Drive 

• On a file server that you connect to over a UNC (Universal Naming Convention) 
address

•  On a web server that you connect to over HTTP (http://)

• On a secure web server that you connect to over SSL (https://)

Why roaming user files should be in a shared directory 

It is possible to place roaming user files in a non-shared, user-specific location such as 
the user’s home drive, provided every user’s home drive is mapped to the same drive 
letter (this is because the roaming user file location is an administrative setting that is 
per-workstation, not per-user). 

However, Nuance recommends placing the files in a shared directory to make certain 
administrative tasks more efficient. These tasks include:

• Scheduling an Acoustic and Language Model Optimizer task that optimizes multiple 
users 

• Upgrading multiple user files to a new major release of Dragon NaturallySpeaking 

• Keeping track of how many user files have been created, which helps with licensing 
compliance (note that Dragon NaturallySpeaking is licensed per user, not per 
workstation) 

Backing up your Master Roaming Users

Dragon does not backup local roaming users on the end-user workstations and does 
not backup the Master Roaming User files on the location where they are stored on your 
network.

It is the responsibility of your local administrator to backup the Master Roaming User 
files.

However, Dragon does automatically backs up local non-roaming users on the end-user 
workstations as specified in the Miscellaneous tab of the Administrative Settings dialog 
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box.

For more information

For more information, see the following topics in the order presented:

• Setting up the Roaming User Feature

1. Choosing type of machine to store Roaming Users and Creating network location 
for Roaming Users

2. Close any open users

3. Turning on the Roaming User feature

4. Setting location of Master Roaming Users

5. Setting location of Local Roaming Users

6. Setting Roaming User options

• Creating a Roaming User

Create Roaming Users with one of three techniques:

• Creating and training a new Roaming User 

• Converting a non-roaming local user into a Roaming User

• Copying an non-roaming local users to the Master Roaming User location

• Dictating with a Roaming User

• Opening a Roaming User

• Using multiple dictation sources with a single user

• How Dragon synchronizes Master and Local Roaming Users 

• Running the Acoustic and Language Model Optimizer for roaming users

• Upgrading Roaming Users from a previous version of Dragon NaturallySpeaking

• Controlling user access to other user’s files

For information on enabling Roaming Users as part of an MSI installation, see Enabling 
Roaming User for an MSI installation.

Setting up the Roaming User feature

You take several steps to set up the Roaming User feature. You perform Step 1 just 
once, and steps 2 through 6 on each computer where you plan to have users dictating 
as roaming users. 

Note: To enable Roaming Users and set the Roaming User options, you must start 
Dragon from an account with Windows Administrator privileges. 

Note for Advanced Administrators: 

• You can, alternatively, set up roaming users during a network installation process by 
putting Roaming User settings into an .ini file and setting the DEFAULTSINI and 
ROAMINGUSEROPTIONS options of the MSI installer to the full path to that .ini file. 
For information on carrying out an MSI installation with Roaming Users, refer to: 
Installing Dragon using the Windows Installer (MSI) and  
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Enabling Roaming User in an msiexec.exe installation.

• You can also set up roaming users while installing Dragon manually. Choose the 
Custom setup, and check the option Modify the administrative settings when it 
appears. After the setup utility has copied all of the Dragon files, it displays the 
Administrative Settings dialog in which you can make the roaming user settings

Step 1: Create network storage location for Master Roaming User files

To set up roaming users, you should first determine:

• The kind of network node on which you want to store your Master Roaming User files. 
Make sure it has enough storage space. (For more information, refer to Choosing type 
of machine to store Roaming User files.)

• How you are going to connect to that network location. 

Then, before setting up the Roaming User feature on individual machines:

• Set up the network location(s) for the Master Roaming Users. Each location you pick 
must be accessible to all computers where Roaming Users will dictate. You can create 
multiple network storage locations. 

For more detail, refer to Creating network storage location for Master Roaming User 
files After you have set up the hardware for storing your Master Roaming Users, return 
here and proceed with the next step.

Step 2: Close any open users

• Before you can enable the Roaming User feature, you must first close any open users:

• If the Open User or New User Wizard dialog box appears when you start Dragon, 
click Cancel. 

• If a user opens automatically (Dragon does this if there is only one user available), 
click Close User on the DragonBar Dragon menu.

Step 3: Turn on Roaming User feature

After closing any open users: 

1. From the DragonBar menu, select Tools > Administrative Settings. This action 
displays the Administrative Settings dialog box.Note: You do not have to be running 
Dragon to act as an administrator of the product. Instead of opening the 
Administrative Settings dialog box from the DragonBar menus, you can open the 
dialog box from the command line by selecting Start > Run, then entering the 
following command in the Open text box (include a space between natspeak.exe 
and the /SetAdministrativeOptions option that follows it): 
 
C:\Program Files\Nuance\NaturallySpeaking10\Program\natspeak.exe  
/SetAdministrativeOptions

2. On the Roaming tab, check Enable.

3. Click Apply to save the changes and keep the dialog box open.

Note: With the Roaming User feature enabled, the Open User dialog box later displays 
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only users in the Roaming User storage locations. To let the users open both local (non-
roaming) and Roaming Users, check the Allow non-roaming users to be opened 
option in the Administrative Settings dialog box. Clearing this option prevents users 
from dictating with a non-roaming (local) user by mistake, but you should check it now 
if you want to ensure you can open existing local users so that you can convert them 
to Roaming Users.

Step 4: Set location of Master Roaming Users

On each computer where you plan to have users dictating as a Roaming Users, you 
must tell that installation of Dragon where the Master Roaming users are located.

After selecting Enable on the Roaming tab: 

1. Click the Add button. The Roaming User Network Location dialog box displays. You 
use the Roaming User Network Location dialog box to define the network location 
of the master roaming users. The location you pick must be accessible to all 
computers on the network that you want available for dictation with Dragon.

2. Set the Display Name to the way the name of the directory should display in other 
dialog boxes. The display name later appears in the Roaming tab of the 
Administrative Settings dialog and the Location of user files text box of both 
the Open User and the Manage Users dialog boxes.

3. Set the Network Location. See the types of locations that the Roaming User feature 
supports in Step 1: Create network storage location for Master Roaming User files. 

4. If you are using a web server to store Master Roaming User files, click the 
HTTP Settings and SSL Settings (if you are using HTTPS) button to set information 
about your HTTP and HTTPS connection and proceed with HTTP Settings and SSL 
Settings for further information. After entering the HTTP and SSL Settings, use the 
Test Connection button to make sure your settings are correct. For help 
troubleshooting a problem with the connection, see Testing and troubleshooting an 
HTTP connection.

5. Click OK in the Roaming User Network Location dialog box.

For more information on setting the location of the master roaming user, see Roaming 
User Network Location. 

Note: You cannot create a non-Roaming user on an HTTP connection. You can 
only create Roaming Users on an HTTP connection when the Roaming User 
feature is enabled. 

Step 5: Set location of Local Roaming Users

When a user opens a Master Roaming User, Dragon transfers a copy of that user to the 
local machine. That local copy is called the Local Roaming User. This is the location on 
the computer where changes made during a dictation session, such as corrections or 
new acoustic data, are stored before they are synchronized with the master roaming 
user.

You can set this location, called <Roaming Local>, from the Administrative Settings 
dialog box . Nuance recommends leaving this option at the default setting. 

<Roaming Local>

To accept the default <Roaming Local> location (which Nuance recommends), click 
OK on the Administrative Settings dialog box. You will be prompted to create the 
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default directory if it does not already exists. When you see the following message, click 
Yes.

The default location of <Roaming Local> is: 
 
Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\RoamingUsers\<display name>\

The <display name> is the name you defined for the Master Roaming User location. 
You can have multiple network storage locations for your Master Roaming User files and 
each has its own corresponding directory for Local Roaming Users. 

Set permissions on the directory that stores Local Roaming Users on each workstation 
to read/write/modify access for all Windows user accounts of Dragon users that will be 
dictating. 

Step 6: Set Roaming User options

The Administrative Settings dialog box also contains several options that affect how 
the Roaming User feature works. You select the options that indicate how you want a 
roaming user to function at each Roaming User location. For a list of the options to 
choose from, refer to “Setting/selecting Roaming User options” on page 102. 

Notes:

• Once you set up an installation of Dragon to use the Roaming User feature, users on 
that machine can only open Roaming Users; they cannot open any locally created 
users unless you choose the "Allow non-roaming users to be opened" option. For 
a list of the options to choose from, refer to “Setting/selecting Roaming User options” 
on page 102. 

• If you use a variety of microphones or input devices with your roaming user, see 
Using multiple dictation sources with a single user for more information.

• If you are dictating with a Roaming User, the Acoustic and Language Model 
Optimizer Scheduler is disabled on the local user’s machine. You must run the 
Acoustic and Language Model Optimizer on the machine where your Master 
Roaming User files are located or on an administrator’s workstation. For more 
information, see Running the Acoustic and Language Model Optimizer with a Roaming 
User.

Choosing type of machine to store Roaming User files

Dragon lets you store your Master Roaming Users on one or more of the following types 
of network machines: 

• File server 

• Web server 

• Secure web server running SSL

You are not strictly required to store Master Roaming User files on a server. Any shared 
0
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location accessible to other computers on the network is a perfectly acceptable place 
to store Master Roaming User files.

Web Servers That Support Roaming User Feature 

If you want to store your Master Roaming Users on a web server (not required), 
Internet access to Master Roaming User files is supported on two web servers:

• Microsoft Internet Information Services (IIS) 6.0. For this type of server: 

• Be sure that the server has Web-based Distributed Authoring and Versioning 
(WebDAV) turned on. The WebDAV Apache module is available free of charge at 
http://www.webdav.org/mod_dav/.

• Digest authentication through a proxy server with Internet Information Server 
(IIS) 6.0 is not supported. 

• If you have not already installed the WebDAV component, use Add/Remove 
Programs in Control Panel and run the Windows Components Wizard. See Microsoft 
IIS documentation for details. 

• Apache HTTP Server 2.0.54 and higher. For this type of server:

• Internet Roaming User—Redirects must be turned on when using Digest 
authentication.

• Be sure the server has Web-based Distributed Authoring and Versioning 
(WebDAV) turned on.

Creating network storage location for Master Roaming User files

Step 1: Creating network storage for Master Roaming User files

At any installation of Dragon you must first determine where on the network the Master 
Roaming user files should be located. 

Dragon lets you store you Master Roaming Users on a networked machine that is not 
a server, on a Windows server, or on an HTTP server with or without SSL—allowing you 
to access your Master Roaming Users over the Internet.

1. If you choose to use a networked machine or Windows server, you should determine 
the path to where the Master Roaming Users will reside. You can create multiple 
network storage locations.

The Roaming User feature supports the following types of locations for your Master 
Roaming Users: 

• Mapped Drives—Connects to a shared network folder that has a drive letter 
assigned to it. 

• UNC Paths—Connects to a shared network folder using the Universal Naming 
Convention (UNC) to locate a user. Format is: 
\\<servername>\<sharename>\<path>\<filename>.

• HTTP (http:)—Connects to machine on the internet or your local intranet. Format 
is: http://<myserver.com>/<webdav>

• HTTP with SSL (https:)—Connects to machine on the internet or your local 
intranet with SSL. Format is: https://<myserver.com>/<webdav>

2. The location(s) you pick must be accessible to all computers where users will dictate 
with a Roaming User. Each location must have adequate storage space for Roaming 
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User Files. For more information, see Storage space required for user files.

3. If you choose to use an HTTP server, choose one of the supported web servers:

Supported Web Servers

 Microsoft Internet Information Services (IIS) 6.0

Apache HTTP Server 2.0.54 and higher 

4. After you have chosen the type of machine to store the Master Roaming Users, you 
should determine the following information so that you can tell Dragon how to connect 
to the HTTP server:

Information about Your Web Server

The network location: You need to know the URL address of your HTTP 
server. For more information, see Roaming User Network Location.

HTTP settings: For your http (or https) connection you need to know 
authentication, firewall, and proxy server information. For more information, 
see HTTP Settings.

Notes:

• The web server application called WebDAV is required to set up an HTTP or 
SSL WebDAV server.

• Using Internet Information Server 6.0: 

• Digest authentication with Internet Information Server not supported.

• If you are running Internet Information Service (IIS) 6.0 (the only version we 
currently support) and have not already installed the WebDAV component, use Add/
Remove Programs in Control Panel and run the Windows Components Wizard. 
See the Microsoft IIS documentation for details. 

• Using Apache HTTP Server 2.0.54 and higher: 

•  Internet Roaming User— Redirects must be turned on when using Digest 
authentication with Apache.

• Be sure that the server has Web-based Distributed Authoring and Versioning 
(WebDAV) turned on. The WebDAV Apache module is available free of charge at 
http://www.webdav.org/mod_dav/.

Setting/selecting Roaming User options

The Administrative Settings dialog box also contains several options that you can 
choose from to indicate how you want a Roaming User to function at each Roaming User 
location: 

Allow non-Roaming Users to be opened

Select this box to permit the user to open non-Roaming (local) users. Nuance 
recommends clearing this option to prevent anyone from dictating with a non-Roaming 
(local) user by accident. You may want to set this option temporarily in order to convert 
non-roaming (local) users to Roaming Users, and then clear it when you are done.

Merge contents of vocdelta.dat into network user when file is full

Select this box to copy the contents of the local vocdelta.dat file to the master 
Roaming User without running the Acoustic and Language Model Optimizer. 

Vocdelta.dat is the file used to store vocabulary changes in the Master Roaming User. 
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It is updated whenever a Local Roaming User is closed, and it is used to update the 
Local Roaming User file with vocabulary changes every time that user is opened. When 
you run the Acoustic and Language Model Optimizer on the Master Roaming User, 
Dragon incorporates the contents of vocdelta.dat into the vocabulary (.voc) file and 
empties vocdelta.dat.

If you check this setting, Dragon monitors the size of the vocdelta.dat file. When the 
vocdelta.dat file reaches 90% of it’s maximum size (500KB), Dragon incorporates the 
contents of the vocdelta.dat file into the vocabulary (.voc) file and empties vocdelta.dat 

This operation occurs when the user opens the local Roaming User. This operation can 
take a long time because the vocabulary file must be transferred over the network 
twice. Subsequently, opening the local roaming user on another workstation can also 
take a long time because the entire vocabulary file must be copied from the master to 
the local roaming user.

If you do not set this option and if you have not run the Acoustic and Language Model 
Optimizer for a long time, the user will see a message when the vocdelta.dat file 
becomes full. If you do not run the Acoustic and Language Model Optimizer regularly, 
you should set this option to prevent end users from seeing this message.

Access network at user open/close only 

Select this box to synchronize changes made to the local Roaming User to the Master 
Roaming User only when a local Roaming User opens or closes. If this box is not 
selected, then these local changes are immediately transferred to the Master Roaming 
User. The only changes affected by this setting are the changes a user makes locally 
from the Options dialog box, therefore this setting is highly unlikely to have a 
perceptible impact on Dragon’s performance.

For more information, see How Dragon Synchronizes Master and Local Roaming users.

Ask before breaking locks on network users (recommended for UNC and 
mapped drives) 

Select this box to keep the option of maintaining or breaking a network lock when 
opening a Roaming User. Normally, network locks prevent anyone from opening a 
Roaming User at the same time someone else is opening that user. While this process 
does not take a long time, network problems can cause a lock to become "stuck" and 
not release when the opening process is completed. When this happens, the next time 
anyone tries to open that user, Dragon displays a message stating that the user is 
locked and giving them the option of overriding it. If you do not want this message 
displaying and always want to break a network lock in this situation, you can clear this 
option to prevent the message from appearing. Because the presence of a lock can 
indicate a problem that needs to be addressed, Nuance recommends that you enable 
this option. 

Notes: 

•  This option is valid for users connecting to the Master Roaming User location using 
a mapped drive or UNC drive, but is not supported for users connecting over HTTP. 

• Be careful when in breaking a locked Roaming User file. For example, if you break a 
lock when another user is writing to the Master Roaming User, breaking the lock may 
corrupt the Master Roaming User files.

Set audio levels on each machine (recommended)

Select this box to run the Check your audio settings option from the Accuracy 
Center window before your first session with a Roaming User. This includes the 
Volume Check and the microphone Quality Check. Check this option if your users 
are dictating on different machines or on a single machine, like a laptop, in many 
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different locations. When a user changes machines or locations, the audio setup data 
can vary depending on differences in the microphone and sound card, as well as 
differences in ambient sound levels of each Roaming User location. In situations where 
Dragon detects a significant difference between operating systems, sound cards, 
microphones, or other hardware, the program will prompt you to run Check your 
audio settings even if you do not have this option selected. 

Copy Dragon Log to Network

Select this box to copy the Dragon.log file from the local workstation to the master 
Roaming User location whenever the program synchronizes the local and master 
Roaming User. Dragon.log contains information that can help to diagnose problems 
that your users might encounter using Dragon.

Note: The Dragon.log file will not be copied once the maximum size is reached in the 
Disk space reserved for network archive option. 

Selecting this option can increase how long it takes to close a Roaming User. It can also 
limit the usefulness of the Acoustic and Language Model Optimizer because it reduces 
the amount of acoustic data that can be stored in the network archive. Nuance 
recommends that you not set this option unless requested by Nuance Technical 
Support.

Always copy acoustic information to network

Select this box to copy the user’s acoustic model (.usr and .sig files) to the Master 
Roaming User location. 

If you chose not to copy the user’s acoustic information to the network, updates to the 
acoustic model that you make on one machine (for example by correcting and training 
words) will not be available on other machines used by that particular Roaming User 
until you run the Acoustic and Language Model Optimizer on the Master Roaming 
User location and the Local and Master Roaming users synchronize. Therefore, if you 
do not run the Acoustic and Language Model Optimizer on the Master Roaming 
Users regularly, you should set this option. By always copying the acoustic information 
to the Master Roaming User location, you ensure these accuracy improvements will be 
available when the Master Roaming User is opened from another location. However, 
setting this option can increase the amount of time it takes to close a Roaming User. 

 The transfer of acoustic information based on this option’s setting is not limited by 
setting the Disk space reserved for network archive option. 

Conserve archive size on network 

Select this box to prevent the copying of .DRA files (files that contain the acoustic data 
from the latest dictation session) to the Master Roaming User location when the 
program synchronizes the Local and Master Roaming users. Leaving this box 
unchecked allows the local .DRA files to synchronize with the Master Roaming User, 
which makes the .DRA files available to the Acoustic and Language Model 
Optimizer when it is run on the Master Roaming User locations and provides increased 
accuracy. 

However, because .DRA files can be large, if you experience excessive network 
slowdowns, checking this option may solve the problem by eliminating the copying of 
these files each time the Master and Local Roaming users synchronize. You can still run 
the Acoustic and Language Model Optimizer on the Master Roaming User, but since 
it will not have the .DRA files to process, the accuracy gains will be less.

Note: The .DRA files will not be copied once the maximum size is reached in the Disk 
space reserved for network archive option.
4



Setting Up and Dictating with Roaming Users
Disk space reserved for network archive

Use this option to specify the maximum size of the directory containing the acoustic 
data available to the Acoustic Optimizer. By default the archive size is 500 MB per 
dictation source. To conserve space, you can reduce the default size and select the 
Conserve archive size on network option. 

Setting up HTTP Connection: HTTP Settings 

You use the HTTP Settings dialog box to define and configure the connection to your 
web (HTTP) server. Enter information about your connection in the following sections 
and text boxes of the dialog box:

Authentication

Passwords

Defines how the roaming user enters the server username and password. This 
username/password is to the server, not a local login: 

• Prompt for User and Password: Select if local users will be prompted for a 
username/password when they connect to the HTTP server. 

• User/password: Sets the default username/password needed to connect to the 
HTTP server. Be sure to put the domain name followed by a backslash in front of the 
user login name; for example, Nuance\JWyman.

Authentication Type 

Sets the type of authentication used on the HTTP server you specified as the Address 
in the Roaming User Network Location dialog box. Select the type that indicates 
how your server is configured:

• Basic: Choose if the server is configured for Basic authentication, where the 
username and password are passed over the network as clear text

• Digest: Choose if the server is configured for Digest authentication, where the 
passwords are never transmitted across the Internet in unencrypted form. 

Note: For security reasons, be sure that anonymous logins are disabled on the 
HTTP or HTTPS server. 

Connection

Follow Redirects 

If you are storing the Master Roaming User files on a server that redirects incoming 
connections to another location, you can define how Dragon handles these redirects:

• Never: redirects are never followed, but ignored.

• Always: redirects are always followed. 

• Same Scheme Only: only redirects using the same scheme as the client request are 
permitted. 

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current 
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session ends. 

Firewall and Proxy Servers

Use Proxy Server 

Select Use Proxy Server if you are connecting to your HTTP server through a proxy 
server.

Type 

Select the type of firewall used on the HTTP server from the drop-down list:

• HTTP Proxy: Select for a proxy server that specializes in HTML (web page) 
transactions.

• Tunnel: Select if you are connecting to the server with tunneling software. 

• SOCKS4: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to 
allow application users transparent access across the firewall. SOCKS4 doesn’t 
support authentication, UDP proxy. SOCKS4 clients require full Domain Name Service 
(DNS).

• SOCKS5: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to 
allow application users transparent access across the firewall. SOCKS5 supports 
multiple authentication methods. SOCKS5 clients use the SOCKS5 server to perform 
the DNS lookup. 

Server

Enter the server name provided by your network administrator. 

Port

Enter the port number needed to connect to the proxy server or firewall. 

Username

Enter any username needed to log in to the proxy server or firewall.

Password

Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization

Enter any special authentication string provided by your network administrator. 

Timeouts

Lock Timeout

Set to the number of seconds the server should wait before breaking the lock on any 
open Master Roaming User files. Setting the lock to 0 uses the default setting from the 
server. Specifying another time overrides the server default. 

A network locks prevent anyone from opening a Master Roaming User that someone 
else has already opened. While this process does not take a long time, network 
problems can cause a lock to become stuck and not release when the opening process 
is completed. When this happens, the next time you try to open that user, you see a 
message informing you of the lock.
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Connection

Number of seconds before Dragon should close the connection to the server either 
when the connection is idle or after the connection has been open for that duration. 

Connection Timeout Type 

Sets when the connection timeout in the previous text box applies:

• Inactivity: Closes the connection after the roaming user is inactive for the specified 
time.

• Absolute: Closes the connection after the specified time independent of any roaming 
user network activity. Use this option with caution, as it could close the connection 
during synchronization. 

Test Connection

Once you have filled in the information, you can click the Test Connection button to 
test the connection to the HTTP server.

Restore Defaults 

Restores the default settings. 

After you click OK, you return to the Administrative Settings dialog box.

For more information 

• About the Roaming User feature

• Setting up the Roaming User feature

• Creating and opening a roaming user

Setting up secure web server connection: SSL Settings 

You use the SSL Settings dialog box to define and configure the connection to your 
secure web (HTTPS) server. Enter information about your connection in the following 
sections and text boxes of the dialog box:

Certificate Store 

Here you indicate the type of certificate that provides server identity, certificate, and 
public key information to clients that try to establish a connection:

Certificate Store Type 

Select the certificate store type used for the client certificate on the local machine:

• User (default): For Windows, choose if the certificate store is a certificate store 
owned by the current user. For Java, choose if the certificate store is the name of a 
JKS (Java Key Store) file. If the provider is OpenSSL, choose if the certificate store 
is a file that contains the PEM encoded certificate and private key. 

• Machine: Choose if the certificate store is a machine store (not available in Java or 
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when provider is OpenSSL). 

• PFX file: Choose if the certificate store is the name of a Private Key Server or PFX 
(PKCS12) file containing certificates. If the provider is OpenSSL, the file may contain 
only one certificate and private key. 

• PFX Blob: Choose if the certificate store is a string (binary or base64 encoded) 
representing a certificate store in PFX (PKCS12) format. 

• PEM Key: Choose if the certificate store is a string or file name that contains a 
Privacy Enhanced Mail (PEM) encoded certificate and private key. This store type is 
currently not supported in Java. 

Certificate Store

 The name of the certificate store for the client certificate on the local machine:

The storage location is called the certificate store. A certificate store will often have 
numerous certificates, possibly issued from a number of a different certification 
authorities:

• MY: A certificate store holding personal certificates with their associated private 
keys.

• CA: A certificate store holding Certifying Authority (CA) certificates.

• ROOT: A certificate store holding ROOT certificates.

• SPC: A certificate store holding Software Publisher Certificate (SPC) certificates.

• Other: Any other Certificate Store not listed above. 
Notes:

• If you select PFX file for the Certificate Store Type, for the Certificate Store 
select Other and enter the name of the file in the associated text box below it. 

• If you select PFX Blob for the Certificate Store Type, for the Certificate Store 
select Other and enter the binary contents of a PFX file (for example, the PKCS12) 
in the associated text box below it.

• If you are using OpenSSL, for the Certificate Store select Other and enter the name 
of the file containing a certificate and a private key in the associated text box.

Certificate Store Password

The password for the Certificate Store on the local machine if one is required. 

Open SSL 

Select Using OpenSSL if the HTTPS server uses OpenSSL as a Certificate Authority. 
OpenSSL is a free non-commercial implementation of SSL.

When you select Using OpenSSL, you must provide: 

• Cipher List: A string that controls the ciphers to be used by SSL. The cipher list 
consists of one or more cipher strings separated by colons.

• Certificate Authority File: Name of the file containing the list of certificate 
authorities (CAs) trusted by your application. The file set by this property should 
contain a list of CA certificates in PEM format. 

• CA Directory: Path to a directory containing CA certificates. The path set by this 
8



Setting Up and Dictating with Roaming Users
property should point to a directory containing CA certificates in PEM format.

General

Use this section to enable/disable the supported security protocols on the HTTPS 
server. 

• TLS1: Version 1 of the Transport Layer Security (TLS) protocol.

• SSL3: Version 3 of the Secure Sockets Layer (SSL) protocol.

• SSL2: Version 2 of the Secure Sockets Layer (SSL) protocol.

• PCT1: Version 1 of the Private Communications Transport (PCT) protocol.

Notes:

• Although a number of sites still support SSL2, Nuance recommends that you disable 
it because of potential security vulnerabilities.

•  If you select Using OpenSSL, this functionality is provided by the Cipher List.

Test Connection

Once you have filled in the information, you can click the Test Connection button to 
test the connection to the HTTPS (SSL) server. 

Restore Defaults 

Restores the default settings. 

After you click OK, you return to the Administrative Settings dialog box.

For more information 

• About the Roaming User feature

• Setting up the Roaming User feature

• Creating and opening a roaming user

Testing and troubleshooting an HTTP connection 

Once you have supplied all the necessary information needed to connect to your HTTP 
server, press the Test Connection button. The Test Connection button tests the 
connection to your HTTP server based on the information you supplied in the Roaming 
User Network Location and HTTP Settings dialog boxes.

Troubleshooting test connections

The table below lists the possible messages you might receive after pressing the Test 
Connection button.
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Message Solution

Connection test successful! None—test successful. 

Could not connect to the 
network location.

Check spelling and syntax of the HTTP address 
in the HTTP Settings dialog.

Check your local network for problems. 

Could not copy a file to the 
network location

Check create and write privileges on the server

Server not installed or active.

Could not create a directory on 
the network location

Check the create directory privileges on the 
server for the Master Roaming directory. 

Check the privileges for creating sub-directories 
under the Master Roaming directory. 

Could not delete a file from the 
network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges

Check that privileges are inherited in the 
subdirectories.

Could not delete a directory 
from the network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges

Check that privileges are inherited in the 
subdirectories.

Could not copy files into a 
directory created on the 
network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges.

Check for authentication time-out on your 
server.

Check your local network for problems. 

Could not list the contents of a 
directory created on the 
network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges

Check that privileges are inherited in the 
subdirectories.

Contents of newly created 
directory TempDir were 
incorrect

Caused by an incomplete directory listing. Try 
again. If the problem persists, check the condition 
of your network.

Could not copy a file from the 
network location

Check permissions on the Local Master Roaming 
directory. 

Check that the Local Master Roaming directory 
exists.

Could not get the size of a 
newly created directory on the 
network location.

Apache: Make sure DavDepthInfinity directive 
is set to "on" for Master Roaming directory.
0
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For more information 

• About the Roaming User feature

• Setting up the Roaming User feature

• Creating and opening a roaming user

Controlling user access to other user’s files

If you have multiple Dragon users on an end-user workstation, those users will have 
multiple users to choose from in Dragon’s Open User dialog box.

If you use a shared directory for user files, whether they are roaming or non-roaming, 
you may be concerned about the ability of a user to see and/or open another user’s file 
as well as their ability to open the correct file. There are several ways to address this 
concern:

• Many of Nuance’s customers address this concern simply through user training. Each 
user should be aware that if they open another user’s file and try to use it, their 
accuracy will be poor and user-specific customizations will not be available. 
Therefore, each user has an incentive to use only their own file. However, this fact 
doesn’t prevent a malicious user from damaging another user’s file. 

• If users always log into Windows with a unique Windows user ID, you can use 
Windows file permissions to control access to the files. Typically, you do this by 
granting Full Control or Read/Write/Modify access to the shared directory, but do not 
allow this permission to propagate to subdirectories. That way, each user becomes 
the creator owner of any Dragon user file that he or she creates. Users can still see 
all of the Dragon NaturallySpeaking user names in the Open User dialog box, but if 
they try to select another user’s file a message will appear saying that they do not 
have permission to access that file. Apply similar file permissions to the local copy of 
each roaming user file; the default location for local copies is under c:\Documents 
and Settings\All Users\Application Data\Nuance\NaturallySpeaking10\Roaming 
Users. 

Could not rename a file on the 
network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges

Check that privileges are inherited in the 
subdirectories.

Could not rename a directory 
on the network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges

Check that privileges are inherited in the 
subdirectories.

Could not copy a directory 
within the network location

Check permissions on the Master Roaming 
directory. The user must have read, write, and 
modify privileges

Check that privileges are inherited in the 
subdirectories.

Message Solution
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• If users log in using a shared Windows user ID, the best way to control access is 
through HTTP Roaming. In this configuration, you set up a web server running either 
IIS or Apache and with the WebDAV file system enabled. On each workstation, you 
specify a URL on the web server as the roaming user location. When a user launches 
Dragon NaturallySpeaking, before displaying the Open User dialog it prompts for a 
user name and password, which it uses to authenticate against the web server.  
 
You can use file permissions on the web server to specify which user files are 
accessible to each account on the web server. File security is a function of the web 
server and the WebDAV software. 

Making it easier for users to select their user files

As described above, the Dragon Open User dialog shows a list of all of the user files in 
a shared directory (unless you are using HTTP Roaming to limit access to user files). If 
there are more user files than will fit on one screen, you can train users to go directly 
to a specific user file by typing the first few letters of its name. 

It is possible to create an icon in the Start Menu and/or the Windows desktop that opens 
a specific user name. This can be helpful if there are only a few users of Dragon who 
share a particular workstation. Make a copy of the Dragon icon for each user, and place 
the parameter /user ″user name″ on the natspeak.exe command line. See the 
Command line interface topic in the main Dragon help file for more information on the 
command-line parameters. 

Creating a Roaming User

There are three ways to create a Roaming User:

• Train a new Roaming User

• Convert a non-roaming local user into a Roaming User

• Copy an non-roaming local users to the Master Roaming User location

To open or create a Roaming User, your local installation of Dragon must be configured 
for Roaming Users. For more information, see Setting up the Roaming User Feature.

Notes

• If you use variety of microphones or input devices with your Roaming User, see the 
topic: Using multiple dictation sources with a single user.

• When you export a user to a new location, any custom words that you have added to 
a local Roaming User will not accompany the user files unless you first run Add 
Words from Document wizard from the Accuracy Center. As an alternative to 
running the Add Words from Document wizard, you can turn the Roaming User 
feature off in the Administrative Settings dialog box, save the user, and then turn the 
feature back on.

• If you modify a master Roaming User while you have a local Roaming User open on 
a computer that is not currently connected to the network (for example, a laptop at 
a remote location), the changes to the master Roaming User will overwrite any 
changes you make to the local Roaming User when you synchronize the local and 
master Roaming Users.

• When a Roaming User exits Dragon, switches users, closes a user, or saves a user, 
2
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Dragon saves changes to the Local Roaming User and then synchronizes these 
changes with the Master Roaming User on the network. For more information, see 
How Dragon Synchronizes Master and Local Roaming users

Creating and training a new Roaming User

To create and train a new Roaming User:

1. To display the Open User dialog box, select Dragon > Open Users on the 
DragonBar.  
 
Note: When the Roaming User feature is enabled, you can only create Roaming 
Users. The Location of user files field displays only the Roaming User locations you 
defined in the Administrative Settings dialog box. To let the users create both local 
(non-roaming) and Roaming Users, select the Allow non-Roaming Users to be 
opened option on the Roaming tab of the Administrative Settings dialog box. 
Clearing this option prevents users from dictating with a non-roaming local user by 
accident. For more information, see Setting up the Roaming User Feature.  
 
If you allow users to select both non-roaming local and Roaming Users, be sure they 
select the correct location from the Location of user files field.

2. Click New and begin training the user as you would any other user. 

3. When you are finished training the user, the program copies the user files into the 
master Roaming User location specified in the Location of user files field.

Converting a non-roaming local user into a Roaming User

You can convert an existing non-roaming local user to a Roaming User from the 
Manage Users dialog box. Converting a non-roaming local user copies that user to the 
specified Master Roaming User location.

To convert a non-roaming user to a roaming user:

1. Select Dragon > Manage Users from the DragonBar. This action displays the 
Manager Users dialog box.

2. In the Location of user files drop-down list at the bottom of the dialog box, 
select the non-roaming local location of your user files. Now the list under Users 
should include all the non-roaming local users that you can convert to Master 
Roaming Users.

3. Select the non-roaming local user you want to convert to a Master Roaming User.

4. Click the Advanced button and then select Save to Roaming from the menu 
that pops up. The Save to Roaming dialog box appears. 

5. Select the appropriate Master Roaming User location from the drop-down list and 
click OK. A Master Roaming User location appears in this list only if it is currently 
available to the local machine.

6. Repeat the process for any other non-roaming local users you want to convert to 
Master Roaming Users.
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Copying non-roaming local users to the Master Roaming User 
location

You can also convert a non-roaming local user to a roaming user by copying the user 
files into the network directory of the Master Roaming User. This approach has the 
advantage of allowing you to turn a number of non-roaming local users into master 
Roaming Users with a single operation.

To copy a local user into the master roaming user directory:

1. If the Master Roaming Users are on an Apache server, skip this step. If they are 
on an IIS server, before you proceed, be sure you have Microsoft Web Folders 
functionality installed on your local machine. If it is not installed, visit http://
www.microsoft.com/downloads/details.aspx?familyid=17C36612-632E-4C04-
9382-987622ED1D64&displaylang=en and download the software.Note: After 
you download the Web Folder functionality, you might need to try this copying 
action more than once before it succeeds.

2. On the local disk, navigate to the location of the non-roaming local user files you 
want to convert to Master Roaming Users. By default, non-roaming user files are 
located in C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Users. You see a folder for each non-
roaming local user.

3. Select the files of the non-roaming local users you want to copy.

4. Copy the selected non-roaming local users to the Master Roaming User network 
directory.

5. Once you have copied the users to the Roaming Users location, to prevent users 
from opening a local user instead of a roaming user:

a. Close all open users. 

b. On the DragonBar, select Tools > Administrative Settings and uncheck 
the Allow non-roaming users to be opened option.

c. Click Apply to apply the change and OK to close the dialog box.
Notes:

• By default, non-roaming local users are located in: 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Users

• Each non-roaming local user has its own directory structure. Be sure to copy the 
entire user directory structure to the Master Roaming User network directory.

Dictating with a Roaming User

You dictate with a Roaming User the same way you would with any other user. For 
specific information about working with a Roaming User, refer to the following topics:

• Opening a Roaming User

• Using multiple dictation sources with a single user

• Running the Acoustic and Language Model Optimizer for Roaming Users
4
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• Synchronizing Master and Local Roaming users

Opening a Roaming User

When the Roaming User feature is enabled, you can only open Roaming Users (unless 
you set an option allowing speakers to open both Roaming and Local Users). 

To open a Roaming User:

1. On the DragonBar, select Dragon > Open User. 

2. On the Open User dialog box, select a user from the list, and click Open. 
If you do not see the user you are looking for, hit F5 to refresh the list of users. 

Notes:

• If you allow users to select both non-roaming local and Roaming Users, make sure 
they select the correct location from the Location of user files drop-down list.

• When the Roaming User feature is enabled, you can only open Roaming Users. The 
Location of user files drop down list displays only the Roaming User location you 
defined in the Administrative Settings dialog box. To let the users open both local 
(non-roaming) and Roaming Users, select the Allow non-Roaming Users to be 
opened option in the Administrative Settings dialog box. Clearing this option 
prevents users from dictating with a non-roaming local user by accident. For more 
information, see Setting up the Roaming User Feature. 

• If you connect to your Roaming User Master Directory over HTTP or HTTP with SSL, 
and you find that not all your users are listed in the Open User dialog box, make 
sure that: 

• The .INI extension is registered in MIME types (ini.png) list of your IIS server. 
 
Add all file extensions within your Master Roaming User directories and subdirectories 
to the Registered MIME types list of your IIS server. You could also add a wildcard ( 
.*) MIME-type. For more information on adding a wildcard ( .*) MIME-type, see: 
 
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/
cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true

• The user’s topics.ini and acoustics.ini files are not locked, password protected, 
or otherwise access restricted by your server permissions.

Using multiple dictation sources with a single user

It is possible to have a variety of dictation sources (audio input devices) for a single set 
of user files so that the speaker can deploy various microphones or portable recording 
devices. This ability is especially useful with a Roaming User. By allowing multiple 
dictation sources, you can still have the same user files for each location regardless of 
the microphone type. 

To add a new dictation source to a user

1. In the Open User dialog box, select the user to dictate with the new dictation source.

2. Click the Source button and then click New. The New Dictation Source dialog box 
appears.
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3. Select a new input device for dictation from the list on the New Dictation Source 
dialog box. You can choose from among different microphone or recorder types.

4. Click OK. You return to the Open User dialog box.

5. Select the user you just created and click Open. If you have not previously trained 
the user with the new dictation source, the New User wizard appears and you can 
begin training.

Running the Acoustic and Language Model Optimizer for Roaming 
Users

When the Roaming User feature is enabled on a workstation, that workstation cannot 
run the Acoustic and Language Model Optimizer or the Acoustic and Language 
Model Optimizer Scheduler because the optimizer or scheduler can only be run on 
the Master Roaming User. Later, any optimizations done by the Acoustic and 
Language Model Optimizer are copied to each Local Roaming User when 
synchronization occurs. 

The system administrator is responsible for running the Acoustic and Language 
Model Optimizer on the network location of the Master Roaming Users. The 
administrator can install Dragon on the machine where the Master Roaming User files 
are located (if it is a Windows Server) or an administrator’s machine that has network 
access to the Master Roaming User files and run the Scheduler for the Acoustic and 
Language Model Optimizer. If possible, the administrator’s workstation should be 
colocated with the server because a large amount of data needs to be transferred 
between the server and the workstation running the optimizer.

Note: You must have Windows Administrator privileges on the machine where you are 
running the Scheduler for the Acoustic and Language Model Optimizer.

To run the Acoustic and Language Model Optimizer to optimize Roaming 
Users

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the 
Acoustic and Language Model Optimizer. Also be sure that the Roaming User 
capability is not enabled.

2. On the Windows Start menu, select Programs > Dragon NaturallySpeaking 
10.0> Dragon NaturallySpeaking Tools > Scheduler for Acoustic and 
Language Model Optimizer to start the Acoustic and Language Model 
Optimizer Scheduler.

3. Access the master directory of the Roaming Users you want to optimize: select File 
> Set Speaker Directory from the menu of the Acoustic and Language Model 
Optimizer Scheduler window. In the Set User Profile Directory dialog box, either 
enter the path of the directory or click the Browse button. If the users you want to 
optimize are located in multiple directories, you can change directories to locate the 
additional users.

4. Select the user or users you want to optimize and set a schedule for running the 
Acoustic and Language Model Optimizer. For specific instructions, click the Help 
button in the window.
6
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How Dragon Synchronizes Master and Local Roaming users

When a Roaming User exits Dragon, switches users, closes a user, or saves a user, 
Dragon saves changes to the Local Roaming User and then synchronizes these changes 
with the Master Roaming User files on the network.

In a networked situation, this occurs at the time one of these operations is performed. 
When a user dictates using a computer not currently connected to a network, all 
changes are saved to the Local Roaming User; synchronization occurs when the user 
reattaches the computer to the network containing the Master Roaming User and opens 
that user again.

The following changes take place when Local and Master Roaming Users are 
synchronized:

• Combines words added to the Local Roaming User during a dictation session with the 
Master Roaming User vocabulary, 

• Removes words deleted from the Local Roaming User from the Master Roaming User 
vocabulary.

• Copies acoustic data (from files with a .DRA or .NWV extension) from the Local 
Roaming User and adds them to the Master Roaming User where the data become 
available to the Acoustic Optimizer (Note that .DRA files saved voluntarily by the user 
along with a document do not get added to the Master Roaming User. The.DRA files 
created automatically by Dragon for use by the optimizer are the only ones that get 
added to the Master Roaming User.) For more information on running the Acoustic 
Optimizer, see Running the Acoustic and Language Model Optimizer for roaming 
users.

• Copies any custom commands created or modified locally (using the MyCommands 
editor) to the Master Roaming User.

• Saves any local user options that you changed on the Options or Formatting dialog 
box to the Master Roaming User, except the options listed below. These options are 
not synchronized, but remain with the local roaming user only: On the Data tab: 

•  Conserve disk space required by user files option

• Create usability log option in the Advanced dialog box

• Incremental adaptation in additional training option

On the Miscellaneous tab:

• Use Active Accessibility for menu and dialog control option

• Launch in QuickStart mode on Windows startup option

On other tabs of Options dialog box:

• All the options on the Text-to-speech tab

• All the options on the Hot keys tab

Settings in the Formatting dialog box:

• The Enable postal code commands option

Note: During synchronization, changes to the Master Roaming User overwrite any 
changes made to a Local Roaming User who has been dictating and correcting 
dictation while not on the network.
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Updating Configuration Files

The following table briefly explains how and when individual files are copied or updated 
to the master roaming user or to the local cache.

File Name or Type When Copied or Updated to 
Master Roaming User

When Copied or 
Updated to Local Cache

*.usr  
and  
*.sig

At save time if the option to 
save the files is on. If the 
option is off, after the acoustic 
optimizer runs on the master 
roaming user, the server 
incorporates the changes.

Copied if version number 
on server is different

*.voc Copied only after the acoustic 
files for the user have been 
modified with information 
from Add Words From 
Documents, Add Words from 
Email, Add Lists of Words, and 
similar procedures.

Copied if version number 
on server is different

Acarchive.nwv Copied to session folder if it 
exists; once master 
voice_container limit is 
reached, nothing more is 
copied. The local copy is 
deleted and a zero-length file 
is created.

Never

Audio.ini Copied to master after 
running the Audio Setup 
Wizard or at user close if not 
copied successfully after 
running the Audio 
Setup Wizard

Copied if version number 
on server is different; also 
copied right before Audio 
Setup Wizard is run

Backups Never 

Dragon does not backup local 
roaming users on the end-
user workstations and does 
not backup the Master 
Roaming User files on the 
location where they are stored 
on your network.

It is the responsibility of your 
local administrator to backup 
the Master Roaming User files.

However, Dragon does 
automatically backs up local 
non-roaming users on the 
end-user workstations as 
specified in the Miscellaneous 
tab of the Administrative 
Settings dialog box.

Never
8
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DRA files, 
aco.ini; 
drafiles.ini

Copied to session folder if the 
master voice_container has 
space. Files are deleted after 
being copied; aco.ini and 
drafiles.ini are recreated at 
zero-length  

Never

Mycmds.dat Copied when user profiles are 
saved, or user is closed and 
saved.

Copied at user open 

Options.ini Copied at user close, options 
dialog close when the 
timestamp on the local file has 
changed.

Copied on user open, 
options dialog open if 
version number is 
different on the server

Vocdelta.dat Merged to master copy on 
user save and open. When 
vocabularies are copied up, 
vocdelta.dat is reset to zero in 
the master copy for that topic.

Copied to local cache on 
user open and merged 
into the voc if version 
number is different on the 
server

nsuser.ini, 
local.ini, 
nssystem.ini, 
natspeak.ini

Never (machine dependent) Never

File Name or Type When Copied or Updated to 
Master Roaming User

When Copied or 
Updated to Local Cache
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Using Dragon in a Citrix Presentation Server 
Environment

Dragon includes support for deploying and running Dragon in a Citrix environment.

Note: Citrix is not supported for Dragon Medical Small Practice Edition.

Note: When you dictate using Dragon Medical in a Citrix environment, you can use all 
capabilities of the PowerMic II microphone, including all of the device’s standard and 
programmable button functions and its bar code scanner. The earlier model PowerMic 
I is not supported.

For information on: See:

Sizing and Configuring Dragon for Citrix Sizing and configuring 
environment for Dragon in 
Citrix

Installing and publishing Dragon on the Citrix server Installing and publishing 
Dragon on the Citrix 
server

Creating the two Citrix policies needed before Dragon 
users can access Dragon from their desktops.

Creating Policies for 
Dragon on the Citrix 
server

Using Dragon published on a Citrix Presentation Server 
with another published application like Microsoft Word. 

Making Published 
Applications Work 
together

Setting Up the Program Neighborhood on Citrix clients. 
This includes:

• Enabling sound quality on the client

• Installing the Citrix Client Update

Setting Up the Program 
Neighborhood on Citrix 
clients

Using a Wyse thin computing device running Microsoft 
Windows XPe to dictate using Dragon

Running Dragon on a 
Winterm device

Sizing and performance information

For sizing and performance information for running Dragon in a Citrix environment, 
please see:

http://www.nuance.com/naturallyspeaking/citrix

Sizing and configuring environment for Dragon in Citrix

Organizations considering deployments of Dragon in a Citrix environment need to 
consider several items for configuring the Citrix environment and scaling client usage 
on Citrix servers. 

This section provides some basic guidelines on how to address these issues to ensure 
maximum performance. 

Note: These are guidelines only and not definitive specifications — actual 
performance will vary from site to site.
2
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Projected User Base

Before considering any deployment of Dragon in Citrix, organizations need to answer 
key questions about the user base and potential growth. These metrics are essential 
since they are needed to size the appropriate network and hardware requirements.

• How many users do you plan to enable access to Dragon through a Citrix environment 
in the first 6 months? 12 months?

• What is the projected distribution of simultaneous user access to Dragon in a Citrix 
environment?

• Where will these users be physically distributed? On the same corporate LAN, WAN, 
remote access, or a combination?

Server-Side Hardware

Dragon Version 10 has been tested to run in a Citrix enterprise environment configured 
with Citrix Presentation Server 4.0, and clients running Citrix ICA thin-client software. 

Based on answers to the questions above, your organization will need to scale and 
deploy an appropriate number of Windows servers to run Citrix Presentation Server 4.0 
to support all your Dragon users.

Network bandwidth

The request for network bandwidth when running Dragon derives primarily from 
requests issued on the virtual audio channel. Nuance recommends and checks for use 
of the high-quality sound on Citrix to ensure the highest quality of accuracy for speech 
recognition.

Based on the user population you intend to serve, you must account for and allocate 
the appropriate amount of network bandwidth for users to be able to utilize Dragon 
Version 10 from a Citrix client.

Test Results of Running Dragon 10 in Citrix 

Listed below are the results of Nuance’s internal testing of Dragon Version 10 in a Citrix 
environment. The information stated here is only meant to provide guidance for setting 
up your Citrix environment—it is not a definitive specification.

Your experience using Dragon with Citrix may vary, depending on many factors that 
might not be addressed in this brief overview. This information should help you 
accurately size what is required within your Citrix environment for Dragon.

The internal Nuance testing of Dragon Version 10 with Citrix utilized the following 
components.

Server Hardware

Dell PowerEdge™ 2850:

• Processor: Dual Intel® Xeon™ single-core processor, 3.16 GHz/1MB cache, 800 MHz 
FSB

• Memory: 4GB DDR2 400 MHz (4x1GB), single ranked DIMMs

• Hard Drive: 146GB 10K RPM Ultra 320 SCSI Hard Drive

• Network Card: Dual Onboard NICs

Dell PowerEdge™ 6850:
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• Processor: Quad Intel® Xeon™ single-core processor, 3.16 GHz/1MB cache, 
Redundant

• Memory: 8GB DDR2 400 MHz (8x1GB), single ranked DIMMs

• Hard Drive:146GB 10K RPM Ultra 320 SCSI Hard Drive

• Network Card: Dual Onboard NICs

Server Software

Windows Server 2003

Published applications:

• Dragon NaturallySpeaking Professional, Dragon Medical and Legal editions, Version 
10

• Dragon Audio Client Update

• Microsoft® Outlook

• Microsoft® Word 2003

Client Software

• Citrix client user interfaces: ICA 32-bit clients, version 9.x and 10.x

• Program Neighborhood

• Program Neighborhood Agent

• Web Client

PC Client Specifications

• Dell Optiplex™ GX 620 and 745 with Windows XP

• 1024 RAM and 2 GHz CPU

• Sound card: Sound Blaster Live! and on-board sound systems. USB headsets, line-in 
microphones, and 
(Dragon Medical only) PowerMic II with button support. 

Network Specifications

Network speed: 100 Mbps Fast Ethernet

• Network environment and active software run on the server:

• Latest Citrix Presentation Server 4.0 and 4.5

• Citrix tools for CPU and memory management were activated to optimize server 
performance.

A sound card might be necessary for certain server installations.

Note: no additional high-memory or CPU-consuming applications were active during 
testing

Network Specifications

Network speed: 100 Mbps Fast Ethernet
4
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CPU Consumption and Memory Usage Running Dragon Professional 10

The following tables show the CPU time and memory usage observed on the Citrix 
servers with Dragon Version 10 running. The CPU time represents the total time 
(expressed as a percentage) used by a single client session; the percentage is a total 
of available CPU. Memory usage is also represented for a single-user session as a 
percentage of total RAM available.

This information stated is meant only to provide guidance for setting up your Citrix 
environment—it is not a definitive specification.

Notes: 
• Peak CPU consumption is reached when Dragon user profiles are being opened, 

saved, and closed.

• Acoustic training appears to consume the most amount of CPU time for any process 
executed with Dragon on Citrix. As such, administrative procedures that run any 
training process need to take this into consideration.

When other applications are running concurrently with Dragon:

• Dragon consumes the same amount of CPU time as it does when it runs alone

CPU consumption, with one user dictating and correcting in the 
DragonPad

 Average Peak

CPU time (Dual 
processor)

10% 25%

CPU time (Quad 
processor)

5% 13%

CPU consumption, performing General Training in New User Wizard, 
Additional Training or running the Acoustic Optimizer

 Average Peak

CPU time (Dual 
processor)

25% 30%

CPU time (Quad 
processor)

12% 18%

Memory consumption, with one user dictating and correcting in the 
DragonPad Average

 Average Peak

RAM required for both 
Dual and Quad processor

130 MB 160 MB

Memory consumption, with one user dictating and correcting in the 
DragonPad Average

 Average Peak

RAM required for both 
Dual and Quad processors

130 MB 160 MB 
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• Memory usage for Dragon Version 10 increases

For example, memory usage for Dragon 10 goes up when running together with 
Microsoft Word 2003.

 Average Peak

RAM required for a single session,  
Dragon 10/Microsoft Word 2003

160 MB 190 MB

When Dragon Version 10 is not being used:

• CPU time consumed is 0.

• The same amount of RAM is required.

• Network bandwidth is 1.3 Mbps if the microphone is active; 0 Mbps if the microphone 
is turned off.

Initial Results—Network Bandwidth

Network bandwidth setting for a single Dragon Citrix client MUST be at least 1.3 Mbps.

NOTE: If the microphone is turned off for an active Dragon session running on Citrix, 
network bandwidth on a channel drops almost to 0.

Summary

Based on the preceding observations made while testing a single Dragon Version 10 
session running on Citrix, it is reasonable to conclude that deployment of Dragon 
Version 10 will scale linearly in a Citrix Presentation Server environment. CPU 
consumption emerges as the most important limiting factor, as collective CPU time per 
session will determine how many Dragon Version 10 sessions can be active at the same 
time.

Using the hardware and software configurations detailed above, here is the 
approximate range of Dragon Version 10 sessions that can be expected to run on the 
Citrix Presentation Server 4.0:

• Maximum Load: In a realistic scenario, where multiple sessions are performing 
different types of activities (opening, saving and closing users, dictating, and 
correcting dictation), it can be expected that 6 concurrent Dragon Version 10/Citrix 
sessions can be executed.

• Minimum Load: Expect to run 4 concurrent Dragon Version 10/Citrix sessions in the 
case when all Dragon sessions are running acoustic training.

Installing and publishing Dragon on the Citrix server

Dragon NaturallySpeaking and Dragon Medical include support for deploying and 
running Dragon in a Citrix environment.

Dragon can be run through the Citrix Webclient, Program Neighborhood Agent, and/or 
the Program Neighborhood. 
6
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Requirements

Server:

Citrix Presentation Server 3.0 or 4.0 (Enterprise and Advanced Editions). 

Note: Standard Edition is not supported. 

Please check http://www.citrix.com to download the latest patches.

Client:

Citrix ICA clients 8.x or 9.x

Note: The Citrix client must be running Windows 2000 Service Pack 4 or higher, 
Windows XP Professional, or Windows XP Home (with SP1 or SP2).

Installing and publishing Dragon on the Citrix server

1. Install Dragon as you normally would other applications that you make available on 
the Citrix server, noting the installation directory. 

2. Publish Dragon as follows: 

• If you installed Dragon, you must publish it as an Application: 
 

 
 
When publishing Dragon from the Presentation Server Console, use 
natspeak.exe as the Dragon executable. By default the Dragon applications are 
installed to:  
\Program Files\Nuance\NaturallySpeaking10\Program 
 
For example: 
 

• If you installed the Dragon SDK Client Edition, you must publish the SDK as a 
Desktop from the Citrix Presentation Server Console in order to view and run 
the sample programs from a client. 
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3. In the Specify Client Requirements dialog box, check the Enable legacy audio 
setting. For example, if you are using the Program Neighborhood: 
 

4. Publish the Dragon Citrix Client Update as Content: 
 

 
 
When publishing the Dragon Citrix Client Update from the Presentation Server 
Console, use vddnspatch.exe as the Citrix Client Update executable. For 
example: 
 

Notes: 

• You must install this Client Update directly on each client computer. For more 
information, see Setting Up the Program Neighborhood on Citrix clients.

• You must have administrator rights to install the Citrix Client Update.

• You do not need to re-install the Citrix Client Update if was already installed 
as part of an MSI installation. See Installing the Citrix Client update for an MSI 
installation for more information.

Creating Policies for Dragon on the Citrix server

You must create two policies for Dragon before users can access Dragon 
NaturallySpeaking or Dragon Medical from their desktops.

Create the AudioIn policy 

1. From the Presentation Server Console, select Policies and click the Create 
Policy button (or select Actions > Policy > Create Policy from the menu) to create 
a policy named AudioIn.

2. Select the AudioIn policy and then click the Properties button (or select Actions > 
Properties from the menu) to set the properties. Use the Properties dialog to 
enable Microphones so the client’s microphones can be used for audio input. For 
example: 
 

8
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3. Select the AudioIn policy and then click the Apply this policy to button (or select 
Actions > Policy >Apply this policy… from the menu) to specify which users can 
use the AudioIn policy (in other words, all users who will use Dragon). This displays 
the Policy Filters for the AudioIn Policy – select Users and grant access to the 
appropriate users.

Create the AudioOut policy 

1. From the Management Console, select Policies and click the Create Policy… 
button (or select Actions > Policy > Create Policy from the menu) to create a 
second policy named AudioOut.

2. Select the AudioOut policy and then click the Properties button to set the 
properties to enable the Sound Quality and set the client audio quality to High 
sound quality; lowest performance. For example: 
 

3. Select the AudioOut policy and then click the Apply this policy to button (or select 
Actions > Policy > Apply this policy… from the menu) to specify which users can 
use the AudioOut policy (in other words, all users who need access to Dragon). This 
displays the Policy Filters for the AudioOut Policy – select Users and grant access 
to the appropriate users. 
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Making Published Applications Work together

To be able to use a published Dragon with another published application like Microsoft 
Word in a Citrix environment, both applications must be running in a single Citrix client 
session. 

Use the following guidelines to make sure all published applications work together.

For the Administrator

Give users access to applications

There are two ways to give users access to applications:

1. Publish the desktop and let users start applications from the published desktop.

2. Publish all needed applications with identical settings. If the settings are not identical, 
Dragon may not operate correctly in other published applications. For example, if 
Microsoft Word is published with different settings than the published Dragon, the 
microphone hotkey will not work in Word. 

For the Client

If you published separate applications and not a Desktop, use the following guidelines:

1. All applications must be started in Seamless mode.

2. Don’t change Application Set settings when a published application is running.

3. When using the Smooth Roaming feature with published applications on multiple 
computers, the user must do one of the following: 

• Close all published applications before moving to a new location.

• Start the same published applications in the same order on all the machines that 
are used. If a user left a running published application on one machine and moved 
to another one, the user should start the same published application on the next 
machine. In this case, the user will connect to the already running application. For 
example, if the use left published Word running on one computer, moved to 
another computer, started published Dragon and then Word, dictation in Word 
won’t work because Dragon is running in a new session. In this particular case, the 
user should first start Word and then Dragon.

Notes

• Citrix starts two published applications in separate sessions for single user when: 

1. The applications are published with different settings (Colors, Enable Legacy 
Audio, Encryption). Citrix places applications into isolated Windows sessions 
if the color settings are different. Using different color settings may cause 
problems with dictation. If you have problems with applications with different 
color settings, use the same color settings for all applications.

2. Any single application is published as a Desktop.

3. The client does not start the application in Seamless mode. 
0
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4. A client launches one application, changes Application Set settings, and then 
launches another application.

5. A user starts different applications from different machines. If the user starts 
the same application from a different machine, it connects to the same session 
and disconnects the previous session, as in Smooth Roaming feature.

Setting Up the Program Neighborhood on Citrix clients

After publishing Dragon and the Citrix Client Update, the Citrix ICA clients should see 
both programs in their Citrix Program Neighborhood (or Web Client interface). For 
example:

Note: When you start Dragon from the client, you should change the DragonBar mode 
to Floating mode to minimize any problems you may have in displaying any other 
applications you run from the server.

Enabling sound quality on the client 

Before starting Dragon as a published application, you must enable sound on the client 
for the application set for Dragon on each Citrix client.

1. From the Citrix Program Neighborhood, select the Application Set that contains 
Dragon and the Citrix Client Update.

2. From this Application Set click the Settings button . 
 
The Settings dialog for the selected application set displays.

3. Select the Default Options tab and unselect the Sound Server Default check box; 
then select the Enable Sound check box.

4.  In the drop-down list select High sound quality. For example: 
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Note:

Using the Web Client Interface: If Dragon is published with the Audio quality set to 
low on the server but with the Audio quality set to high on the client through the 
Program Neighborhood, the client will not receive an Audio Quality warning when 
Dragon is started through the Web Client Interface.

Installing the Citrix Client Update

If you intend to dictate from the Citrix client, you must run the Citrix Client Update 
before you run Dragon for the first time.

Note: about Winterm

1. Double-click the Citrix Client Update icon in the Program Neighborhood 

  
 
This starts the Citrix Client Update installer wizard.

2. When prompted, click Next and then Patch. Clicking Patch starts the installation.

3. When the installation completes, click Finish.

After installing the Citrix Client Update, you can start Dragon to create your users.

Notes

• You must have administrator rights to install the Citrix Client Update. 
You do not need to re-install the Citrix Client Update if was installed earlier as part of 
an MSI installation. See Installing the Citrix Client update for an MSI installation for 
more information.

• In order to run the Citrix Client Update, each client machine must be joined to the 
network domain of the Citrix server. In other words, the Citrix server must be able 
to recognize the client’s Windows logon credentials. If the client is not joined to 
network domain of the Citrix server, you will see the following error when trying to 
2
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run the Citrix Client Update: 

 
 
If this is a problem, you can still use network resources by entering your domain user 
name and password. Before running the Citrix Client Update: 

1. From the Windows Explorer, click on the Tools menu and then click Map 
Network Drive. 

2. In Drive, type or select the drive letter to map to the shared resource. 

3. In Folder, type the server and optionally, the share name of the resource, in 
the form of \\server name\share name. You can also click Browse to locate 
the resource. 

4. Click Finish. 

5. In the User name and password dialog box, type your user name in the form 
of domain\user name. 

6. In Password, type your domain password.

• If during the installation of Citrix Client Update you see the following error 
message: 
 
Unable to set High Sound Quality in your Citrix client. It is recommended that 
you do this manually 
 
Please double-check that the Audio settings on your client are set to high. 
For more information, see Setting up Citrix Clients. 

• If you are using a Phillips SpeechMike, set up your system so that sound 
playback is through a different device and not the SpeechMike. To do this, 
select Sound and Audio Devices from the Windows control panel and use 
the Audio tab to set your Sound playback and Sound recording devices.

• There must be sound system installed on the client. For example, if your 
client has disabled USB audio, you cannot create a Dragon user. If you 
disable USB audio, enable it and re-connect to the Citrix server.

Running Dragon on a Winterm device

If you want to dictate with Dragon NaturallySpeaking or Dragon Medical on a Wyse thin 
computing device (Winterm) running Microsoft Windows XP Embedded (XPe), you must 
run the Citrix Client Update on that device before you run Dragon for the first time.

Note: This procedure has only been tested with the Wyse S90 with native support for 
ICA client 9.x.

To prepare a WinTerm device for Dragon in a Citrix environment, please follow these 
steps: 

1. Log into the Wyse thin computing device as an Administrator 
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2. From the Administrator account, disable the Enhanced Write Filter (EWF).  
 
You can disable the EWF from the Administrator desktop or the DOS command line. 
 
You need to disable the EWF because it blocks write operations on the flash memory 
itself needed to install the Dragon Citrix Client update. 

3.  Open the Citrix Program Neighborhood, enable sound on the client for the application 
set for Dragon. 
 
For more information, see Setting Up the Program Neighborhood on Citrix clients. 

4. From the Wyse thin computing device, map a network drive to where the Dragon 
audio client is published as content.  
You can map the network drive using the Windows Explorer or from the DOS 
Command Prompt. For example: 
 
net use * \\server_name\c$ /user:domain_name\user_name * /persistent=no

5. Install the Dragon audio client by double-clicking the Citrix Client Update icon in the 
Program Neighborhood and following the Citrix Client Update installer wizard 
prompts.

6. If needed, log out of the Administrator account 

After installing the Citrix Client Update, you can start Dragon to create your users. 

Notes

• After installation, the Dragon Citrix Client Update takes up approximately 118 KB 
of flash memory on the Winterm device.

• If you get a "Sound level is too low" error while creating a Dragon user on the 
Winterm Device, you will need to manually boost the microphone’s volume. To 
manually boost the microphone’s volume:

1. Select Start> Control Pane l> Sound and Audio Device (Windows XP) or 
Sound (Windows Vista)

2. Select

• Windows XP: Audio tab

• Windows Vista: Recording tab. 

3. Boost the microphone volume by:

• Windows XP: double-clicking the Volume button under Sound recording. 
This action displays the microphone slider; move the slider all the way to the 
right to set the maximum boost. If you see a Boost check box, select the 
check box.

• Windows Vista: double-clicking the Microphone icon to display the 
Microphone Properties dialog (depending on your sound card and 
microphone, you set the boost from the Levels or Custom tab). If you see 
a slider to set the boost, move the slider all the way to the right to set the 
maximum boost. If you see a Boost check box, select the check box. 
4
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Disabling or redirecting Citrix Logging

When you start a Citrix ICA session, the ICA client starts and loads the module.ini 
file from the root folder of the Citrix client. This module.ini file contain a list of the 
parameters used to select and configure the communications stack modules.

To save space on the Citrix client, you can disable or redirect Citrix logging:

1. Open the module.ini file. By default, the module.ini file is located in the Citrix client 
directory: 
 
C:\Program Files\Citrix\ICA Client

2. To disable logging:

• Go to the [VDDNS] section.

• Change the line LogLevel=2 to LogLevel=0

3. To redirect logging to another location or device, locate the line that begins 
"LogFileName=" and change the path in that line.

4. Save and exit module.ini.
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Customizing Vocabularies with the Dragon 
Vocabulary Tool (Voctool)

You use the Dragon Vocabulary Tool to customize a vocabulary by adding new words 
and by optimizing the language model. 

This section of the Administrator Guide Help describes the Vocabulary Tool Wizard 
and includes the following topics:

• Starting Voctool — Starting the Voctool UI and command line.

• Step 1: Selecting a user — The type of information available that can be modified on 
the introduction screen. 

• Step 2: Choosing Documents — Selecting documents for the Vocabulary Tool to 
analyze.

• Step 3: Choosing Word Lists — Selecting word lists for analysis.

• Step 4: Analysis Settings — Specify how the Dragon Vocabulary Tool will analyze 
the documents and word list files you chose.

• Step 5: Analyzing Files — Confirming the file list; stopping and resuming the analysis.

• Step 6: Previewing New Words — Reviewing new words, their frequency, etc.; 
clearing, editing, saving, and training words from the word list.

• Step 7: Training Added Words — Selecting the words to train.

• Step 8: Build the Language Model — Building a new language model with the 
information you have collected.

• Summary Page — Displaying information about the newly-built language model.

• Voctool command line switches — Lists command line switched.

Starting Voctool 

There are two ways to start Voctool:

• Click Start > All Programs > Dragon NaturallySpeaking 10 > Dragon 
NaturallySpeaking Tools > Voctool.

• You can run the Dragon Vocabulary Tool using MS-DOS commands. To view a list 
of command-line switches for running the Dragon Vocabulary Tool, type 
voctool.exe /? at the prompt inside a command-prompt window. See Voctool 
command line switches for a list of switches. By default, voctool is located in: 
C:\Program Files\Nuance\NaturallySpeaking10/Program

Notes:

When you start the Voctool, on the Introduction page of the wizard you are 
immediately prompted to select a user/vocabulary. Once you select a user, you can 
click the Change User/Vocabulary... button to change the user only before you 
proceed with running the Voctool. Do not change the current user or the vocabulary 
after you make this selection or while you are running the Dragon Vocabulary Tool. 
If you do try to change the user or vocabulary, the Dragon Vocabulary Tool will stop 
running and discard any changes.
8
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Dragon vocabulary tool overview

The Dragon Vocabulary Tool allows you to customize a vocabulary by adding new 
words and optimizing the language model.

You can find and modify the following information on the Introduction page of this 
wizard.

User

The name of the user that the Dragon Vocabulary Tool will modify.

Vocabulary

The vocabulary type applied when creating the user.

Change User/Vocabulary button

Click this button to open the Select User dialog box and choose a different user from 
among the ones that are available.

Specify what you want to do

Choose one of the two options for adding new words to the vocabulary and click Next 
to proceed.

Add new words from documents and adapt to writing style

This option instructs the Dragon Vocabulary Tool to examine documents you indicate 
in the next page of the wizard, the Choose Documents page. In general, you should 
select documents that reflect the preferred writing style and vocabulary of the person 
who will use the modified user files for dictation.

Add new words from word list files

This option instructs the Dragon Vocabulary Tool to examine files containing lists of 
words that you indicate in the next page of the wizard, the Choose Word Lists page. 
When you choose this option that the Vocabulary Tool will only add words and will 
not analyze word frequency or otherwise adapt the vocabulary to a particular writing 
style.

Notes

• Do not change the current user or the vocabulary in the middle of running the Dragon 
Vocabulary Tool. If you do try to change the user or vocabulary, the Dragon 
Vocabulary Tool will stop running and discard any changes.

• You can run the Dragon Vocabulary Tool using MS-DOS commands. To view a list 
of command-line switches for running the Dragon Vocabulary Tool, type 
voctool.exe /? inside a command-prompt window.
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Dragon Vocabulary Tool: Choosing Documents

In the Choose Documents page of the wizard you select documents for the 
Vocabulary Tool to analyze. The Vocabulary Tool pinpoints words in the documents 
that are not in the current vocabulary and analyzes the frequency and order of those 
words in the samples to better understand the writing style of the author.

You modify the list of documents on this page, then click Next to proceed with the 
wizard.

The following information and buttons appear on this page:

Documents

The list of documents. If no documents appear in the list, click the Add Folder or Add 
Document button and browse to find documents. The buttons to the right of this list 
allow you to add to and delete from the contents of the list.

Add Folder...

Click this button to open the Browse for Folder dialog box and select a folder of 
documents to display in the documents list. Click the Add Folder button as many times 
as necessary to add additional folders of documents to the list.

Add Document...

Click this button to open the Add Documents dialog box and select documents from 
a folder to display in the documents list. You can hold down the CTRL key and click 
individual document names to select multiple documents one at a time, or you can hold 
down the SHIFT key and click the first and last document names to select a range of 
documents. Click the Add Documents button as many times as necessary to select 
different documents to add to the list.

Remove Document

Select documents you want to remove from the document list, then click this button to 
remove them. You can hold down the CTRL key and click individual document names 
to select multiple documents one at a time, or you can hold down the SHIFT key and 
click the first and last document names to select a range of documents.

View Document

Select a single document to examine and click this button to open that selected 
document in the application where the document was created. For example, if the 
document has a .doc extension, it will open in Microsoft Word. If the document has a 
.txt extension, it will open in Notepad. The appropriate application must be available 
on your computer for you to view a document.

Save List...

Click this button to open the Save Document List as File dialog box, to save the 
current list of documents in a separate file in the folder of your choice. Creates a text 
0
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file (.txt extension) listing the file names, including the full path to each file. The tool 
can process these types of files:

• Microsoft Word (*.DOC)

• Corel WordPerfect (*.WPD)

• ASCII Text (*.TXT)

• Rich Text Format (*.RTF)

• HyperText (*.HTM, *.HTML, *.SHTM, and *.SHTML)

 
If your computer does not have access to an application that can open a particular 
format, the Dragon Vocabulary Tool will not be able to process that document. 

Load List...

Click this button to open the Load Document List from File dialog box, to locate and 
load a file containing a list of documents previously saved with the Save List button 
above. If the file you try to load is not an appropriate file list, an error message alerting 
you to this fact will appear, and the contents of the file will not appear in the document 
list.

Note: If you try to process documents that contain invalid characters or text that 
doesn’t reflect the writing style of the person for whom the user was created, you may 
either damage the vocabulary by filling it with improper words or decrease recognition 
accuracy by building a Language Model from examples that don’t reflect the user’s 
dictation style.

Dragon Vocabulary Tool: Choosing Word Lists

In the Choosing Word Lists page of the wizard, you select word lists for the 
Vocabulary Tool to analyze. The Vocabulary Tool determines whether or not words 
in the lists are in the current vocabulary.

A word list is an ASCII text document containing words or shorts phrases you want to 
add to the vocabulary. Each word or phrase should be on an individual line and can 
contain a spoken form separated from the written form by a backslash (\). For 
example: "& Co.\and Company"

The following information and buttons appear on this page:

Word Lists

The names of files containing word lists that you can have the Vocabulary Tool 
analyse. The buttons to the right of this list allow you to add to and delete file names.

Add Word List

Click this button to open the Add Word List Files dialog box, which you can use to 
select file names to display in the documents list. You can hold down the CTRL key and 
click individual file names to select multiple files one at a time, or you can hold down 
the SHIFT key and click the first and last file names to select a range of files. Continue 
to click the Add Word List button and select different folders from which to add 
additional file names to the documents list.
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Remove Word List

Click this button to remove selected file names from the documents list. You can hold 
down the CTRL key and click individual file names to select multiple documents one at 
a time, or you can hold down the SHIFT key and click the first and last file names to 
select a range of files.

Notes:

• Be careful to process word lists that contain only valid words or phrases. Otherwise 
you may fill the vocabulary with improper words or decrease recognition accuracy by 
building a Language Model from examples that don’t reflect the user’s normal 
dictation vocabulary.

• You can create word list files from a current Dragon user with the Export Words 
dialog box on the Tools menu of the DragonBar.

Dragon Vocabulary Tool: Analyzing Settings

In the Analyze Settings page of the wizard you indicate how the Dragon Vocabulary 
Tool should analyze the documents and word list files you chose on the previous 
page(either the Choose Documents or Choose Word Lists page).

You can change the following settings:

Find unknown words

Select this option to have the Vocabulary Tool find words that are not already in the 
vocabulary. Note: This option is available only if the Vocabulary Tool is analyzing 
documents and not word lists.

Find known words with unknown capitalization

Select this option to have the Vocabulary Tool find words that are already in the 
vocabulary but with a different capitalization.

Enable word frequency counting

This options displays only when you have selected Add new words from documents.

Enabling word frequency counts how many times a new words appears in your 
documents and displays that number in the wizard after the documents have been 
analyzed. The maximum number displayed in 100. 

Note: If you are analyzing a large sets of text, you should disable frequency counting 
to improve performance. 

Preview the list of unknown words

Select this option to have the Vocabulary Tool open the Preview New Words page to 
display the unknown words and/or the known words with unique capitalization. 
A Preview New Words page appears where you can modify the list and select specific 
words that the Vocabulary Tool found.
2
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Add all unknown words without previewing them

Select this option to have the Vocabulary Tool skip the Preview New Words page. 
The Vocabulary Tool will add all the unknown words and/or the known words with 
unique capitalization to the vocabulary without letting you modify the list.

Note: Use the Find known words with unknown capitalization option only with 
word lists that you are sure you want to add to the vocabulary. Otherwise you 
might add words to the vocabulary unintentionally.

Dragon Vocabulary Tool: Analyzing Files

In the Analyzing Files page of the wizard, the Dragon Vocabulary Tool analyzes the 
documents and word list files you chose in the Choose Documents page or the Choose 
Word Lists page.

This page displays the following information and button:

File list

The file list is a scrolling list of the files or documents that the Vocabulary Tool is 
processing. A check mark next to the file name indicates that Vocabulary Tool has 
completed analyzing that file. An X mark indicates that the Vocabulary Tool has not 
successfully completed analyzing the file, either because the analysis was interrupted 
by the Stop button, or because an error occurred while reading the contents of the file. 
An hourglass symbol appears next to the name of the file that Vocabulary Tool is 
currently analyzing. 

When the process completes, a message appears below the document list stating how 
many documents were analyzed and prompting you to click Next to proceed.

Stop/Resume

Click Stop to end the analysis. Click Resume to restart the analysis.

Progress bar

The progress bar indicates how much of the current file has been analyzed.

Dragon Vocabulary Tool: Previewing New Words

In the Preview New Words page of the wizard, you can view the list of words that 
the Vocabulary Tool identified as either not being in the current vocabulary or as 
having a unique capitalization.

The following information and buttons appear on this page:

Word

You can scroll the Word list and use the check box to the left of the word to choose 
whether or not to add the word to the vocabulary. A check mark indicates that the word 
will be added. Removing the check mark indicates that the word will not be added.
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Frequency

Frequency indicates how many times the word appears in the analyzed documents. This 
information appears only if you selected the Enable word frequency counting option 
on the Introduction page of the wizard. The maximum number displayed is 100. 

Check All

Click this button to check all the words in the Word list.

Clear All

Click this button to clear all the words in the Word list.

Edit

Select a word in the list and click this button to open the Edit Word dialog box. In this 
dialog box you can change both the written form and spoken form of the selected word. 
The Edit Word dialog box also displays the context and frequency with which the word 
appears in the analyzed document.

Save

Click this button to open the Windows Save As dialog box and save the contents of the 
Word list as a file. Use the dialog box to provide a name and a location for this file. You 
can use this file with the Vocabulary Tool at a later time to modify the vocabulary of 
other users.

Train added words

Select this option to open the Train Added Words page of the Vocabulary Tool where 
you can train selected words so that Dragon can better recognize your pronunciation.

The Train added words feature is available only when you run the Dragon 
Vocabulary Tool as part of a normal installation of Dragon. You cannot train words 
using the Vocabulary Tool if you are running the Dragon DSS SDK edition.

Dragon Vocabulary Tool: Training Added Words

In the Training Added Words page of the wizard, you can train Dragon to better 
recognize your pronunciation.

This feature is available only when you run the Dragon Vocabulary Tool as part of a 
normal installation of Dragon. You cannot train words using the Vocabulary Tool if you 
are running the Dragon SDK Server Edition (DSS).

The following information and buttons appear on this screen:

Word

The Word list contains the words you selected on the Preview New Words screen. 
Select the words you want to train from this list. A check mark in the box to the left of 
4
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the word indicates that you want to train that word.

Check All

Click this button to select all the words in the Word list.

Clear All

Click this button to deselect all the words in the Word list.

Train

Click this button to open the Train dialog box where you can train Dragon to recognize 
your pronunciation of the words you selected. If you have selected more than one word 
to train, the Train dialog box shows them to you in the order that they appear in the 
list.

Note: Only the person who will be dictating with the user you are modifying can 
perform the training. If that person is unavailable for this Vocabulary Tool session, 
then training can also occur during a Dragon session by clicking Train from the Words 
menu on the DragonBar.

Dragon Vocabulary Tool: Language Model Build Settings

In the Language Model Build Settings page of the wizard you tell the Vocabulary 
Tool to build a new language model with the information that it has gathered in the 
preceding steps. You also provide the location and maximum size of the new 
vocabulary. 

You can specify the following settings:

Build language model

If you select this option, the Vocabulary Tool will build a new language model 
containing the words and other information it has gathered in preceding pages.

Language Model locator

If you are building a language model for a Solution Series version of Dragon you can 
select either the Middle or the User slot as a location. If you are building a language 
model for a Preferred version of Dragon you can select only the User slot as a location.

Language model size limit (Solution Series or SDK Server Edition only)

If you build the Language Model into the Middle slot, you can also limit the size of the 
model. You can specify a limit between 0.5 MB and 5 MB. If you don’t want to set a limit 
select Unspecified from the list.

Existing Model built by:

The version of the Dragon Vocabulary Builder that created the previous Language 
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Model. This information only appears if the user you are building a language model for 
has an existing language model.

Preserve existing model

This option appears only if the user who you are building a language model for has an 
existing language model. Selecting Yes merges the new language model with the 
current one. Selecting No builds a new language model to replace the existing one. 
Normally, you should accept the recommended value, which varies based on the 
language model location and the version of Dragon. The recommendations for the 
Solution Series and Preferred editions are:

• For Dragon NaturallySpeaking Solution Series, middle slot, the recommendation is 
No.

• For Dragon NaturallySpeaking Solution Series, user slot, the recommendation is Yes.

• For Dragon NaturallySpeaking Preferred, user slot, the recommendation is Yes.

You cannot build a language model in the middle slot of Dragon NaturallySpeaking 
Preferred edition.

Dragon Vocabulary Tool: Summary Page

The Summary page of the Vocabulary Tool wizard displays information about the 
newly built language model. After you review the information on this page, click Finish 
to exit the wizard.

Details

The details box contains following information:

User

The name of the user whose user files Vocabulary Tool modified.

Vocabulary

The base vocabulary type of the user.

Language

The language of the vocabulary, including any specific variation of that language, 
such as United States English or Southeast Asian English.

Additional information

The following information may also appear: 

• The number of documents analyzed.

• The names of the documents or word lists that were processed.

• The number of unknown words that were found.

• The number of added words.

• Whether the Vocabulary Tool saved the previous language model or built a new 
language model, and if it did, which language model location was used.
6
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• Any warnings or any non-critical errors that might have occurred during 
processing

Save speech files

Select this option to save the new speech file so that it is available for future Dragon 
sessions.

Voctool command line switches 

When you start the Voctool from the command line, you first switch to the follow 
directory:

C:\Program Files\Nuance\NaturallySpeaking10/Program

Then enter the following syntax:

voctool.exe switches

where the switches are one or more of the following, some required in combination:

Switch Required with /S Purpose

/S NA  Silent mode. No GUI 
displays and no messages 
display on the screen while 
the voctool runs.

/U <user> Yes. User name to indicate the 
user whose vocabulary you 
are running the tool on 
(required with /S).

/V <vocabulary> Yes, for an existing 
vocabulary.

Vocabulary name. Required 
if the vocabulary exists; 
otherwise, /VN is required to 
create a new vocabulary.

/VN <vocabulary> Yes, if vocabulary doesn’t yet 
exist.

Create new vocabulary if one 
doesn’t yet exist for this 
user. The empty vocabulary 
will be used as the base 
vocabulary. Required if the 
vocabulary does not yet 
exist; otherwise, if the 
vocabulary exists, /V is 
required to use the current 
vocabulary name. If you are 
using a version of Dragon 
that does not have base 
vocabularies, you must 
include /VB to indicate the 
base vocabulary alongside /
VN.
147



14

Dragon®  Medical Installation and Administration Guide
/VB <base vocabulary> No. Use in conjunction with /VN 
to indicate the name of the 
base vocabulary.

<doc file> Yes, either this doc,/WI with 
a word list, or /WLI with a list 
of word lists.

 Input document.

/DI <doc list file> No. Input document list. Lists 
documents to garner words 
from for the vocabulary.

/DO <doc list file> No.  Output document list. Lists 
documents to export words 
from the vocabulary to.

/WI <word list file> Yes, either this option, <doc 
file>, or /WLI with a list of 
word lists.

Input predefined word list.

/WLI <wordlists list file> Yes, either this option, <doc 
file>, or /WI with a list of 
words.

Input file listing predefined 
word lists.

/WO <word list file> No.  Output list of added /new 
words in the vocabulary to 
the file indicated.

/WLO <word list file> No.  Output list of added words 
from both predefined word 
lists and documents along 
with word frequency.

/AW[C][<n>] No. Add unknown words to 
vocabulary:

C=Also add known words 
with unknown 
capitalization. 
n=Minimum frequency of 
usage in documents to be 
applied. If the minimum is 
met, add that word to the 
vocabulary.

/LM- No. (with minus sign) Do not 
build language model

/LM[M|U][N|I] No. Build language model: 

M=Middle Slot* (default)

U=User Slot*

N=Non-incremental 
(default)

I=Incremental

/LMSIZE <size> No. Middle Slot* language model 
size (0.5, 1, 2, 3[default], 4, 
or 5).*

Switch Required with /S Purpose
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*For more information on language model slots, refer to Definition: About language 
model slots.

To see some examples of running voctool.exe on the command line, refer to Voctool 
command line examples.

Voctool command line examples

Examples of using the Voctool from the command line are show below.

Example 1

To use Voctool to add a set of new words to the General vocabulary of a user named 
Katarina Phelps, you would first copy the file of words (NewWords.txt) to the 
Program Files\Nuance\NaturallySpeaking10\Program directory, then enter the 
following on the command line:

voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt  
/AW /Summary voc_actions.txt

The /AW option is required to add the new "unknown" words to the vocabulary.

A summary of the actions taken appears in the voc_actions.txt file: 

Dragon Vocabulary Tool Version x.xx 
 
User:______________Katarina Phelps 
Vocabulary:________General - Large 
Language:__________0x409 - English (United States) 
 
Processed 1 word list file(s): 
________NewWords.txt 
 
7 unknown word(s) found. 
7 word(s) added. 
 
Language model was not built. 
No errors occurred. 
No warnings occurred.

Example 2

To take all of the actions you took in Example 1 but to also build the language model, 
taking into account the new words, you would add another option to the command 
line—/LM. To indicate you want the language model to be stored in the Middle slot, 
you would add M after /LM; to store it in the User slot, you would add U after /LM. In 
addition. you could indicate whether you want the language model to include all 
previous changes (called non-incremental) by adding an N after /LM or have the 
language model include only the most recent changes (called incremental) by adding 

/NS No. Do not save changes to the 
vocabulary. Applies only in 
Silent mode.

/Summary <file> No.  Write summary of session 
actions to file.

/? No.  Displays this list of options.

Switch Required with /S Purpose
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an I after /LM. If you include /LM on the command line and do not indicate the 
particular slot to build the model in or what type of build to do, Voctool builds the 
language model non-incrementally and stores it in the Middle slot.

To build the language model in an incremental fashion and store it in the User slot, 
enter:

voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt  
/AW /LM U I /Summary voc_actions.txt

Example 3

To use Voctool to add a list of drug names to the vocabulary of a medical provider 
named Jackson Stone, you would first copy the file of drug names (DrugNames.txt) 
to the Program Files\Nuance\NaturallySpeaking10\Program directory, then 
enter the following on the command line:

voctool.exe /S /U "Jackson Stone" /V "Internal Medicine - Large" 
 /WI DrugNames.txt /AW /Summary actions.txt

Be sure to use the full name of the vocabulary, including "- Large" in this case. 

A summary of the actions taken appears in the actions.txt file:

Dragon Vocabulary Tool Version x.xx 
 
User:______________Jackson Stone 
Vocabulary:________Internal Medicine - Large 
Language:__________0x409 - English (United States) 
 
Processed 1 word list file(s): 
________DrugNames.txt 
 
7 unknown word(s) found. 
7 word(s) added. 
 
Language model was not built. 
No errors occurred. 
No warnings occurred.

Definition: The language model

In addition to a word list, a vocabulary has a language model that contains statistical 
information. Those statistics predicts which words are most likely to occur in the 
context of the user’s speech. This information includes:

• unigram probability of each word — Likelihood of this word being used in text 
compared with other words in the same vocabulary. For example, if the verb ?write? 
is more likely to occur in text compared with the name ?Wright,? then ?write? will 
have a higher unigram probability.

• Bigram and trigram probabilities — Likelihood of two-word or three-word 
sequences occurring in text. For example, if the bigram ?Mr. Wright? is more likely 
than ?Mr. write,? the language model should favor Mr. Wright even though 
?write? has a higher unigram probability than ?Wright.? In this context the bigram/
trigram probability outweighs the unigram probability.

Definition: About language model slots

Every vocabulary has three slots for storing language model information, although 
not all vocabularies necessarily contain information in each slot.
0



Customizing Vocabularies with the Dragon® Vocabulary Tool
• base slot — Stores the base language model that ships with Dragon. You cannot 
modify the information in the base slot.

• middle slot — Can contain a custom language model based on a significant amount 
of data, developed for a target group of users. The only way you can modify the 
custom slot is by using the Dragon Vocabulary Tool.

• user slot — Can contain a language model based on a relatively small amount of 
data for use by at most a few users. Individual users can modify the user slot using 
the Vocabulary Builder feature of Dragon. You can also modify the user slot using 
Dragon Vocabulary Tool.

 Only Dragon NaturallySpeaking Professional editions can use vocabularies with a 
middle slot language model that has been modified in the Vocabulary Tool.

Both SDK Client and SDK Server editions can use the Dragon Vocabulary Tool 
to modify middle slot language models.
151



15

Dragon®  Medical Installation and Administration Guide
2



   
 
 
 
 
 
 
 
 
 
Chapter 6 
 

Adding Words, Commands, and 
Vocabularies to User Files 
153



15

Dragon®  Medical Installation and Administration Guide
Overview of Adding Words, Commands, or 
Vocabularies to User Files

You use the nsadmin command line utility or the Dragon Data Distribution Tool 
when you want to make new words, customized vocabularies, or new commands 
available to all users on a particular Dragon installation:

• Dragon Data Distribution Tool: Use Data Distribution Tool when you want to work 
interactively. 

• nsadmin command line: Use this tool when you want to take action from the 
command line.  
 
Although the nsadmin command line performs only one operation at a time, you can 
write your own batch file or script to execute multiple nsadmin operations on each 
computer.

Both the nsadmin and Data Distribution Tool can work across a network.

Note: Nsadmin and the Dragon Data Distribution tool are not supported for Dragon 
Medical Small Practice Edition.

Note: If you want to customize a vocabulary by adding new words or optimizing the 
language model for a particular user profile, see the Voctool Help.

Using the Dragon Data Distribution Tool

The Dragon Data Distribution Tool lets you interactively make new words, 
customized vocabularies, or custom commands and make them available to all users 
on a particular Dragon installation. 

Run the Data Distribution Tool on each Dragon installation where you want the new 
words or vocabularies to be available to your Dragon users.

This section describes: 

• Creating Data Distribution Directory

• Using the Data Distribution Tool

• Adding Custom Words

• Adding and Deleting Custom Vocabularies

• Adding Custom Commands

You can also run nsadmin from the command line. For more information, see Nsadmin 
command line.

Note: The Dragon Data Distribution Tool only runs on Dragon Professional, Medical, 
and higher editions. 

Creating Data Distribution Directory

You create a data distribution directory where you place word lists and/or commands 
to be distributed to multiple Dragon NaturallySpeaking or Dragon Medical users. 

Once words and commands are in this directory, no matter where the user 
4
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subsequently dictates, as soon as that person opens his or her user files, Dragon 
automatically imports words and commands into that set of user files.

This topic explains how to create the data distribution directory. Subsequent topics 
explain how to use the Data Distribution Tool to put new words and commands into 
that directory for distribution.

Note: After a default installation, custom words for existing Dragon users are located 
in: \Documents and Settings\All Users\Application Data\Nuance\Dragon 
NaturallySpeaking10\custom

To create a data distribution directory in a location other than the default:

1. Close all open users in Dragon.

2. Create a directory on the network and give all users who are dictating with Dragon 
access to the directory. Set the permissions so that providers who dictate can read it 
and only administrators can write to the directory.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. 
The Administrative Settings dialog box opens and you can continue with Step 6. 

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, type 
the following command line in the Open text box, being sure to put a space between 
natspeak.exe and the option that follows it (/
SetDefaultAdministrativeOptions): 
 
C:\Program Files\Nuance\NaturallySpeaking10\Program\natspeak.exe  
/SetDefaultAdministrativeOptions 
 
(The quotation marks are required because Program Files has a space in it.Your 
path might not require quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the user opens 
automatically, click Cancel to close the user or go to the DragonBar a nd select 
NaturallySpeaking > Close User.

7. Click the Miscellaneous tab and, in the Data distribution location text box, set 
the location where you want Dragon to store custom words and commands, usually 
on a central machine. You set the location by clicking the Change... button, browsing 
for the new location, then clicking OK.

8. Click Apply to save the changes and click OK to close the dialog box.

9. Repeat these steps for each workstation that should share the distributed words or 
commands.

10.To put new words and commands into the data distribution directory, you now use 
the Data Distribution Tool, as explained in Using the Data Distribution Tool or the 
nsadmin command line utility, explained in Starting the nsadmin command line 
utility.

Using the Data Distribution Tool

You run the Data Distribution Tool on each Dragon installation where you want to 
make new words, customized vocabularies, or new commands available to all Dragon 
users. 
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Note: You can use this tool to work locally or across the network. Both mapped drives 
and UNC paths are supported for network access.

Before you use the Data Distribution Tool, you must have already created the data 
distribution directory, as explained in Creating Data Distribution Directory.

Starting the Data Distribution Tool 

To start Data Distribution Tool, select Start > All Programs > Dragon 
NaturallySpeaking > Dragon NaturallySpeaking Tools > Data Distribution Tool 

This displays the first page of the nsadmin wizard. From this page, you can:

• Add or remove base vocabularies

• Add or remove shared commands

• Add or remove word to share across vocabularies

Select an operation and click Next.

Advanced

Click the Advanced button to set the location where the local installation of Dragon 
stores customized words and commands.

For a default installation, custom commands for existing Dragon users are located in: 
\Documents and Settings\All Users\Application Data\Nuance\Dragon 
NaturallySpeaking\Custom\<language>

Data Distribution Tool: Adding and removing custom words

You can use the Data Distribution Tool to make new words available to all users on 
a particular installation. 

Note: Before you use the Data Distribution Tool, you must have already created a 
data distribution directory, as explained in Creating Data Distribution Directory.

To distribute a set of custom words (for example, a list of new drug names) to a 
particular installation, you must first either create a text file or export words from an 
existing user’s Dragon installation:

Create a Text File of New Words

• Create a text (.txt) file and enter each word or phrase you want to add to the 
vocabulary on a separate line. Make sure words are spelled correctly. Each word, 
phrase, or name that you add must be on a separate line. 
 
To add a multiple-word phrase, such as "Mayberry Tribune," enter it on one line. To 
include a spoken form for a word, type the word followed by a backslash (\) and the 
spoken form. For example, to have "Robert F. Kennedy" entered when you say "RFK" 
type Robert F. Kennedy\RFK.

Export Words from Existing Dragon Installation

If you have Dragon available on another machine, you can use it to create those words 
and export the words to a .txt file. For more information on exporting words, see the 
main Help for Dragon.
6
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Notes

• After you have imported the custom words using nsadmin, you must close your 
users, then re-open and save them for the changes to become available.

• Paths can be entered as complete local paths, relative paths, mapped network drives, 
a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. 
Pathnames that include spaces must be enclosed in quotation marks. 

Before adding the custom words

Once you have created a .txt file (newwords.txt in the following examples) containing 
the custom words:

1. If you have not already created it, create the data distribution directory as outlined 
in Creating Data Distribution Directory.

2. On each dictation computer, map a network drive to the location of the data 
distribution directory you created or reference the network UNC address of the 
location in the nsadmin program.

3. Start the Data Distribution Tool (see Using the Data Distribution Tool).

4. Make the appropriate selections in the tool to add the list of words to the data 
distribution directory, as outlined in Adding custom words below. This process copies 
the .txt file to that shared location.

Adding custom words 

To add custom words once the Data Distribution Tool opens:

1. Select Add or remove words to share across vocabularies from the Data 
Distribution Tool.

2. (optional) If you want to change the location of the custom words on the local 
machine, click Advanced and enter the path to the location where you want the 
custom words stored on the local machine in the Custom directory text box of the 
Advanced Settings dialog box. If you do not take this step, the files are stored in 
the default location.

3. Click Next.

4. Select the language of the user files that will have the custom words added and click 
Next. 

5. When the list of files appears, use the Import button to select the .txt files 
containing the custom words you want to add.  
You can use the View button to view the content of the selected files. Or you can 
modify the list by clicking the Remove button to remove the selected file or clicking 
the Remove All button to remove all files listed from the data distribution directory.  
 
Note: The Remove and Remove All buttons can remove the listed files from the 
data distribution directory, but once the words have been added to the data 
distribution directory and the user has been opened, this process cannot remove the 
words from the user files.  

6. Click Next to continue. 
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7. The Data Distribution Tool displays a log of all operations it performed. 

8. Click Finish to re-display the first page of the Data Distribution Tool; or click 
Cancel to exit.

The NewWords.txt file will be copied to the following directory on each machine where 
it is run (unless you changed the location in Step 2):

\Documents and Settings\All Users\Application Data\Nuance\Dragon 
NaturallySpeaking10\Custom\enx\NewWords.txt

Note: If you add custom words to a Commands Only vocabulary, those words will not 
be retained if you upgrade the user at a later date. In general, you should not add 
custom words to a Commands Only vocabulary.

Data Distribution Tool: Adding and removing vocabularies 

You can use Data Distribution Tool to make a customized vocabulary available to all 
user profiles on a particular Dragon installation. 

For example, say you have extensively customized a vocabulary using the Voctool. 
Using the Data Distribution Tool, you can copy the user’s vocabulary and have it be 
a base vocabulary on any Dragon installation. After you add a base vocabulary to a 
Dragon installation, any users subsequently created can use that vocabulary.

Notes

• For a default installation, vocabularies for existing Dragon users are located in: 
\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\users\<user_name>\current

• Vocabulary files end with the *.voc extension.

Before adding a vocabulary

Before adding the new vocabulary with the Data Distribution Tool:

1. If you have not already created it, create the data distribution directory as outlined 
in Creating Data Distribution Directory.

2. On each dictation computer, map a network drive to the location of the data 
distribution directory you created.

3. Start the Data Distribution Tool (see Using the Data Distribution Tool).

4. Make the appropriate selections in the tool to add the vocabulary to the data 
distribution directory, as outlined in Adding a vocabulary below. This process copies 
the vocabulary to that shared location.

Adding a vocabulary

To add a new base vocabulary:

1. Select Add or remove base vocabulary from the Data Distribution Tool and click 
Next.

2. To add a Base Vocabulary, click Add. This displays the Add Base Vocabulary 
dialog.
8
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3. On the Add Base Vocabulary dialog box: 

• Give the vocabulary a name. The name should describe the content of the 
vocabulary, such as Astronomy or Marketing.

•  Select the location of the vocabulary, either a mapped drive or a UNC address.

• Give the vocabulary an unique numeric ID. Use a value greater than 9000 for the 
topic ID parameter. 

4. Click OK when you are done. 

Now, the next time you open a user, Dragon automatically updates that user’s 
vocabulary.

Adding exported vocabularies

If you used a separate installation of Dragon to create a vocabulary, you can use the 
Data Distribution Tool to distribute that vocabulary.

 An exported Dragon vocabulary is saved as a group of files. 

One of the exported files has a .top file extension, the other files have .to* file 
extensions, where * is an integer. To add an exported vocabulary to Dragon with the 
Data Distribution Tool, provide the path to the file with the .top file extension as an 
argument on the nsadmin command line.

Deleting a vocabulary

To delete a base vocabulary:

1. Select Add or remove base vocabulary from the Data Distribution Tool and click 
Next. 

2. The screen displays the existing base vocabularies by ID and username.

3. Select the vocabulary to delete.

4. Click Remove and then click Next. The Data Distribution Tool displays message 
when the vocabulary is deleted. 

5. Click Finish to close the Data Distribution Tool or click your browser’s back button 
to re-display the screen. 

Data Distribution Tool: Adding and removing custom commands 

Custom commands are voice commands that you can create and modify to enter text, 
insert graphics, or activate menus and keystrokes in any application. You can create 
these commands with the MyCommands Editor or modify them using the Command 
Browser. 

Using the Data Distribution Tool you can copy a set of custom commands you have 
created to the data distribution directory to make that set of custom commands 
available to all users at a particular Dragon installation. 

Note: Before you use the Data Distribution Tool, you must have already created a 
data distribution directory, as explained in Creating Data Distribution Directory.

Note the following when adding a custom commands:
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• For a default installation, custom commands for existing Dragon users are located in: 
\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Custom\<language>

• Once you have imported the custom commands to the Dragon installation, you must 
close your users, then re-open and save them for the changes to become available 
to those users. 

Before adding the commands

When creating commands for export: 

1. Create custom commands in Dragon.

2. Export the commands to a .dat file using the Command Browser. 

3. If you have not already created it, create the data distribution directory as outlined 
in Creating Data Distribution Directory.

4. On each dictation computer, use the Data Distribution Tool to add the .dat file to 
the data distribution directory as outlined in Adding custom commands below.

Adding custom commands 

To add custom commands:

1. Start the Data Distribution Tool (see Using the Data Distribution Tool).

2. Select Add or remove shared commands from the Data Distribution Tool and 
click Next.

3. Select the languages of the user files that will have the custom words added and click 
Next. 

4. Use the Import button to select the .DAT files containing the custom commands you 
want to add and put them into the New shared commands list in the upper half of 
the dialog box.  
You can modify the list by selecting particular file names and using the Remove and 
Remove All buttons. Click Next to continue. 

5. The Data Distribution Tool displays a log of all operations it performs. 

6. Click Finish to re-display the Data Distribution Tool main screen; or click Cancel 
to exit. 

 
The next time you open a user, Dragon updates the commands in the associated 
user files.

Removing shared commands

To remove shared commands:

1. Select Add or remove shared commands from the Data Distribution Tool and 
click Next.

2. Select the languages of the user files that will have the custom words removed and 
click Next. 

3. Select the command to remove from the Existing shared commands list and click 
0
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Remove.

4. Click Next. The Data Distribution Tool displays a log of all operations it performs. 

5. Click Finish to re-display the Data Distribution Tool main screen; or click Cancel 
to exit.

Paths

Paths can be entered as complete local paths, relative paths, mapped network drives, 
a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. 
Pathnames that include spaces must be enclosed in quotation marks.

The NewCommands.dat file is copied to: 
<drive>:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Custom\enx\NewCommands.dat

Nsadmin utility for new words, vocabularies, and commands

Note: The nsadmin command line utility runs only on Dragon Professional and 
Medical editions. 

Use nsadmin command line when you want to make new words, customized 
vocabularies or new commands available to all users on a particular Dragon installation.

The nsadmin command line performs only one operation at a time, but you can write 
a batch file or script to execute multiple nsadmin operations on each computer. 

Refer to the following sections for step-by-step instructions on using the utility: 

• Creating Data Distribution Directory

• Starting the nsadmin Command Line Utility

• Adding Custom Words

• Adding and Deleting Custom Vocabularies

• Adding Custom Commands

Alternatively, you can run nsadmin interactively by Using the Data Distribution Tool.

Creating Data Distribution Directory

You create a data distribution directory where you place word lists and/or commands 
to be distributed to multiple Dragon NaturallySpeaking or Dragon Medical users. 

Once words and commands are in this directory, no matter where the user 
subsequently dictates, as soon as that person opens his or her user files, Dragon 
automatically imports words and commands into that set of user files.

This topic explains how to create the data distribution directory. Subsequent topics 
explain how to use the Data Distribution Tool to put new words and commands into 
that directory for distribution.

Note: After a default installation, custom words for existing Dragon users are located 
in: \Documents and Settings\All Users\Application Data\Nuance\Dragon 
NaturallySpeaking10\custom

To create a data distribution directory in a location other than the default:

1. Close all open users in Dragon.
161



16

Dragon®  Medical Installation and Administration Guide
2. Create a directory on the network and give all users who are dictating with Dragon 
access to the directory. Set the permissions so that providers who dictate can read it 
and only administrators can write to the directory.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. 
The Administrative Settings dialog box opens and you can continue with Step 6. 

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, type 
the following command line in the Open text box, being sure to put a space between 
natspeak.exe and the option that follows it (/
SetDefaultAdministrativeOptions): 
 
c:\Program Files\Nuance\NaturallySpeaking10\Program\natspeak.exe  
/SetDefaultAdministrativeOptions 
 
(The quotation marks are required because Program Files has a space in it.Your 
path might not require quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the user opens 
automatically, click Cancel to close the user or go to the DragonBar a nd select 
NaturallySpeaking > Close User.

7. Click the Miscellaneous tab and, in the Data distribution location text box, set 
the location where you want Dragon to store custom words and commands, usually 
on a central machine. You set the location by clicking the Change... button, browsing 
for the new location, then clicking OK.

8. Click Apply to save the changes and click OK to close the dialog box.

9. Repeat these steps for each workstation that should share the distributed words or 
commands.

10.To put new words and commands into the data distribution directory, you now use 
the Data Distribution Tool, as explained in Using the Data Distribution Tool or the 
nsadmin command line utility, explained in Starting the nsadmin command line 
utility.

Starting the nsadmin command line utility

You run the nsadmin utility on each computer containing Dragon where you want the 
new words, vocabularies, or commands to be available.

The nsadmin program performs only one operation at a time, but you can write a batch 
file or script to execute multiple nsadmin operations on each computer. 

Note: Before you proceed, you should be sure you have created the data 
distribution directory, as outlined in Creating Data Distribution Directory.

Starting nsadmin

To start nsadmin, select Start > All Programs > Dragon NaturallySpeaking > 
Tools > NSAdmin 

nsadmin starts in a DOS window, listing the nsadmin syntax. To display the nsadmin 
syntax at any time, enter the following:
2
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>nsadmin /? 

The nsadmin.exe program is located in the \Program directory beneath the directory 
where Dragon is installed. For example, in a default installation:

C:\Program Files\Nuance\NaturallySpeaking10\Program 

Command line syntax

The nsadmin.exe program uses the following syntax.

nsadmin <operation> <parameters> [options]

Available commands and options:

Commands and 
parameters

Description

/commands <src_filename> Adds a command file to the local installation 

/words <src_filename> Adds a list of new words to the local installation

/vocabulary <src_directory> 
"<language or dialect> | 
<model name> | 
<category>" <topic ID> 

Adds a vocabulary contained in <src_directory> or an 
exported .top file to the NaturallySpeaking <language> 
using the specified <model name>, <category> and 
<topic ID>

/vocabulary delete <topic 
ID> 

Deletes the base vocabulary specified by <topic ID> 

Options  

/language enx | fra | deu | ita 
| esp | nld

Name of an installed language that you want to add 
words, commands, or a vocabulary. The default value is 
"enx."

/overwrite yes | no | ask Specifies overwrite rules if a file exists with the same 
name as the file you are attempting to add. The default 
value is ask.

/? Display the command syntax

Notes:

• Command line arguments that contain spaces must be enclosed in quotation marks.

• When you are running nsadmin from a directory other than the one it resides in, you 
must give the full path to the nsadmin.exe program on the command line. 

• You may want to write a batch file or script that executes nsadmin. When you have 
new words or vocabularies to distribute, you can place them at the network location 
defined in the script and run the script from the client machines to copy the new 
functionality to those machines.

• nsadmin supports both mapped drives and UNC paths.

nsadmin: Adding custom words

You can use nsadmin to make new words available to all users on a particular 
installation.

To distribute a set of custom words (for example, a list of new drug names) to a 
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particular installation, you must first either create a text file or export words from an 
existing user’s Dragon installation:

Create a Text File of New Words

• Create a text (.txt) file and enter each word or phrase you want to add to the 
vocabulary on a separate line. Make sure words are spelled correctly. Each word, 
phrase or name that you add must be on a separate line. 
 
To add a multiple-word phrase, such as "Mayberry Tribune," enter it on one line. To 
include a spoken form for a word, type the word followed by a backslash (\) and the 
spoken form. For example, to have "Robert F. Kennedy" entered when you say "RFK" 
type Robert F. Kennedy\RFK.

Export Words from Existing Dragon Installation

• If you have Dragon available on another machine, you can use it to create those 
words and export the words to a .txt file. For more information, see the main Dragon 
Help file.

Notes

• After you have imported the custom words using nsadmin, you must close your 
users, then re-open and save them for the changes to become available.

• Paths can be entered as complete local paths, relative paths, mapped network drives, 
a UNC path, or the path to removable media, such as a CD-ROM or ZIP drive. 
Pathnames that include spaces must be enclosed in quotation marks. 

Adding custom words 

Once you have created a .txt file (newwords.txt in the following examples) containing 
the custom words:

1. If you have not already created it, create the data distribution directory as outlined 
in Creating Data Distribution Directory. 

2. On each dictation computer, map a network drive to the location of the data 
distribution directory you created or reference the network UNC address of the 
location in the nsadmin program. 

3. On each client computer, use the following command to add the custom words 
contained in the .txt file: 
 
<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt 

The NewWords.txt file will be copied to the following directory on each machine where 
it is run: 
 
C:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Custom\enx\NewWords.txt

Now, the next time you open a user, Dragon automatically updates that user’s words 
to include the words in this file.

Example: Overwriting a custom words file

To overwrite a custom words file with the same name as the file you are adding, use 
4
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the /overwrite option:

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt /overwrite=yes

If the NewWords.txt file already exists in the \Documents and Settings\All 
Users\Application Data\Nuance\NaturallySpeaking10\Custom\enx directory, 
the new file will overwrite the existing file without prompting you.

Note: If you add custom words to a Commands Only vocabulary, those words 
will not be retained if you upgrade the user at a later date. In general, you should 
not add custom words to a Commands Only vocabulary.

nsadmin: Adding and removing custom vocabularies

You can use nsadmin to make a customized vocabulary available to all users on a 
particular Dragon installation. 

For example, say you have extensively customized a vocabulary using the Voctool. 
Using nsadmin, you can copy the user’s vocabulary and have it be a base vocabulary 
on any Dragon installation. After you add a base vocabulary to a Dragon installation, 
any users subsequently created can use that vocabulary.

Notes:

• For a default installation, vocabularies for existing Dragon users are located in: 
\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\users\<user_name>\current

• Vocabulary files end with the *.voc extension.

Adding vocabularies

1. If you have not already created it, create the data distribution directory as 
outlined in Creating Data Distribution Directory.

2. On each dictation computer, reference the network UNC address of the location 
in the nsadmin command line.

3. Start the nsadmin (see Starting the nsadmin command line utility).

4. On each dictation computer, use the following command syntax to add the 
vocabulary:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model 
name> | <category>" <topic_ID>

 This command copies the vocabulary to that data distribution location.

Now, the next time you open a user, Dragon automatically updates that user’s 
vocabularies.

Notes:

• Use the <language or dialect> parameter to link a vocabulary to a language. 
For example, US English or UK English for an English install. The language or 
dialect you enter must be present in the version of Dragon installed on the computer. 
The <model_name> represents the size of the vocabulary you are importing.

• The value you specify for the <category> parameter should describe the content of 
the vocabulary, such as Astronomy or Marketing. 
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• Use a value greater than 9000 for the topic ID parameter. 

Example

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 
9005

The contents of the myvoc directory will be copied to: 
\Documents and Settings\All Users\Application Data\Nuance\Dragon 
NaturallySpeaking9\Custom\enx\Custom9005\

 The model name, category, and ID will be added to the models.ini file.

To overwrite a vocabulary with the same name

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large | Nuance" 
9005 /overwrite=yes

If the vocabulary file already exists in \Documents and Settings\All 
Users\Application Data\Nuance\Dragon 
NaturallySpeaking9\Custom\enx\Custom9005\, Dragon overwrites it without 
prompting you. 

Adding exported vocabularies

If you used a separate installation of Dragon to create a vocabulary, you can use 
nsadmin to distribute it.

 An exported Dragon vocabulary is saved as a group of files. 

One of the exported files has a .top file extension, the other files have .to* file 
extensions, where * is an integer. To add an exported vocabulary to Dragon with 
nsadmin, provide the path to the file with the .top file extension as an argument on 
the nsadmin command line. Do NOT include the .top file extension on the command 
line. 

The following command adds the myvoc exported topic (myvoc.top) as a new base 
vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large | 
Nuance" 9005

Deleting a base vocabulary

 On each client computer, use the following command syntax to delete the vocabulary 
and the corresponding entry in models.ini: 

<PATH>\nsadmin /vocabulary delete <topic_ID>

<PATH>\nsadmin /vocabulary delete 9005 

After a base vocabulary is deleted, vocabularies based on that base vocabulary cannot 
be used. 

nsadmin: Adding custom commands

Custom commands are voice commands that you can create and modify to enter text, 
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insert graphics, or activate menus and keystrokes in any application. You can create 
these commands with the MyCommands Editor or modify them using the Command 
Browser. 

Using the nsadmin tool you can copy a set of custom commands you have created to 
the data distribution directory to make that set of custom commands available to all 
users at a particular Dragon installation. 

Note: Before you use the nsadmin utility, you must have already created a data 
distribution directory, as explained in Creating Data Distribution Directory.

Note the following when adding a custom commands:

• For a default installation, custom commands for existing Dragon users are located in: 
\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Custom\<language>

• Once you have imported the custom commands to the Dragon installation, you must 
close your users, then re-open and save them for the changes to become available 
to those users. 

Adding custom commands 

1. Create custom commands in Dragon.

2. Export the commands to a .dat file using the Command Browser. In this example, 
NewCommands.dat.

3. If you have not already created it, create the data distribution directory as outlined 
in Creating Data Distribution Directory.

4. On each dictation computer, use the following command syntax to add the custom 
commands contained in the .dat file (reference the network address of the data 
distribution directory in the command line):

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat

The next time you open a user, Dragon updates the commands in the associated user 
files.

Paths

Paths can be entered as complete local paths, relative paths, mapped network drives, 
a UNC path, or the path to removable media, such as a DVD, CD, or ZIP drive. 
Pathnames that include spaces must be enclosed in quotation marks.

To use a UNC address

<PATH>\nsadmin /commands \\HostComputer\NsAdmin\NewCommands.dat 

The NewCommands.dat file will be copied to: 
<drive>:\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Custom\enx\NewCommands.dat

To add the commands to a language other than English

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /language=fra
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The NewCommands.dat file will be copied to: 
\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Custom\fra\NewCommands.dat

To overwrite a commands file with the same name

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /overwrite=yes

If the NewCommands.dat file already exists in the \Documents and Settings\All 
Users\Application Data\Nuance\NaturallySpeaking10\Custom\enx directory, 
Dragon overwrites the old file without prompting you. 

 

8
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Maintaining Installations

There are several actions you can take to maintain your Dragon installations:

• Run the Acoustic and Language Model Optimizer and schedule the Optimizer to 
run automatically (see Using Acoustic and Language Model Optimizer and Scheduler 
Tools).

• Export user files from one machine and import them to another as outlined in 
Exporting and Importing User Files.

• Work with the Dragon.log file to determine the cause of error messages (see 
Handling Dragon Error Messages).

• Work with a Usability log file—create a usability log (DgnUsability.log) by pressing 
the Advanced button on the Data tab of the Options dialog box. For more 
information, see Working with the Usability Log.

• Work with the Dragon knowledge base as outlined under Accessing Dragon 
Knowledge Database.

• Work with the hardware compatibility list (see Hardware Compatibility List)

• Manage who has administrative privileges (see Managing Who Has Administrative 
Privileges).

Using Acoustic and Language Model Optimizer and Scheduler Tools

You run Acoustic and Language Model Optimizer Scheduler to: 

• Choose to optimize the acoustic files for the user

• Choose to optimize the language model for the user

• Schedule one or both types of optimization to occur on a particular day or time at 
particular intervals

• Enable or disable the scheduled optimizations

• Separate procedures exist for running the optimization on a Non-Roaming User (see 
Running Acoustic and Language Model Optimizer on Non-Roaming Users) or a 
Roaming User (see Running Acoustic and Language Model Optimizer on Roaming 
UsersRunning Acoustic and Language Model Optimizer on Roaming Users).

Running Acoustic and Language Model Optimizer on Non-Roaming Users

An open local user cannot run the optimizer tools on user files. Only an administrator 
can run the Acoustic and Language Model Optimizer or the associated Scheduler 
tools. You must have Windows Administrator privileges (at the operating system level) 
on the machine where you are running the Scheduler. If you want to optimize a 
Roaming User on the machine where you are running the Acoustic and Language Model 
Optimizer, disable roaming and browse to the Master Roaming User file location as if it 
were local. 

As system administrator, you are responsible for running the Acoustic and Language 
Model Optimizer on the network location of the Master Roaming Users. You can install 
Dragon on the machine where the Master Roaming User files are located or on any 
machine that has network access to the Master Roaming User files, then run the 
Scheduler. Later, any optimizations that result from running these tools are copied to 
the Local Roaming User when Dragon synchronizes it with the Master Roaming User. 
0
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You can run the Acoustic and Language Model Optimizer from the Windows Start 
menu (Select Start > All Programs > Dragon NaturallySpeaking 10 > Dragon 
NaturallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler) 
without opening a user file, or you can run it from the DragonBar using the Tools 
menu when a user file is open as indicated here. 

To run the acoustic and language model optimizers on non-roaming users: 

1. On the DragonBar, select Dragon > Open User. 

2. In the Open User dialog box, select a user to run the optimization on and click Open. 

3. On the DragonBar, select Tools > Accuracy Center. The Accuracy Center opens. 

4. Click Run the Acoustic and Language Model Optimizer. The Acoustic and Language 
Model Optimizer dialog box opens. 

5. If the user has not dictated and corrected recognized text since the last time the 
optimizer was run, you receive this message: There is no new data in the acoustic 
archive. Acoustic Optimizer does not need to be rerun. Click OK and the 
Acoustic and Language Model Optimizer opens with the 
Perform Acoustic Optimization option grayed out. 

6. Check the types of optimization you want to perform, Perform Acoustic 
Optimization (to optimize the acoustic files of the user), Perform Language 
Model Optimization (to optimize the language model of the user), or both. 

7. Click Go to start the process. The process may take some time to complete. When 
the process completes, you receive a message notifying you that it has completed.

8.  Click Done. 

9. When asked if you would like to save your user files click Yes to return to the 
Accuracy Center. Click Exit in the Accuracy Center dialog box.

Running Acoustic and Language Model Optimizer on Roaming Users

To run the Acoustic and Language Model Optimizer on Roaming Users: 

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the 
Acoustic and Language Model Optimizer.

2. Select Start > All Programs > Dragon NaturallySpeaking 10 > Dragon 
NaturallySpeaking Tools > Acoustic and Language Model Optimizer 
Scheduler. The Acoustic and Language Model Optimizer Scheduler dialog box 
opens.

3. To access the master directory of the Roaming Users you want to optimize, in the 
Acoustic and Language Model Optimizer Scheduler dialog box, select File > Set 
User Directory. The Set a Directory Containing User Files dialog box opens.

4. On the Set a Directory Containing User Files dialog box, either enter the path to 
the directory or click the Browse button and browse to the location of the Master 
Roaming Users, then click OK. If the users you want to optimize are located in 
multiple directories, you can later repeat the steps outlined here and change this 
directory to locate the additional users. 

5. In the tree of users, select the user you want to optimize. Notice that if you expand 
that user in the tree, you see one or more dictation sources under the Acoustic 
Optimization tasks in the tree. You also see the vocabulary of the user under the 
Language Model Optimization tasks. 
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OR 
 
Select File > New Task. The Windows user name and password dialog box opens. 
To set a schedule for running the Acoustic and Language Model Optimizer, either 
double-click on the dictation source or the language model under that user.

6. Before you proceed, enter your Windows user name and password. If you are logged 
in to a domain, you must insert the domain name in front of your user name; for 
example, HospitalDB\RSessions for the HospitalDB domain.

7. Click OK. The Select Frequency dialog box opens. 

8. Under Optimization, select Perform Acoustic Optimization, Perform Language 
Model Optimization, or both. 

9. Under User Information, you can either select another user from the User Name 
drop-down list or, to select multiple users, click the Multiple Users button to open 
the Select Users dialog box.

a. In the Select Users dialog box, use the Add> and <Remove buttons to put 
the users you want to run optimization on in the Selected users in this task list 
to the right. Or you can click Add All>> or <<Remove All to add or remove 
all users from the list.

b. You can also move a user up and down in the list by selecting a name and 
clicking the Move Up or Move Down button. When you are satisfied with the 
list, click OK to proceed.

10.If you selected multiple users in the previous step, skip this step. Otherwise, in the 
Dictation Source text box, select an audio input device from the drop-down list and 
in the Vocabulary text box, select a vocabulary from the drop-down list.

11.Under Select Frequency and Start Date & Time, select how often and at what 
time you want the optimization to run, as well as the first date it should run. 

12.At the bottom of the dialog, click the Enabled (schedule task runs at specified time) 
check box to enable the optimization. 

13.Click Apply to apply the changes. 

14.Click OK to close the Select Frequency dialog box. The Acoustic and Language 
Model Optimizer Scheduler dialog box displays a list of the events scheduled in the 
right pane of its dialog box. You can create more than one optimization schedule for 
a single user. When you do, both optimization events appear in the schedule list. 

15.Click Files > Exit to close the acoustic and language model optimizer scheduler

Removing One or More Optimization Schedules

To remove one or more scheduled optimizations from the scheduler:

1. Select the schedule you want to remove. You can select multiple schedules by holding 
the CTRL key while clicking a schedule. 

2. Press the Delete key on your keyboard or select Options > Delete Selected Tasks 
on the toolbar.

3. Click OK when you are asked to confirm the deletion.

OR 
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1. To remove all scheduled optimization events in the Acoustic and Language Model 
Optimizer Scheduler select Options > Delete Displayed Tasks. 

2. Click OK when you are asked to confirm the deletion. 

Alternatively, you can optimize multiple users on the same schedule by selecting all the 
users you want to share one schedule in the Select Users dialog box.

Exporting and Importing User Files

You can export user files on one machine and import them for use on another. 

When you export a user to a new location, any custom words added to a Local Roaming 
User do not accompany the user files unless you first run Add Words from Document 
wizard in the Accuracy Center. 

Exporting User Files

To export users from Dragon:

1. On the DragonBar, select Dragon > Manage Users.

2. The Manage Users dialog box opens.

3. Select the user in the list that you want to export.

4. Click the Advanced button and select Export from the menu that appears. 

5. When the Browse For Folder dialog box opens, navigate to the folder where you 
want to store the exported user (or create a new folder by clicking the Make New 
Folder button) and click OK.

6.  When a dialog box opens displaying a message indicating the export was successful, 
click OK.

7. Repeat steps 3 through 6 for each set of user files you want to export. 

8. Click Close to close the Manage Users dialog box.

9. In the operating system, navigate to the directory where you exported the users. In 
that directory you find a separate folder for each exported user, labeled with the user 
name.

Importing User Files

To import users into Dragon that you previously exported on a different machine:

1. On the DragonBar, select Dragon > Manage Users. The Manage Users dialog 
box opens. 

2. Click the Advanced button and select Import from the menu. 

3. When the Browse For Folder dialog box opens, navigate to the folder to retrieve a 
set of exported users files from. 

4. Select the folder in that directory that has the name of the user to import and click 
OK.

5. If the user already exists a User already exists dialog box opens and asks you to 
choose how to proceed: Overwrite the existing user or Import the user with an 
alternate name. If you choose to import the user and assign it another name, enter 
the name in the text box provided and click OK. 
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6. Repeat steps 2 through 5 for each user whose user files you want to import.

7. Click Close to close the Manage Users dialog box.

Handling Dragon Error Messages

When Dragon displays an error message:

1. Read the message carefully. It may give you enough information to determine what 
to do.

2. If you dictated text into your document, click Close to close the error message box 
and then save your document.

3. Do not save your user files.

4. Copy the error message log file (Dragon.log) to a safe place. To locate this file, click 
Start > Programs > Dragon NaturallySpeaking 10 > Show Dragon Log. This 
file is normally located in the C:\Documents and 
Settings\<username>\Application Data\Nuance\NaturallySpeaking10 folder. 
Technical Support may ask you to send this file for further study.

5. Exit Dragon and start it again. In some cases it may be necessary to restart your 
computer.

6. Insert your Dragon DVD into your DVD reader, run the installation program again, 
and choose the Repair option on the first screen of the Dragon setup program. After 
setup finishes, reinstall any Dragon patches that were previously installed.

7. If the error message does not provide enough information to determine what to do, 
search our Web site, http://www.Nuance.com/NaturallySpeaking10/support/, for 
information on the error message. You may find a solution that can save you time 
and trouble.

For more help

If you are unable to resolve your problem or if it occurs again, contact technical 
support.

Working with the Usability Log

You can set up Dragon to create a usability log that logs all menu commands, toolbar 
buttons, and voice commands that you use during a dictation session. 

To set up a usability log: 

1. With a user open, on the DragonBar, select Tools > Options. 

2. Click the Data tab. 

3. Click the Advanced button. 

4. When the Advanced dialog box opens, check the Create usability log check box 
and click OK to return to the Data tab. 

5. Click Apply and then click OK to close the Data tab of the Options dialog box. 

Later, you can find the log under C:\Documents and Settings\ 
<username>\Application Data\Nuance\NaturallySpeaking 10.
4
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Accessing Dragon Knowledge Database

Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, 
located at http://knowledgebase.Nuance.com/. 

If you have problems using Dragon with Microsoft Word on Windows XP (for example 
if the program freezes or commands stop working in a Microsoft Office XP application), 
it may be that the Microsoft Word XP’s built-in speech recognition is interfering with 
Dragon. 

To locate and use the Dragon Knowledge Database: 

Navigate to http://knowledgebase.Nuance.com/. 

1. In the product drop-down list, select Dragon NaturallySpeaking and click 
Continue. 

2. In the Dragon NaturallySpeaking TechNotes-Basic search section you can 
search using: 

• Product version — Select the version you are using. 

• Search Criteria — Type the words that would be expected to be found in the 
pages that contain the answer. Do not use words such as how, why, the, 
in, or on. 

• Using: 

o Any of the words — Show pages that contain any of the words 

o All of the words — Show pages that contain all of the words. 

o Exact phrase entered — Show pages that contain all of the words 
in the exact order typed. 

3. Click Search, to begin the search.

Hardware Compatibility List

You can find a list of headsets and microphones compatible with Dragon at the Nuance 
Communications web site. 

To find the hardware compatibility list: 

1. Navigate to http://support.nuance.com/compatibility/default.asp

2. At the site, under Select a Product click on the product drop-down list and select 
Dragon NaturallySpeaking. 

3. Click Continue to proceed. 

4. Under Select a Device Category click on the device category drop-down list and 
select the type of microphone or recorder. For instance, you can select 
Wireless Microphones to see the various types of Bluetooth microphones that are 
compatible. A list of compatible hardware displays, along with a model, 
manufacturer, and accuracy scale Dragon Score.

5. Click on the device name to open an Evaluation Report on the device that provides 
more detail. Each device is either Nuance Certified (meets highest standard), 
Nuance Authorized (provides satisfactory performance), or Reseller Endorsed 
(not necessarily tested by Nuance, but reported by resellers/VARs to provide 
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satisfactory performance).

Managing Who Has Administrative Privileges

Before You Give Windows Administrator Privileges 

Before you decide to give a Dragon user Windows Administrator privileges on a laptop 
computer, note that you are giving that person access to the Administrative Settings 
dialog box on that machine. 

Determining Logged In User Has Admin Privileges 

If the logged in user has Windows Administrator privileges, the following line appears 
in the Dragon.log file after he or she logs in: 

09:33:10 LOG (MainWin): Windows user has administrative access to NatSpeak
6
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Managing and Securing Custom Commands

You can make your custom commands more secure in two ways:

To make the tool available only in Dragon, convert any XML files of commands to DAT 
format. For details see Using the Convert XML to DAT tool.

To prevent any Dragon users from editing the commands, you can lock access to the 
file. For details see Locking File of Custom Commands.

Using the Convert XML to DAT tool

You can open commands you have stored in XML format in any text editor, which is 
extremely convenient, but not terribly secure. To allow only Dragon users to access 
those command files, you might want to convert them from XML format to DAT format.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract user-defined 
Dragon commands from an XML file. The tool writes out the commands to a .dat file. 
Dragon uses .dat files to store commands. To make these commands available to other 
Dragon users, use nsadmin or the Data Distribution Tool to make the new.dat files 
available to those other users.

Note: If you are using the Dragon SDK Client Edition, you can programmatically import 
Dragon commands stored in XML or DAT files into a Dragon user file by using the 
DgnEngingControl::ImportMyCommands method.

Starting Convert XML to DAT (mycmdsxml2dat.exe) 

To start Convert XML to DAT (mycmdsxml2dat.exe) select:

In Dragon:

Start > All Programs > Dragon NaturallySpeaking 10 > Dragon Natu-
rallySpeaking Tools >Convert XML to DAT 

In Dragon SDK Client Edition:

Start > All Programs > Dragon SDK Client Edition 9 > Dragon SDK Client 
Tools > Convert XML to DAT 

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool’s syntax. 
To display the syntax at any time, enter the following command line:

>mycmdsxml2dat

The mycmdsxml2dat.exe program is located in the \Program directory beneath the 
directory where Dragon SDK Client is installed. For example, in a default installation:

C:\Program Files\Nuance\NaturallySpeaking10\Program> 
8
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Convert XML to DAT (mycmdsxml2dat.exe) syntax

Convert XML to DAT (mycmdsxml2dat.exe) uses the following syntax:

mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]

Required 
parameters :

 
Description

<dat-file-path> The full path to the local copy of the current user’s .DAT file 

<xml-file-path> The full path to the .XML file 

Optional 
parameters :

 

-v  Validates the specified .xml file over the Internet with a 
Nuance DTD (Document Type Definition) file. Disabled by 
default

Using the XML to DAT tool 

To make a set of commands in an XML file available to other users: 

1. Create the XML file containing the commands to be used in Dragon.

2. Execute the command line tool, mycmdsXML2DAT.exe, to convert the XML file to 
DAT format.

3. Use the nsadmin tool to import the .dat file into Dragon for all users.

After you use nsadmin or the Data Distribution Tool to copy the .dat file to the data 
distribution directory, the next time you open a user, Dragon incorporates the new 
commands into the user files for that user.

For more information, see:

• Adding custom commands (nsadmin)

Adding and removing custom commands (Data Distribution Tool)

Locking File of Custom Commands

In Dragon Medical and Dragon Legal, when you export a set of custom Graphic and 
Text, Step-by-Step, Macro, and/or Advanced Scripting commands into a .dat file, 
you can set the permissions on that file so that after a user imports them, that user can 
dictate the commands but cannot view their source code, edit their source code, or re-
export the commands. As a result, the integrity of the commands remains intact.

To set the permissions on the .dat file of commands to protect the commands in this 
way:

1. Make a backup copy of the unprotected .dat file and store it in a secure location. You 
later use that file to edit the commands, because once you protect the .dat file that 
you are distributing, you cannot make the file available for editing again.

2. Select Start > Run and enter cmd into the Run dialog box.

3. Change directories to <drive letter>:\Documents and Settings\<user 
name>\Application Data\Nuance\NaturallySpeaking10\Custom\<language>
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4. Enter the following on the command line: 
 
protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>] 

5. Once you press return, after a user imports these commands, if that user attempts 
to edit any of them, the following message indicates that the commands cannot be 
edited: 
 
The command was protected by <vendor-name>.  
Please contact <vendor-contact-info> for more information.

In the Command Browser, the same message appears as the Preview Content in 
Script mode.

Once you have protected the file, you can put it into the Data Distribution directory 
for distribution to multiple users. For more on distributing saved commands, refer to 
Creating Data Distribution Directory, then refer to a topic about distributing commands 
to multiple users by either:

Using the Data Distribution Tool (Data Distribution Tool: Adding and removing cus-
tom commands) 

 OR 

Using the nsadmin command line tool (nsadmin: Adding custom commands)

 

0
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Using Structured Commands

Dragon NaturallySpeaking Professional, Dragon Medical, and Dragon Legal include an 
extension to text and graphics commands that let you to set the values of variables in 
text blocks based on voice input. 

You can create simple text and graphics commands with variables in the My 
Commands Editor without having to do extensive programming in Microsoft® VBA.

Application states

Structured commands let you control the action of a command based on the state of 
the application. For example, if you assign a state to each field in a form, the same 
command can perform different actions depending on which field is activated.

You can use Advanced Scripting methods to control the states within structured 
commands or to set the initial state from a non-structured command. You can also 
create structured commands that prompt the user to select values from a predefined 
list. 

When the user speaks a command, the user is presented with a list of pre-defined 
values for the command. Once the user selects a value, the value is inserted into the 
correct location in the macro.

Samples

Dragon includes several sample text and graphics commands with variables and sample 
structured commands. You can import the samples into Dragon to use them as 
templates for your own commands. The sample commands are fully commented.

For more information, see:

• Structured Commands Samples

• Importing Sample Commands

Methods

For more information on the methods used by the sample commands, refer to the 
following topics in the Main Help file:

• Global Methods 

SetState

GetState

• EngineControl Methods   

MyCommandsActiveState

PromptValue

Structured Command Samples 

Dragon includes several sample Text and Graphics commands with variables and 
sample structured Advanced Scripting commands. You can import the samples into 
Dragon to use them as templates for your own commands. The sample commands are 
fully commented.
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Sample location

The sample commands are installed in:

\Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking10\Data\Enx\samplecommands

A shortcut to this directory is available on the Windows Start menu. To open this 
directory, click Start > Programs > Dragon NaturallySpeaking 10 
>MyCommands Samples.

Importing Sample Commands

You can import the samples into Dragon to use them as templates for your own 
commands. For information, see Importing Sample Commands

Samples

The following samples are included with Dragon: 

GroceryListSample_DragonPad

GroceryListSample_DragonPad.xml contains Advanced Scripting commands 
that simulate an on-line grocery order form in DragonPad. It demonstrates how to 
set and change command states, activating and deactivating various state 
structured commands, and how to use the command prompt. The "Prepare 
Grocery List" voice command displays the first section of a grocery list in 
DragonPad and sets a command state. Each section of the grocery list is designed 
to have a separate state. The "What’s Available" voice command prompts the 
user with a set of grocery list commands that are active in the given section.

GroceryListSample_WordPad

GroceryListSample_WordPad.xml contains Advanced Scripting commands 
similar to those of GroceryListSample_DragonPad.xml. It demonstrates how to 
set and change command states and to use the command prompt in WordPad and 
uses a different coding style. The "Prepare Grocery List" voice command starts 
the grocery list in WordPad, activate the initial grocery list state, and prompt the 
user with a set of grocery list commands that are active in the given state. To read 
more about this sample and its commands, refer to the code comments in the XML 
file. 

SampleBoilerPlate_ColonCancer

SampleBoilerPlate_ColonCancer.xml contains Advanced Scripting commands 
that demonstrate how to use structured commands and the command prompt for 
boilerplate text. This sample is modeled after a colon cancer checklist and is 
designed to work in Microsoft Word 2003. The "Colon Cancer Checklist" voice 
command displays the boilerplate text and takes the user, field by field, through the 
checklist.

SampleBoilerPlate_EndoBiopsy

SampleBoilerPlate_EndoBiopsy.xml contains a single Advanced Scripting 
macro that demonstrates how to set up boilerplate text and use the command 
prompt to guide users in filling the boilerplate text without using states. This sample 
is modeled after an endoscopic biopsy report and is designed to work in Microsoft 
Word 2003. The "Prepare Endoscopic Biopsy Gross Template" voice command 
2
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displays the boilerplate text and takes the user, field by field, through the report.

SampleTGV_Restaurant

SampleTGV_Restaurant.xml contains Text and Graphics and Advanced 
Scripting commands that are used in DragonPad to simulate an ordering system 
for a Chinese and Japanese restaurant. This sample demonstrates how to set states 
for structured commands as well as how the same commands can be used to 
produce different results in different states. Either the "Chinese Restaurant" or 
"Japanese Restaurant" voice command starts the ordering system and activates 
the structured commands created for the given state. The "Exit Ordering 
System" voice command ends the ordering session. 

SetStateSample

SetStateSample.xml contains simple Text and Graphics commands that 
demonstrate how to use variables and text formats and Advanced Scripting 
commands to set and unset a command state. This sample is designed to work in 
DragonPad with the initial command "Sample Set State." When the command 
executes, a command state is set for DragonPad and a simple exchange of 
greetings is simulated between the user and the system. The user speaks the 
greeting, such as. "Good Morning," and the system responds in bold red text. 
When the user says "Good-bye," the exchange is terminated and the command 
state is unset.

SampleInjuryReport

SampleInjuryReport.xml together with SampleInjuryReport.dot 
demonstrates how structured commands and Microsoft Word templates can be used 
together to create a voice-enabled form filling environment. The template is a mock 
injury report with several text and check box fields can be filled using the 
commands included in the XML file. You start a form filling session by speaking the 
"Edit Report" voice command in a new document based on the sample template. 
Both the template and the commands are designed to work in Microsoft Word 2003.

Importing Structured Commands

You can import existing structured commands, such as the Structured Commands 
Samples, into Dragon to use as templates for your own commands. Use the following 
procedure to import the sample structured commands that are supplied with Dragon:

To import the sample structured commands:

1. On the DragonBar, select Tools > Command Browser to open the Command 
Browser window.

2. Click the Manage button on the Command Browser toolbar.

3. In the Manage area, click the Import button, and in the Import Commands 
window choose MyCommands XML files from the Files of type list.

4. Use the Import Commands window to browse to the Documents and 
Settings\All Users\Application 
Data\Nuance\NaturallySpeaking9\Data\Enx\samplecommands directory.

5. Select one of the sample .XML files (for example, sampletgv_restaurant.xml) and 
click Open.

6. Click OK on the Import Commands validation dialog box and then click Import on 
the Import Commands window to import the commands contained in the file.
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Note: The syntax of XML command files is defined by a document type definition 
(DTD) file that resides on the Nuance web site. When you import an XML command 
file, the application gives you the option of validating the syntax of the XML file 
against the DTD. The validation step is useful if you receive a XML command file 
from another person and want to check it for syntax errors prior to importing it.

7. Click OK on the success message and return to the Manage area of the Command 
Browser.

To examine the sample code

1. Open the Command Browser and click the Manage button.

2. Expand and select the appropriate item (for example, <restaurant_type> Menu)

3. Click the To Script button and then click the Edit button.

The MyCommands Editor dialog box opens with the command you selected entered 
into it. You can examine and modify the command with the MyCommands Editor.
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Summaries of Administrative Settings Dialog 
Boxes

The tabs in the Administrative Settings dialog box are:

• Roaming

• Miscellaneous

• Scheduled Tasks

For more on each tab, see the corresponding topic below:

• Administrative Settings: Roaming tab 

• Administrative Settings: Miscellaneous tab

• Administrative Settings: Scheduled Tasks tab

Administrative Settings: Roaming tab 

You use the Roaming tab of the Administrative Settings dialog box to set up the 
Roaming User feature. You must set up the Roaming User feature on each computer 
where you want users to dictate with a Roaming User. 

Enable

Select Enable to activate the Roaming User feature and the Roaming User options.

Network Directories

To set the location of the master Roaming User(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to 
define the network location of the master roaming users. The location you pick must 
be accessible to all computers on the network that you want available for dictation 
with Dragon.

2. Set the Display Name and the Address under Network Location. The Roaming 
User feature supports the following types of locations: 

• Mapped Drive—the format is: <drive letter>:\<folder name>. For example, 
y:\roaming. 

• UNC Path—the format is: \\servername\sharename\path\filename.

• HTTP (http:)—the format is: http://myserver.com/webDAV. For HTTP 
locations, click the HTTP Settings button to set information specific to your HTTP 
connection. You can also test your connection to the HTTP server from HTTP 
Settings dialog box.

• HTTP with SSL (https:)—the format is: https://myserver.com/WebDAV. For 
HTTP with SSL locations, click the SSL Settings button to set information specific 
to your HTTP with SSL connection. You can also test your connection to the HTTP 
with SSL server from SSL Settings dialog box.

Note: Additional installation of a third-party web server application called WebDAV is 
required to set up a compatible WebDAV HTTP or SSL server. WebDAV software is 
required in order to access and secure Dragon user files on the Internet location. The 
WebDAV application is available free of charge at www.webdav.org. 
6
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For more information on setting the location of the master roaming user, see Roaming 
User Network Location. 

Local directory (for cache)

When a user opens a Master Roaming User, Dragon transfers a copy of that user to the 
local machine. That local copy is called the Local Roaming User.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> is: 
Documents and Settings\All Users\Application 
Data\Nuance\NaturallySpeaking9\RoamingUsers\<display name>\<username> 

The <display name> is a name you assigned as a Master Roaming User files location. 
You can have multiple network storage locations for your Master Roaming User files. 

The <username> is the name of an individual Master Roaming User. There is a separate 
directory for each user.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User Options

The check boxes and other components below the Local directory are the Roaming 
User Options. For when and why to set these options, refer to Selecting Roaming User 
options.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first 
installed Dragon. Note that the default is to have the Roaming User feature turned off.

Note: 

• If you connected to your Roaming User Master Directory over HTTP and you find that 
either not all your users are listed in the Open User dialog box or after creating a 
roaming user you cannot open it again, be sure to: 

• Add all file extensions within your Master Roaming User directories and 
subdirectories to the Registered MIME types list of your IIS server. You could also 
add a wildcard ( .*) MIME-type. For more information on adding a wildcard ( .*) 
MIME-type, see http://www.microsoft.com/technet/prodtechnol/
WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-
83a2c180cd32.mspx?mfr=true. 

• Check that no files in your user directory are locked, password protected, or 
otherwise access-restricted by your server permissions.

For more information 

About the Roaming User feature

Setting up the Roaming User feature

Creating and opening a Roaming User

Defining a network location for a master Roaming User
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Administrative Settings: Roaming User Network Location

You use the Roaming User Network Location dialog box to define the network 
location of the master roaming users.

The location you pick must be accessible to all computers where users will dictate using 
a Roaming User.

Display Name 

Sets the directory name displayed in the following locations:

• The Roaming tab of the Administrative Settings dialog box

• The Location of user files drop-down list in the Open User dialog box. 
  
Note: With the Roaming User enabled, the Open User dialog box displays only users 
in the Roaming User locations. To let the users open both local (non-roaming) and 
Roaming users, select the Allow non-roaming users to be opened option on the 
Administrative Settings dialog box. Clearing this option prevents users from 
dictating with a non-roaming (local) user by accident. For more information, see 
Setting Up the Roaming User feature

• The Location of user files drop-down list in the Manage Users dialog box.

Network Location—Address

On each computer where you plan to have users dictating as a Roaming Users, you 
must tell that installation of Dragon where the Master Roaming user files are located.

The Roaming User feature supports the following types of locations: 

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it. 

UNC paths connect to a shared network folder using the Universal Naming Convention 
(UNC) to locate a user. The UNC is a way to identify a shared file on a computer or 
network without having to know the storage device it is on. The UNC path format is:  
\\servername\sharename\path\filename.

To use a mapped drive or UNC path: 

1. Under Network Location, enter the address of the mapped drive or UNC path.  
 
You can click Browse to browse for the location of the mapped drive or UNC path. This 
displays the Browse for Folder dialog box. You can also create a new directory on the 
mapped drive or UNC path by clicking the Make New Folder button. 

2. Click OK when you are done. 

Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted 
Secure Sockets Layer (SSL).

 To use an Intranet/Internet connection: 

1. Under Network Location, enter the URL address of your HTTP or HTTPS server 
8
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where your roaming user master files are located.

2. Click 

• HTTP Settings...to display the HTTP Settings dialog box, where you can set 
information specific to your HTTP connection like Authentication, Firewall, and 
Proxy Server information. You can also test your connection to the HTTP server 
from this dialog box. For more information, see HTTP Settings.

• SSL Settings...to display the SSL Settings dialog box, where you can set 
information specific to your HTTPS (SSL) connection. You can also test your 
connection to the HTTPS server from this dialog box. For more information, see 
HTTPS Settings.

Note: You cannot create a non-Roaming user on an HTTP or HTTPS connection. You 
can create only Roaming Users on an HTTP or HTTPS connection and only when the 
Roaming User feature is enabled. 

For more information 

• About the Roaming User feature

• Setting up the Roaming User feature

• Creating and opening a roaming user

Administrative Settings: Miscellaneous tab

The Miscellaneous tab of the Administrative settings dialog box contains the fol-
lowing options:

Backup Location for user files

Shows the location where Dragon will save backup user files. Click the Change button 
to open a dialog box where you can specify a new location. Click the Use Default but-
ton to make the individual user’s folder the location. You can change the Backup lo-
cation for user files to any directory where Windows has both read and write 
permissions, including portable devices such as Zip drives and CD/DVD burners. If you 
change the location, backups for all users will be located in the same directory.

Note: On Windows XP and 2000 you must have administrator privileges to change the 
Backup location for user files and Data Distribution location. These fields are 
grayed out for restricted users. Dragon will not let restricted users create backup files 
in directories reserved for the operating system (for example, the \Windows directory). 
When specifying a backup location, make sure that directory can be accessed by all us-
ers.

Data Distribution location

Shows the location where Dragon should look to distribute custom words, vocabularies, 
and commands to multiple users. Click the Change button to open a dialog box where 
you can specify the location for this directory. Click the Use Default button to set the 
location to this default path:

C:\Documents and Settings\All Users\Application Data\Nu-
ance\NaturallySpeaking10\custom

You can change the Data Distribution location to any directory where Windows has 
both read and write permissions, including portable devices such as Zip drives and CD/
189
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DVD burners.

Do not allow restricted users to add or modify commands

Select this check box to prevent restricted Windows users from adding or modifying 
Dragon commands. Selecting this option allows only users logged on with administrator 
privileges to add or modify commands. (Windows 2000 and Windows XP Professional).

Disable Modification of Macro Recorder Commands

Select this box to prevent users from modifying macro recorder commands. Users can 
still run the commands.

Disable Modification of Step-by-Step Commands

Select this box to prevent users from modifying step-by-step commands. Users can still 
run the commands.

Disable Modification of Advanced Scripting Commands 

Select this box to prevent users from modifying advanced scripting commands. Users 
can still run the commands.

Do not allow restricted users to modify vocabularies 

Select this check box to prevent restricted Windows users from modifying Dragon vo-
cabularies. Selecting this option allows only users logged on with administrator privi-
leges to modify vocabularies. (Windows 2000 and Windows XP Professional)

Record wave data between utterances.

Select this option to capture all dictation, including background noise, "ums" and "ahs", 
extraneous noises, and anything else the speaker may do like cough or laugh.

Correction Only Mode (no dictation available)

Select this option to enable Correction Only Mode, which disables dictation but lets a 
transcriptionist play back another user’s dictation without opening that user.

Note: You must disable Correction Only mode before running the Acoustic and Lan-
guage Model Optimizer.

Disable Windows Advanced Text Services

Select this option to disable Microsoft’s Alternative User Input Text Input Processor 
(CTFMon)--turning off Windows speech recognition and eliminating potential conflicts 
with Dragon.

Dragon installs an add-in to Microsoft Word that can conflict with add-ins installed by 
other applications. After installing Dragon on a Windows XP system, errors may start 
appearing when using Microsoft Word if the Microsoft Alternate User Input application 
(CTFMON.EXE) is also installed and running. The Microsoft Alternate User Input appli-
cation supports advanced text services in Microsoft Office XP. These advanced text ser-
vices include Microsoft speech, handwriting, and East Asian keyboard input services. 
You can disable the Microsoft Alternate User Input application during installation or lat-
er in the Administrative Settings dialog box. 

Note: This option does not appear on systems running Windows Vista.

Disable automatic acoustic model selection in the Acoustic Optimizer

Running the Acoustic Optimizer updates your user files with accumulated acoustic 
data from any corrections and additional training you may have done. Running Acoustic 
Optimization increases your overall accuracy. In the process of increasing your accura-
0
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cy, Acoustic Optimization might select a different acoustic model for your user files. Se-
lect this option to disable the Acoustic Optimizer from selecting a different acoustic 
model when run. 

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first in-
stalled Dragon. Note that the default is to have the roaming user feature turned off.

Notes

In some versions of Windows, such as Windows XP Pro, you must be logged on as 
the administrator before you can make changes to the options on this dialog box.

In some situations, a user who does not have administrator privileges may have ac-
cess to options on this dialog that they would not normally have.

Dragon allows you to use the Universal Naming Convention (UNC) to locate a user. 
The UNC is a way to identify a shared file on a computer or network without having 
to know the storage device it is on. The format is: \\servername\share-
name\path\filename. 

Administrative Settings: Scheduled Tasks tab

The Scheduled Tasks tab of the Administrative settings dialog box is where you 
schedule optimization and tuning of voice (acoustic) models and language models and 
determine if and when the share the tuning information with Nuance:

• Enabled Scheduled Accuracy Tuning—Check to turn on periodic scheduled 
acoustic model tuning for all users. 

• Click Configure to set the schedule. You are immediately asked to log in with your 
Windows Administrator password to make a schedule change. After you log in, you 
can set one schedule for Acoustic model tuning and another for Language Model 
tuning by clicking the appropriate tab and choosing Daily, Weekly, or Monthly 
and the start date and time.

• Enable Scheduled Data Collection—Check to allow Nuance to collect up to 500 MB 
of text and data about optimizations performed for Dragon users. Nuance uses the 
data to improve recognition quality. Once the data is collected, you have the option 
of sending it to Nuance to help improve the accuracy of future versions of Dragon. 
No personal information is ever sent to Nuance and participation in data collection is 
completely voluntary.

• Click Configure to set the schedule for data collection. You are immediately asked 
to log in with your Windows Administrator password to make a schedule change. 
After you log in, you can choose Daily, Weekly, or Monthly and the start date 
and time.

• Let the user choose when to run Accuracy Tuning and Data Collection—Check 
to give users access to this tab, effectively allowing them to change the schedules for 
periodic tuning and data collection. 

• Restore Defaults—Click to return the schedules on this tab to their default 
frequencies and times.
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